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About This Document

Purpose

This document introduces the SmartLogger1000 (SmartLogger for short) in terms of
installation, cable connections, system operation and maintenance, and troubleshooting.
Readers should understand the SmartLogger features, functions, and safety precautions
provided in this document before installing and operating the SmartLogger.

Intended Audience

This document is intended for photovoltaic (PV) power plant personnel and qualified

electrical technicians.

Symbol Conventions

The symbols that may be found in this document are defined as follows.

Symbol

Overview

Indicates an imminently hazardous situation which, if
not avoided, will result in serious injury or death.

A DANGER

Indicates a potentially hazardous situation which, if
not avoided, could result in serious injury or death.

/\ CAUTION

Indicates a potentially hazardous situation which, if
not avoided, may result in minor or moderate injury.

NOTICE

Indicates a potentially hazardous situation which, if
not avoided, could result in equipment damage, data
loss, performance deterioration, or unanticipated
results.

NOTICE is used to address practices not related to
personal injury.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd. ii




SmartL.ogger1000
User Manual About This Document

Symbol Overview

L] noTE Calls attention to important information, best
practices and tips.

NOTE is used to address information not related to
personal injury, equipment damage, and environment
deterioration.

Change History

Changes between document issues are cumulative. The latest document issue contains all
updates made in previous issues.
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Issue 04 (2013-12-01)

This is the fourth official release.

6.2.26 Setting Communications ParametersServer+Client is added to the management
system parameters.

Added the address allocation in 6.2.34 Managing Devices.
Added the setting of USB parameters in 7.10.4.2 Setting USB Parameters.
Updated part of the web user interface (WebUI).

Issue 03 (2013-09-10)

This is the third official release.

Compared with the second official release, this document updated some operations and
figures for the LCD and WebUI.

Issue 02 (2013-06-06)

This is the second official release.

Issue 01 (2013-04-25)

This is the first official release.

Compared with the original draft, this document updated some operations and figures for the
LCD and WebUI.
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Safety Precautions

Read the safety precautions carefully. Otherwise, human injury and equipment damage may
occur.

1.1 Precautions

This topic describes the precautions for installing and operating the SmartLogger.

Personnel Requirements

®  Only qualified and trained electrical technicians are allowed to install and operate the
SmartLogger.

e  Operation personnel should understand the composition and working principles of the
PV grid-tied power generating system and local regulations.

NOTICE

Read this document thoroughly before operations. Huawei shall not be liable for any
consequence caused by violation of the storage, transportation, installation, and operation
regulations specified in this document.

Identification Protection

®  The signs on the SmartLogger shell specify important information about secure
operations. Do not damage the signs.

®  The nameplate attached to the bottom of the SmartLogger lists the SmartLogger
parameters. Do not damage the nameplate.

Installation
e  Before installing the SmartLogger, ensure that it is not connected or energized.
e Install the SmartLogger in well-ventilated environments to ensure system performance.
®  Ensure that the heat dissipation holes of the SmartLogger are not blocked.

® Do not move the components inside the shelf except for the wiring terminals at the
bottom.
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Operation

Strictly comply with the safety precautions in this document and associated documents to
operate the SmartLogger.

When operating the SmartLogger, follow local laws and regulations.

Maintenance and Replacement

e  Afaulty SmartLogger requires overall maintenance. Contact the dealer if any fault
occurs in the SmartLogger shelf.

e  Maintain the SmartLogger after you get familiar with this document and tools and testing
equipment are available.

e  When maintaining the SmartLogger, wear ESD gloves and comply with ESD
precautions.

1.2 Symbols

The following table describes all symbols on the SmartLogger.

Symbol Name Meaning

CE certification label This product complies with
the Conformite Europeenne

(CE) certification
standards.

VCCI certification label This product complies with
Voluntary Control Council

V@ I for Interference by

Information Technology

Equipment (VCCI)
certification standards.

Environmentally friendly This product does not

‘50’ use period (EFUP) label pollute the environment

during a specified period.

EU waste electrical and Do not dispose of the
electronic equipment SmartLogger as household
(WEEE) label garbage. For details about

how to deal with the
undesirable SmartLogger,
refer to 11 Disposing of the
SmartLogger.
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2 Overview

This topic describes the SmartLogger in terms of functions, networking applications, product
features, appearance, and the monitoring panel.

2.1 Product Introduction

This section describes the SmartLogger in terms of functions, networking applications, and

product features.

Functions
The SmartLogger is dedicated for monitoring and managing the PV power generating system.
It converges all ports, converts protocols, collects and stores data, and centrally monitors and
maintains the PV power generating system.

Networking

The SmartLogger applies to a PV system.

® |t can monitor Huawei inverters, PID, and other devices.

® |t supports third-party devices such as inverters, environment monitoring instruments,
box-type transformers, and smart meters that use the standard Modbus protocol or
provide RS485 ports.

® It can simultaneously connect to the Huawei and third-party network management
systems by using the Modbus-TCP and IEC104 protocols.

® It can connect to a multi-functional power meter over DLT645.

The SmartLogger networking is shown in Figure 2-1.
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Figure 2-1 SmartLogger networking
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Features

The SmartLogger has the following features:

e  Central monitoring
- Centrally monitors a maximum of 80 devices.

- Allows users to view information about the power station, devices, products, and
alarms, set parameters, and maintain devices on the liquid crystal display (LCD).

- Allows users to monitor and manage the PV power generating system on the
embedded WebUI, for example, viewing real-time information about the power
station, devices, and faults, and setting device parameters in remote mode.

®  Graphical data
- Displays energy yields and real-time monitoring information on the LCD in
graphics and texts.

- Displays energy yields, real-time monitoring information, and performance data of

the power station and devices on the embedded WebUI in tables and curves.

e  Convenient maintenance

- Allows users to upgrade the firmware of the SmartLogger and inverters and export

data by using a USB flash drive.

- Allows users to upgrade the firmware of the SmartLogger or inverters and export

logs over the embedded WebUI.
®  Grid dispatching
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Supports power grid dispatching: active power reduction and reactive power
compensation.

e Intelligent management

- Automatically scans and identifies Huawei inverters and supports protocol
conversion for third-party devices

- Supports access from third-party devices that use the standard Modbus-RTU
protocol.

- Automatically assigns RS485 addresses to the connected inverters and allows for
adjusting RS485 addresses based on device sequence numbers to facilitate remote
configuration and maintenance.

- Supports remote setting of inverter parameters and synchronizes the parameters of
one inverter to other inverters in batches.

L4 Remote maintenance

- Supports connection to both Huawei NMS and a third-party NMS using
Modbus-TCP and IEC104 protocol to remotely manage all devices.

- Allows users to access a third-party NMS over the File Transfer Protocol (FTP).
- Sends energy yield and fault information to users by emails.

2.2 Appearance

This topic describes the SmartLogger in terms of its appearance and specifications.
Front View of the Shell

Figure 2-2 Front view of the SmartLogger
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The LCD on the SmartLogger monitoring panel displays information about the power site, devices,
alarms, and products. This topic describes how to set parameters and maintain devices over the
monitoring panel.
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Side View of the shell
Figure 2-3 Side view of the SmartLogger
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1. SD card slot (reserved) 2. USB port
Rear View of the Shell
Figure 2-4 Rear view of the SmartLogger
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1. Mounting hole 2. Rail snap 3. Heat dissipation hole
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Bottom of the Shell

Figure 2-5 Bottom view of the SmartLogger
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The following table describes functions of each port of the SmartLogger, as shown in Table
2-1.

Table 2-1 Port description

Port (Silk Screen) Function Description

POWER Power supply 12V DC

FE Fast Ethernet Connects to a local area
network (LAN) switch,
router, power over Ethernet
(POE) or PC.

RS232 RS232 Connects to an external
RS232 device.

Al Analog input 4-20 mA and 0-20 mA
current input (active),
reserved.

DI Digital input Connects to a dry contact
input.

DO Digital output Relay output

SO0.In Connects to a pulse output Reserved

power meter

CAN port CAN port Reserved

COM1-COM3 RS485 Supports three RS485 ports
that can connect to devices
such as the inverter and
environmental monitoring
instrument (EMI).
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2.3 Monitoring Panel

This topic describes the monitoring panel, including an LCD, indicators, buttons, and the
default page.

Monitoring panel

The monitoring panel provides one LCD, three indicators, and four buttons, as shown in
Figure 2-6.

Figure 2-6 Monitoring panel

1
|
i
O = A
2
Smart Logger
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1. Indicator 2.LCD 3. Button

Indicators

There are three indicators on the monitoring panel. They are Power indicator, Run indicator,
and Alarm indicator from left to right.

Table 2-2 describes the indicators.

Table 2-2 Indicator description

Indicator Status Meaning
Power indicator Steady green The power supply is normal.
(E I E) Off There is no power supply.
Run indicator Blinking green (on for 1s The SmartLogger is working.
= and then off for 1s)
s
Off The SmartLogger stops working.
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Indicator

Status Meaning

Alarm indicator Steady red The inverter connected to the

SmartLogger generates a major
alarm. For details about the
alarm, see 6.2.19 Querying
Alarm Records.

Blinking red (on for 0.5s The inverter connected to the
and then off for 0.5s) SmartLogger generates a minor
alarm. For details about the
alarm, see 6.2.19 Querying
Alarm Records.

Blinking red (on for 1s and | The inverter connected to the
then off for 4s) SmartLogger generates a
warning. For details about the
warning, see 6.2.19 Querying
Alarm Records.

Off The inverter connected to the
SmartLogger is working
normally.

LCD

The LCD displays data in graphics and text, including the information about the site, devices,
alarms and products. Users can also set parameters and maintain devices on the LCD.

If you do not press any button within 90s on a non-default page, the LCD returns to the
default page automatically, as shown in Figure 2-7.

Figure 2-7 Default page

[ 2017-08-10 1B:32:24 «— 1
1 kWh
—2
° 04.00_ 05,00 12,00 16,00 20100 A
E-Daily: 24. 04kWh
Reduced COZ: 240, 40kg I
Active power: 0. 00N
M0 @0 ®:0 —4
1. Date and Allows you to view the date and time.
time
2. Energy Allows you to view the total energy production in each hour by all the
production inverters connected to the SmartLogger.
histogram
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3. Energy ¢ Allows you to view the total energy production from 0:00 to the current
production time by all the inverters connected to the SmartLogger.
data e Allows you to view the emission reduction of CO> corresponding to the

energy Yyield of the current day.
¢ Allows you to view the total output power by all the online inverters
connected to the SmartLogger at the present.
4. Status Allows you to view the number of the major alarms, minor alarms, and
information warnings of all the inverters connected to the SmartLogger. When remote
grid dispatching is enabled, you can view the current status of grid
dispatching.
Buttons

There are four buttons on monitoring panel. They are the Return button, Cursor Up button,
Cursor Down button, and Confirm button from left to right.

Table 2-3 describes the button functions.

Table 2-3 Button description

Buttons Name Functions

ESC Return Allows you to return to the last page or end an
button operation.

A Cursor Allows you to go to the upper-level menu or set
Down parameters.
button

v Cursor Up | Allows you to go to the lower-level menu or set
button parameters.

J Confirm Allows you to go to the menu or confirm the value.
button

[l noTE

The backlight lasts 120s after you press any button.

2.4 Typical Cable Connection Scenarios

Overview

e  The cable from the busbar to the knife switch needs to be prepared by yourself.
Recommended cable: three-core multi-wire (L1, L2, and L3) cable with the operating
voltage to the ground not less than 600 V and the cross sectional area of a single core
wire being 4 mm?.

e  The cable from the knife switch to the miniature circuit breaker (MCB) needs to be
prepared by yourself. Recommended cable: three-core multi-wire (L1, L2, and L3) cable

with the operating voltage to the ground not less than 600 V and the cross sectional area
of a single core wire being 4 mm?.
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e If the SmartLogger communicates with the inverter over PLC, a PLC CCO module needs
to be connected. If they communicate over RS485, no PLC CCO module is required.

Optical Fiber+RS485/PLC Scenario

Figure 2-8 Cable connections in the optical fiber+RS485/PLC scenario
SmartLogger1000
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1 | l
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ILO1110003

Table 2-4 lists the components required in this scenario.

Table 2-4 Required components

Component Model or Specifications | Component Quantity
Source
SmartLogger SmartLogger1000 Can be purchased | 1 PCS
from Huawei
RS485 signal SPD PowerSA-5KA-15V Can be purchased | 2 PCS
from Huawei
PLC CCO PLC CCOO01A Can be purchased | 1 PCS
from Huawei
Ring network LAN | AR531 or a ring-network To be supplied by | 1 PCS
switch LAN switch of a local type | the customer
Optical module FTLF1323P1BTR-HW or To be supplied by | 2 PCS
an optical module of a the customer
local model
ATB CT-GZF2PJ-8, To be supplied by | 1 PCS
CT-GPH-A-8, oran ATB the customer
of a local model
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Component Model or Specifications | Component Quantity
Source
MCB Rated voltage > 500 V; To be supplied by | 1 PCS
rated current > 6 A the customer
Knife Fuse Rated voltage: > 500 V; To be supplied by | 3PCS
switch rated current: 6 A the customer
Knife Rated voltage: > 500 V; To be supplied by | 1 PCS
switch rated current: > 6 A; the customer
box number of phases: three
Socket Matching with the power To be supplied by | 1 PCS
adapter the customer
LTE+RS485/PLC Scenario
Figure 2-9 Cable connections in the LTE+RS485/PLC scenario
SmartLogger1000
‘“
T =
Socket I-l-l
POE module
RS485 | ==y pLeceo
signal SPD %
l MCB
3 ! 1 POE SPD
Ground bar SL‘:
' Knife switch
— I
, = . CPE
RS485 input PE Busbar A/B/C
Communications cable s Power cable e Ground cable ==———= AC power cable e
ILO1110004
Table 2-5 lists the components required in this scenario.
Table 2-5 Required components
Component Model or Specifications | Component | Quantity
Source
SmartLogger SmartLogger1000 Can be 1PCS
purchased
from Huawei
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Component Model or Specifications | Component | Quantity
Source
POE module POE35-54A or Can be 1PCS
POES85-56A purchased
from Huawei
PLC CCO PLC CCOO01A Can be 1PCS
purchased
from Huawei
RS485 signal SPD PowerSA-5KA-15V Can be 2 PCS
purchased
from Huawei
POE SPD POE-2 Can be 1PCS
purchased
from Huawei
CPE EG860V2-C71 Can be 1PCS
purchased
from Huawei
MCB Rated voltage: > 500 V; To be supplied | 1 PCS
rated current: > 6 A by the
customer
Knife Fuse Rated voltage: > 500 V; To be supplied | 3PCS
switch rated current: 6 A by the
customer
Knife Rated voltage: > 500 V; To be supplied | 1 PCS
switch box | rated current: > 6 A; by the
number of phases: three customer
Socket Matching with the power | To be supplied | 1 PCS
adapter by the
customer
Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 13
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Installation

This topic describes how to install the SmartLogger.

Context

Install the SmartLogger in an appropriate position and surface.

i DANGER

e Do not store the SmartLogger in areas with flammable or explosive materials.
e Do not install the SmartLogger on flammable building materials.

3.1 Installation Process

This topic describes the SmartLogger installation process.

The SmartLogger installation process is shown in Figure 3-1.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 14
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Figure 3-1 Installation flowchart
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Table 3-1 describes the installation process.

Table 3-1 Description of the installation process

Step Operation Description
1 Checking Before Before unpacking, check that the outer packing
Installation materials are intact. After unpacking, check that
deliverables are complete and intact.
2 Preparing Tools Prepare tools required for installation and electrical
connections.
3 Determine the installation | Before installing the SmartLogger, determine an
position. appropriate position to ensure that the
SmartLogger works properly.
4 Installing the SmartLogger | The SmartLogger can be installed on a desk, a wall
or along a guide rail.

Issue 12 (2019-01-15)
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3.2 Checking Before Installation

Checking Outer Packing Materials

Check the outer packing materials for damage before unpack the SmartLogger, such as holes
and cracks. If any damage is found, do not unpack the SmartLogger and contact the dealer as
soon as possible.

Checking Deliverables

After unpacking the SmartLogger, check whether deliverables are intact and complete. If any
damage is found or any component is missing, contact the dealer.

L1l noTE

For details about the number of components, see the Packing List in the packing case.

3.3 Preparing Tools

Prepare tools required for installation and electrical connections.

Tool Model Function

Hammer drill D6 drill bit Drills holes in the wall when
the SmartLogger is
wall-mounted.

Diagonal pliers - Cuts and tighten cable ties.

Wire stripper - Peels cable jackets.

Rubber mallet - Hammers expansion bolts into

holes.
=
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Tool

Model

Function

Guarded blade utility knife

Removes package.

Cable cutter

Cuts cables.

Cleans up dust after holes are
drilled.

Marker

]

Diameter: < 10 mm

Marks signs.

Measuring tape

Measures distance

Plumb line

Ensures that the screws are
perpendicular to the wall.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd.
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Tool

Model

Function

Safety goggles

Protect an operator's eyes
during hole drilling.

Anti-dust respirator

<

Protects an operator from dust
inhalation during hole drilling.

3.4 Determining the Installation Position

Before installing the SmartLogger, determine an appropriate position to ensure that the

SmartLogger works properly.

Comply with the following requirements when determining the installation position for the

SmartLogger:

e Do not install the SmartLogger outdoors because it is protected to IP20.
e |Install the SmartLogger in a dry environment to protect it against water.

e  Keep the product in an ambient temperature range of —40<C to +60<C and away from

direct sunlight.

®  The communication distance for the RS485 port should be less than 1000 m and for the

Ethernet less than 100 m.

e Install the SmartLogger at an appropriate height for the user's ease to view and operate

on the monitoring panel.

e Do not place the SmartLogger upside down. Ensure that the heat dissipation holes are
facing upwards, preventing dust from entering the SmartLogger and reducing its service

life.

®  Choose appropriate installation method and position for the Smart Logger according to
its weight and size. For details, refer to 12 Technical Specifications.

e If you install the SmartLogger on a wall or along a guide rail, the area for connecting

cables should be downwards.

®  The SmartLogger is at least 100 mm away from the neighboring objects on both sides,
the top side, and the bottom side respectively, as shown in Figure 3-2.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd.
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Figure 3-2 Minimum installation clearance
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3.5 Installing the SmartLogger

The SmartLogger can be installed on a desk, on a wall, or along a guide rail.

3.5.1 Installing the SmartLogger on a Desk

This topic describes how to install the SmartLogger on a desk.

Context

e Ensure that the desk on which the SmartLogger is installed is horizontal to prevent it from
falling down.

e |[nstall the SmartLogger in places where cables cannot be easily touched to avoid signal
disruption.

Procedure
Step 1 Take the SmartLogger out from the package.
Step 2 Place the SmartLogger onto a horizontal desk.

~—-End

3.5.2 Mounting the SmartLogger on a Wall

This topic describes how to mount the SmartLogger on a wall.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 19
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Context

e |Install the SmartLogger on a solid and smooth wall to ensure that it can be secured on the
wall.

e Before hanging the SmartLogger on the screws, secure the expansion tubes and screws
into the wall.

Procedure

Step 1 Install the expansion tubes and screws.

If you need to use a ladder to install the SmartLogger on a high position, keep balance to
protect yourself from falling down.

1. Use a plumb line to ensure that the line between the centric points of the two holes is
vertical to the ground. Use a marker to mark out the holes, as shown in Figure 3-3.

Figure 3-3 Hole positions and dimensions

IL015C0002

2. Drill holes using a hammer drill and install expansion tubes and screws, as shown in
Figure 3-4.
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Figure 3-4 Drilling a hole and installing an expansion tubes and screws
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24-25 mm

Table 3-2 describes the operations shown in Figure 3-4.

Table 3-2 Drilling a hole and installing an expansion tubes and screws

Step Operation

1 Put a hammer drill with a ®6 drill bit on a marked hole position perpendicularly
against the wall and drill holes with a depth of 24 mm to 25 mm.
NOTICE

e To prevent dust inhalation or contact with eyes, wear safety goggles and an anti-dust
respirator when drilling holes.

e Wipe away any dust in or around the holes and measure the hole distance. If the holes
are inaccurately positioned, drill holes again.

2 Vertically insert an expansion tube into a hole, and knock it completely into the
hole by using a rubber mallet.

3 Insert the screws into the expansion tube until the screw heads are 7.5 mm to 8
mm away from the wall.

Step 2 Hang the SmartLogger onto the secured screws by the mounting holes on the rear of the
SmartLogger.

NOTICE

Ensure that the area for connecting cables in the SmartLogger is downwards for the ease of
electrical connections and maintenance.

—End

3.5.3 Mounting the SmartLogger Along a Guide Rail

This topic describes how to mount the SmartLogger along a guide rail.

Context

The guide rails are not delivered together with the SmartLogger. If you need to mount the
SmartLogger along a guide rail, prepare a 35 mm wide guide rail.
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e Choose a guide rail with appropriate lengths to ensure that the SmartLogger can be
secured along it.

e Secure the guide rail before mounting the SmartLogger.

Procedure

Step 1 Hold both sides of the SmartLogger, keep it parallel with the guide rail, and then tilt it slightly
to insert its upper hooks into the guide rail, as shown in Figure 3-5.

Figure 3-5 Mounting the SmartLogger Along a guide rail (1)

ILOTHCO002

Step 2 Hold the two lower corners of the SmartLogger, pull it downwards appropriately, and then
push it towards the guide rail. When you hear a click sound, the SmartLogger is successfully
mounted along the guide rail, as shown in Figure 3-6.
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Figure 3-6 Mounting the SmartLogger along a guide rail (2)
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~—-End

3.6 Installing the RS485 signal SPD

Context

e If the SmartLogger needs to be connected to outdoor equipment through the COM port,

it is recommended that an RS485 signal SPD be installed.

®  Each SmartLogger can be configured with a maximum of two RS485 signal SPDs.

®  The RS485 signal SPD can be mounted on guide rail. No guide rail is delivered with an

RS485 signal SPD. If you need to install an RS485 signal SPD on a guide rail, prepare a
standard 35 mm wide guide rail with a length no less than 80 mm.

e Secure the guide rail before mounting the RS485 signal SPD.

o |f the SmartLogger is installed on a guide rail, the RS485 signal SPD can share the guide
rail with the SmartLogger. In this case, the recommended guide rail length is 400 mm or
greater.

Procedure

Step 1 Secure the RS485 signal SPD to the guide rail, as shown in Figure 3-7.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 23



SmartL.ogger1000
User Manual

3 Installation

Figure 3-7 Securing the RS485 signal SPD to the guide rail
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~—-End
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Electrical Connections

This topic describes how to connect the SmartLogger to the inverters, environmental
monitoring instrument, and PCs.

Context

NOTICE

e Ensure that all cables are connected and secured.

e Do not connect a power adapter to the SmartLogger before the cable connections are
complete because the SmartLogger has no startup button.

4.1 Connection Description

Port Description

For the bottom view of the SmartLogger and port description, see Bottom of the Shell in 2.2
Appearance.

Device Connection Description

Figure 4-1 shows the recommended method for connecting the SmartLogger to multiple
devices through the COM ports. For details, see 4.3 Connecting the RS485 Signal SPD-4.9
Connecting to a PID.
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Figure 4-1 Connecting the SmartLogger to multiple devices through the COM ports
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4.2 Connecting the PE Cable for the RS485 Signal SPD

Prerequisites

The ground cable is available. Outdoor copper-core cables with a cross sectional area of 4
mm? or 12 AWG are recommended.

Procedure

Step1 Remove 8 mm of the insulation layer from the ground cable using the wire stripper.

Step 2 Insert the bare cable cores into port 3 of the RS485 signal SPD, as shown by (1) in Figure 4-2.

Figure 4-2 Connecting the PE cable for the RS485 signal SPD

’”

ILO2IC1001
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Step 3 Use a flat-head screwdriver to tighten the screws on port 3, as shown by (2) in Figure 4-2.

Connect the other end of the PE cable to the ground bar.

—End

4.3 Connecting the RS485 Signal SPD

Prerequisites

The communications cable is prepared. The DJYP2VP2-22 2x2x1 network cable or a
communications cable with a cross sectional area of 1 mm? and outer diameter of 14-18 mm
is recommended.

Context

[l noTE

The way of connecting two RS485 signal SPDs is the same as the way of connecting one RS485 signal
SPD.

One RS485 signal SPD provides two RS485 surge protection ports, as shown in Figure 4-3.

Figure 4-3 Ports on an RS485 signal SPD
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Table 4-1 describes the surge protection ports.
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Table 4-1 Port description

RS485 Prote | Function Surg | Function

Surge ction e

Protection | Port Port

Port

RS485 2 RS485A, for RS485 | 1 RS485A, for RS485 positive
surge positive differential differential signaling
protection signaling

port 1 -

6 RS485B, for RS485 | 5 RS485B, for RS485 negative
negative differential differential signaling
signaling

RS485 8 RS485A, for RS485 | 7 RS485A, for RS485 positive
surge positive differential differential signaling
protection signaling

port 2 -

12 RS485B, for RS485 | 11 RS485B, for RS485 negative
negative differential differential signaling
signaling

[l noTE
[ )

Protection ports are connected to COM ports on the SmartLogger. Port 4 is not connected.
e Surge ports are connected to RS485 ports of other devices. Port 3 is the ground port.
e Protection ports and surge ports must not be reversely connected.
e One RS485 signal SPD can protect two COM ports.

e Protection ports 2 and 6 and surge ports 1 and 5 form an RS485 signal SPD port for protecting one
COM port. Protection ports 8 and 12 and surge ports 7 and 11 form another RS485 signal SPD port
for protecting one more COM port.

Procedure

Step1 Remove an appropriate length of steel armor and insulation layer from the cable using a wire
stripper, as shown in Figure 4-4.

Figure 4-4 Stripping an RS485 communications cable (unit: mm)

8-10

1501ZC0036

Step 2 Remove the terminal block from the SmartLogger COM port, as shown in Figure 4-5.
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Figure 4-5 Connecting the terminal block (1)

ILO1110005

Step 3 Connect the cable to the SmartLogger terminal block, as shown in Figure 4-6.

Figure 4-6 Connecting the terminal block (2)

ILO1IC3002

(1) Wiring terminal (2) White contact plate

1. Press the white contact plate of the corresponding wiring terminal to flip the metal spring
inside the wiring terminal.

2. Insert the uninsulated part of the core wire into the wiring terminal.
3. Release the white contact plate to fasten the core wire.

Step 4 Insert the terminal block into the SmartLogger COM port.

Step 5 Insert the bare cable cores at the other end of the cable into a protection port of the RS485
signal SPD, as shown by (1) in Figure 4-7.
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Figure 4-7 Wiring diagram for the RS485 signal SPD

ILO2I1C1003

NOTICE

Verify that the COM+ port on the SmartLogger is connected to protection port 2 or 8 on the
RS485 signal SPD, and that the COM- port on the SmartLogger is connected to protection
port 6 or 12 on the RS485 signal SPD.

Step 6 Use a flat-head screwdriver to tighten the screws on the protection ports, as shown by (2) in
Figure 4-7.

—-End

Follow-up Procedure

Disconnection can be performed in reverse order.

4.4 Connecting the SmartLogger to Inverters

This topic describes how to connect the SmartLogger to inverters.

4.4.1 Connecting the SmartLogger to the SUN2000

This topic describes how to connect the SmartLogger to the SUN2000 using an RS485
communications cable.
Context

The SmartLogger provides three COM ports for RS485 communication, as shown in Figure
4-8.
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Figure 4-8 COM ports on the SmartLogger
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Table 4-2 describes the COM ports.

Table 4-2 COM port description

Port Identifier

Function

NC

Reserved

NC

Reserved

COML1 port

RS485B, for RS485 negative
differential signaling

RS485A, for RS485 positive
differential signaling

RS485B, for RS485 negative
differential signaling

COM2 port

RS485A, for RS485 positive
differential signaling

RS485B, for RS485 negative
differential signaling

COMS3 port

RS485A, for RS485 positive
differential signaling

The RS485 terminal block or RJ45 port on the SUN2000 is used for RS485 communication.
There are two types of RS485 terminal blocks (1 and 2) located in different models of
SUN2000s. All the SUN2000s have RJ45 ports. You are advised to use terminal blocks for

connection.

e  Terminal block connection
- Terminal block 1

Figure 4-9 shows the position of the terminal block in the
SUN2000-50KTL/50KTL-C1. Table 4-3 describes the functions of the terminal

block.
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Figure 4-9 Position of the terminal block in the SUN2000

1503W00003

Table 4-3 Functions of the RS485 terminal block

No. Port Definition Function

1 RS485A IN RS485A, for RS485 positive differential
signaling

2 RS485A OUT RS485A, for RS485 positive differential
signaling

3 RS485B IN RS485B, for RS485 negative differential
signaling

4 RS485B OUT RS485B, for RS485 negative differential
signaling

- Terminal block 2

Figure 4-10 shows the position of the terminal block in the
SUN2000-33KTL/40KTL. Figure 4-11 describes the functions of the terminal
block.
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Figure 4-10 Position of the terminal

Figure 4-11 Terminal block
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Table 4-4 Functions of the RS485 terminal block

No. Port Definition Function

5 RS485A IN RS485A, for RS485 positive differential
signaling

6 RS485A OUT RS485A, for RS485 positive differential
signaling

7 RS485B IN RS485B, for RS485 negative differential
signaling

8 RS485B OUT RS485B, for RS485 negative differential
signaling

RJ45 network port connection
The RJ45 port needs to be connected using an RJ45 connector, as shown in Figure 4-12.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd.

33




SmartL.ogger1000
User Manual

4 Electrical Connections

Figure 4-12 RS485 crystal plug of the SUN2000 (side view without the fastener)
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Table 4-5 lists the wire colors and functions.

Table 4-5 Cable colors and functions

Category Color Function

1 White and orange RS485A, for RS485 positive
differential signaling

2 Orange RS485B, for RS485 negative
differential signaling

3 White and green N/A

4 Blue RS485A, for RS485 positive
differential signaling

5 White and blue RS485B, for RS485 negative
differential signaling

6 Green N/A

7 White and brown N/A

8 Brown N/A

Figure 4-13 shows how to connect the SmartLogger to the SUN2000 through an RS485 signal
SPD. This section describes how to connect the SUN2000-33KTL/40KTL to the
SmartLogger through a terminal block.
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Figure 4-13 Connecting the SmartLogger to the SUN2000
RS485 Signal SPD
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Procedure
Step 1 Prepare a cable with an appropriate length, strip a proper part of the insulation layer from one
end, and connect the end to the SUN2000 terminal block.
e The DJYP2VP2-22 2x2x1 network cable or a communications cable with a cross
sectional area of 1 mm? and outer diameter of 14-18 mm is recommended.
®  [or details about how to strip and connect the cable, see the SUN2000 user manual.
Step 2 Strip an appropriate length from the other end of the cable using a wire stripper, as shown in
Figure 4-14.
Figure 4-14 Stripping an RS485 communications cable (unit: mm)
8-10
1S01ZC0036
Step 3 Insert the bare core wires into the surge port of the RS485 signal SPD, as shown by (1) in

Figure 4-15.
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Figure 4-15 Connecting the surge port of the RS485 signal SPD
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e The RS485 IN and RS485 OUT ports on the SUN2000 can both connect to the
SmartLogger. This document uses the RS485 OUT port as an example to describe the
connection between the SUN2000 and the SmartLogger.

e \frify that the RS485A (OUT) port on the SUN2000 connects to surge port 1 or 7 on the
RS485 signal SPD, and that the RS485B (OUT) port on the SUN2000 connects to surge
port 5 or 11 on the RS485 signal SPD.

e After connecting cables, wrap the part without an insulation layer using PVC insulation
tape.

Step 4 Use a flat-head screwdriver to tighten the screws on the surge ports, as shown by (2) in Figure
4-15.

Step 5 Set Baud Rate to the same value for the SUN2000 and SmartLogger.

®  SmartLogger communications parameters can be set on the LCD or WebUI. For details,
see 6.2.26 Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

®  For details about the communications parameter configurations for the SUN2000, see
SUN2000 APP User Manual.

—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the SUN2000.

4.4.2 Connecting the SUN2000L to the SmartLogger

Context

The SmartLogger provides three COM ports for RS485 communication, as shown in Figure
4-16.
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Figure 4-16 COM ports on the SmartLogger
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Table 4-6 describes the COM ports.

Table 4-6 COM port description

Port Identifier

Function

NC

Reserved

NC

Reserved

COML1 port

RS485B, for RS485 negative
differential signaling

RS485A, for RS485 positive
differential signaling

RS485B, for RS485 negative
differential signaling

COM2 port

RS485A, for RS485 positive
differential signaling

RS485B, for RS485 negative
differential signaling

COMS3 port

RS485A, for RS485 positive
differential signaling

SUN2000L-4.125KTL-JP/4.95KTL-JP connects to the SmartLogger through the bottom

COM port.
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Figure 4-17 COM port on the SUN2000L
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Table 4-7 describes the COM ports.

Table 4-7 COM port pin definitions

No. Label Definition

1 485B1 RS485B, RS485 differential
signal—

2 485A1 RS485A, RS485 differential
signal+

3 485B2 RS485B, RS485 differential
signal—

4 485A2 RS485A, RS485 differential
signal+

5 N/A N/A

6 N/A N/A

7 N/A N/A

8 PE Port for grounding the shield
layer

Figure 4-18 shows how the SmartLogger connects to the SUN2000L through an RS485 signal
SPD.
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Figure 4-18 Connection between the SmartLogger and the SUN2000L
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Procedure

Step 1 Prepare a cable with an appropriate length, strip an appropriate length from one end, and
connect the end to the SUN2000L terminal block.

®  Select a two-core outdoor shielded RS485 communications cable with a cross-sectional
area of 0.25-1 mm? (0.9 mm? recommended).

®  For details about how to strip and connect the cable, see the SUN2000L-(4.125KTL,
4.95KTL)-JP User Manual.

Step 2 Strip an appropriate length from the other end of the cable using a wire stripper, as shown in
Figure 4-19.

Figure 4-19 Stripping an RS485 communications cable (unit: mm)

1501ZC0036

Step 3 Insert the bare core wires into the surge port of the RS485 signal SPD, as shown by (1) in
Figure 4-20.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 39



SmartL.ogger1000
User Manual 4 Electrical Connections

Figure 4-20 Connecting cables to the surge port of the RS485 signal SPD
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e \frify that the 485A1 or 485A2 port on the SUN2000L connects to surge port 1 or 7 on
the RS485 signal SPD, and that the 485B1 or 485B2 port on the SUN2000L connects to
surge port 5 or 11 on the RS485 signal SPD.

e After connecting cables, wrap the part without an insulation layer using PVC insulation
tape.

Step 4 Use a flat-head screwdriver to tighten the screws on the surge ports, as shown by (2) in Figure
4-15.

Step 5 Set Baud rate to the same value for the SUN2000L and SmartLogger.

SmartLogger communications parameters can be set on the LCD or WebUI. For details, see
6.2.26 Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

—End

Follow-up Procedure

Disconnection can be performed in reverse order.

4.4.3 Connecting Multiple Inverters to the SmartLogger

This topic describes how to connect the SmartLogger to multiple inverters.

The SmartLogger can connect to multiple inverters through a daisy chain, as shown in Figure
4-21.
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Figure 4-21 Connecting Multiple Inverters to the SmartLogger

EMI Inverter Inverter Inverter
av av av
| | | ] | _ | |
Inverter Inverter Inverter Inverter
- - - - = SmartLogger1000
v av av v
[ J | ] | _ | |
Inverter Inverter Inverter Inverter
av av av av
[ J | | | _ | |
ILOTNCO001
L] noTE

e A maximum of 80 devices can be connected to one SmartLogger. You are advised to connect fewer
than 30 devices to each RS485 route.

e The addresses for all devices in the daisy chain should be within the searching scope set in the
SmartLogger and they must differ from each other. Otherwise, the communications would fail
between the device and the SmartLogger.

e |f the firmware version of the SUN2000 is V100R001C00SPCO10 or later, or
V100R001C81SPC105 or later, you can perform Auto Assign Address on the SmartLogger. If
detecting that an RS485 address is repeatedly used, the SmartLogger automatically allocates another
address and hence no local operation is required.

e Baud rate of all the devices in one daisy chain should stay consistent with those of the
SmartLogger.

4.5 Connecting to an EMI

4.5.1 Connection Description

There are two types of EMI. One is the standard EMI that supports the Modbus-RTU protocol,
and it can directly connect to the SmartLogger. The other is the EMI that is composed of
sensors, whose signals need to be converted into RS485 signals (Modbus-RTU) over an extra
analog-to-digital converter before the sensors are connected to the SmartLogger.

4.5.2 Connecting the SmartLogger to an EMI That Supports
Standard Modbus-RTU

Context

The SmartLogger can connect to an EMI that supports the standard Modbus-RTU protocol.
One SmartLogger can connect to and manage only one EMI.
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Devices from different vendors may support different protocols. To normally obtain
information from the connected EMI, correctly configure the protocol on the SmartLogger
WebUI based on the document delivered by the vendor.

For the definition of the RS485 communications cable for the EMI, see the instructions
delivered with the EMI.
There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.
Figure 4-22 shows how to connect the SmartLogger to the EMI.
Figure 4-22 Connecting the SmartLogger to the EMI
RS485 Signal SPD
R EEES:
e ® 3 |9
S o OIS
ILO1IC3004
Procedure
Step1 Connect one end of the cable delivered with the EMI to the RS485 port of the EMI.
Step 2 Connect the other end of the cable to a Surge port of the RS485 signal SPD. For details, see

Step 2-Step 4 in Procedure in 4.4.1 Connecting the SmartLogger to the SUN2000.

Verify that the RS485+ port on the EMI is connected to Surge port 1 or 7 on the RS485 signal
SPD, and that the RS485- port on the EMI is connected to Surge port 5 or 11 on the RS485
signal SPD.

L] noTE

e The EMI cannot be detected automatically. You need to add this device manually on the LCD or
WebUI. For details about this operation, see 6.2.34 Managing Devices or 7.11.8.1 Connecting
Devices.

e After the EMI is connected, log in to the embedded WebUI and set relevant parameters for the EMI.
For details, see 7.8.4.2 Setting EMI Parameters. Select the specific model of EMI.

e When the SmartLogger is connected to an EMI and multiple inverters at the same time, connect the
EMI to the end of the daisy chain. For details, see 4.4.3 Connecting Multiple Inverters to the
SmartLogger.
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—End

Follow-up Procedure

Take the reverse steps to disconnect the SmartLogger from the EMI.

4.5.3 Connecting the SmartLogger to a Split EMI

The EMI used in Europe and Southeast Asia is composed of sensors, whose signals need to be
converted into RS485 signals (Modbus-RTU) over an extra analog-to-digital converter before
the sensors are connected to the SmartLogger.

The analog-to-digital converter should provide an RS485 port and support the standard
Modbus-RTU protocol. This section describes the connection between the SmartLogger and a
split EMI through the ADAMA4117 that functions as an analog-to-digital converter.

There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-23 shows how to connect the SmartLogger to a split EMI through an RS485 signal
SPD and analog-to-digital converter.

Figure 4-23 Connecting the SmartLogger to a split EMI (1)
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Step 1 Prepare a cable with an appropriate length, strip a proper part of the insulation layer from one
end, and connect the end to the port on the analog-to-digital converter.

e The DJYP2VP2-22 2x2x1 computer cable or a communications cable with a conductor
cross-sectional area of 1 mm? and outer diameter of 14-18 mm is recommended.
®  For detailed operations, see the document delivered with the analog-to-digital converter.

Step 2 Remove an appropriate length of the steel armor and wire insulation layer from the other end
of the cable using a wire stripper, as shown in Figure 4-24.
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Figure 4-24 Stripping a cable (unit: mm)
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Step 3 Insert the bare core wires into the surge port of the RS485 signal SPD, as shown by (1) in
Figure 4-25.

Figure 4-25 Connecting cables to the surge port of the RS485 signal SPD

r B

J
IL02IC1002

Verify that the RS485+ port on the analog-to-digital converter connects to surge port 1 or 7 on
the RS485 signal SPD, and that the RS485— port on the analog-to-digital converter connects
to surge port 5 or 11 on the RS485 signal SPD.

Step 4 Use a flat-head screwdriver to tighten the screws on the surge ports, as shown by (2) in Figure
4-25.

Step 5 Set Baud rate for the analog-to-digital converter to the same value as that for the
SmartLogger.

®  SmartLogger communications parameters can be set on the LCD or WebUI. For details,
see 6.2.26 Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

®  For details about the communications parameter configurations for the analog-to-digital
converter, see the delivered document.

Step 6 Connect each sensor to the analog-to-digital converter. For detailed operations, see the
documents delivered with the analog-to-digital converter or sensors.

LLl NnoTE

e After connecting the cables, log in to the embedded WebUI and set relevant parameters. For details,
see 7.8.4.2 Setting EMI Parameters. The selected EMI model is Sensor(ADAM).

e The EMI cannot be detected automatically. You need to add this device manually on the LCD or
WebUI. For details about this operation, see 6.2.34 Managing Devices or 7.11.8.1 Connecting
Devices.
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e If the SmartLogger needs to connect to an EMI and multiple inverters, connect the EMI at the end of
the daisy chain, and verify that other devices connected to the port have different addresses from the
EMI. For the daisy chain connection, see 4.4.3 Connecting Multiple Inverters to the SmartLogger.

—End

4.6 Connecting the SmartLogger to a Power Meter

This topic describes how to connect the SmartLogger to a power meter.

Context

The SmartLogger can be connected to a power meter that supports the standard Modbus-RTU
or DL/T645 protocol.

[l noTE

e The SmartLogger can be connected to and manage only one power meter that supports the
Modbus-RTU protocol.

e The SmartLogger can be connected to and manage multiple power meters that support the DL/T645
protocol.

The protocol points for Power Meters provided by different vendors are varied. Therefore, to
obtain information from a Power Meter, configure the protocol point on the WebUI of the
SmartLogger properly based on the document delivered by the vendor.

For details about the definition of the RS485 communications cables for the Power Meter, see
the operation manual delivered with the Power Meter.

There are three RS485 ports in the SmartLogger. For details about the port descriptions, see
Context in 4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-26 shows how to connect the SmartLogger to the Power Meter.

Figure 4-26 Connecting the SmartLogger to a power meter

COM1 COM2 COM3
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A Power Meter is typically installed indoors, and can be connected to the COM port of the SmartLogger
without an RS485 signal SPD.
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Procedure

Step 1 Connect one end of the cable delivered with the power meter to the RS485 port of the Power
Meter.

Step 2 Connect the other end of the cable to the COM port of the SmartLogger. For details, see Step
1-Step 4 in Procedure in 4.3 Connecting the RS485 Signal SPD.

NOTICE

Connect the RS485+ port of the Power Meter to the COM+ port of the SmartLogger and the
RS485- port of the Power Meter to the COM- port of the SmartLogger.

L] noTE

e After connecting the cable for a power meter that supports the Modbus-RTU protocol, log in to the
embedded WebUI and set relevant parameters for the Modbus power meter. For details, see 7.10.2.3
Setting Power Meter Parameters.

e Devices connected to a COM port of the SmartLogger must support the same protocol. After
connecting the cable, modify the COM port protocol on the LCD or WebUI. For details, see 6.2.26
Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

e The power meter cannot be detected automatically. You need to add this device manually on the
LCD or WebUI. For details about this operation, see 6.2.34 Managing Devices or 7.11.8.1
Connecting Devices.

—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the Power Meter.

4.7 Connecting to a PLC

This topic describes how to connect the SmartLogger to a PLC.

Context

The RS485 port of a PLC is an RJ45 port that should be connected to an RJ45 connector, as
shown in Figure 4-27.
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Figure 4-27 PLC RS485 port connection (side view without the fastener)
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Table 4-8 lists the cable colors and functions.

Table 4-8 Cable colors and functions

No. Color Function

1 White and orange Reserved

2 Orange Reserved

3 White and green 12 Vin, power

4 Blue RS485A, and RS485 differential signal
+

5 White and blue RS485B, and RS485 differential signal

6 Green Reserved

7 White and brown Reserved

8 Brown N/A

There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in

4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-28 shows how to connect the SmartLogger to the PLC.
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Figure 4-28 Connecting the SmartLogger to the PLC
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Procedure

Step 1 Choose a shielded network cable of appropriate length. Crimp an RJ45 connector at one end
and connect it to the RS485 port of the PLC.

Step 2 Connect the other end of the cable to the COM port of the SmartLogger. For details, see Step
2-Step 4 in Procedure in 4.3 Connecting the RS485 Signal SPD.

e Connect the RS485+ port of the PLC to the COM+ port of the SmartLogger and connect
the RS485- port of the PLC to the COM- port of the SmartLogger.

e The PLC cannot be detected automatically. You need to add this device manually on the
LCD or WebUI. For details about this operation, see 6.2.34 Managing Devices or 7.11.8.1
Connecting Devices.

e The Huawei PLC supports auto-negotiation of baud rate 9600 bps/115200 bps. If the PLC
networking is used, you are advised to set Baud rate to 115200 bps for the RS485 ports of
the SmartLogger to achieve better communication performance.

——End

Follow-up Procedure

Take the reverse steps to disconnect the SmartLogger from the PLC.
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4.8 Connecting an Ethernet Network Cable

Context

Procedure

Step 1

Step 2

The SmartLogger can be connected to an Ethernet switch, router, or POE module. It can also
be connected to the Ethernet electrical port of a PC directly or through a hub. Select the
connection device based on the actual networking scenario.

Connect one end of the delivered network cable to the Ethernet electrical port of a device.

L1l noTE

If the delivered cable is too short, pay attention to the following when preparing a cable:
e Select CAT 5E or a higher-class shielded network cable.
e It is suggested that the cable length is less than or equal to 100 meters.

Connect the other end of the network cable to the FE port of the SmartLogger, as shown in
Figure 4-29.

Figure 4-29 Connecting an Ethernet network cable
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e A POE module can be connected only to the DATA port of the SmartLogger.

e The default IP address of the SmartLogger is 192.168.0.10, the default subnet mask is 255.255.255.0,
and the default gateway is 192.168.0.1.

e If the SmartLogger is connected to a PC directly or through a hub, the IP addresses of the
SmartLogger and PC must be in the same network segment. For example, if the IP address of the
SmartLogger is 192.168.0.10, the IP address of the PC can be 192.168.0.11. The subnet mask and
the gateway of the PC should be consistent with those of the SmartLogger.

o If the SmartLogger connects to the PC through a network device (for example, a router), set the IP
addresses for the SmartLogger and network device to be in the same network segment. Correctly set
the gateway of the SmartLogger to ensure that the SmartLogger can normally communicate with the
network device.
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e To enable communication between the SmartLogger and the NMS on the PC, set the management
system parameters properly on the LCD or WebUI. For details, see 6.2.26 Setting Communications
Parameters or 7.10.2.4 Setting Management System Parameters.

—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the PC.

4.9 Connecting to a PID

This section describes how to connect the SmartLogger to a PID.

Context

There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-30 shows how to connect the SmartLogger to the PID module.

Figure 4-30 Connecting the SmartLogger to the PID

ILO1IC3018

[l noTE

In the scenarios with the communication box, the SmartLogger and PID module are installed before
delivery, and the PID module is connected to the SmartLogger through the X2 terminal block.

Procedure

Step 1 Connect one end of the cable delivered with the PID to the RS485 port of the PID.

Step 2 Connect the other end of the cable to a Surge port of the RS485 signal SPD. For details, see
Step 2-Step 4 in Procedure in 4.4.1 Connecting the SmartLogger to the SUN2000.
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NOTICE

Verify that the brown cable (RS485A) of the PID module is connected to Surge port 1 or 7 on
the RS485 signal SPD, and that the black cable (RS485B) is connected to Surge port 5 or 11
on the RS485 signal SPD.

—-End

Follow-up Procedure

Take the reverse steps to disconnect the SmartLogger from the PID module.

4.10 Connecting the SmartLogger to a Ripple Control
Receiver

This topic describes how to connect the SmartLogger to a ripple control receiver.

Context

In Germany and some European areas, a ripple control receiver is used to convert a power
grid scheduling signal to a dry contact signal, in which a dry contact is required.

Figure 4-31 shows the DI ports of the SmartLogger.

Figure 4-31 DI ports of the SmartLogger

ILO1WC0008

Table 4-9describes the definition of the DI ports.

Table 4-9 DI port description

Port Functions

GND1 Dry contact_input common terminal 1, used for active
power derating for DI1-DI4

1 DI_1

2 DI 2

3 DI 3
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Port Functions
4 DI_4
GND2 Dry contact input common terminal 2, used for reactive
power compensation for DI1-DI14
Figure 4-32 shows how to connect the Smart Logger to the ripple control receiver.
Figure 4-32 Connecting the SmartLogger to a ripple control receiver
y s’ '8 N
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ILO1IC3010
NOTICE
When active power remote control and reactive power remote control are supported, only one
out of the four outputs of each ripple control receiver can be closed.
Procedure
Step 1 Select a cable of appropriate length and connect one end of a cable to the ripple control
receiver.
Step 2 Connect the other end to the DI port in the SmartLogger. For details, see Step 2—Step 4 in

Procedure in 4.3 Connecting the RS485 Signal SPD.

To enable a normal power grid scheduling function, you need to set the corresponding
parameters (Active Power Control or Reactive Power Control) on the embedded WebUI. For
details, see 8 Power Grid Scheduling.

—-End
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Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the ripple control
receiver.
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System Operation

This topic describes how to start the SmartLogger and set the initialization parameters.

5.1 Power-on Process

This section describes how to check the SmartLogger before power-on and how to power on
the SmartLogger.

Checking Before Powering On the SmartLogger
Check and ensure the following before powering on the SmartLogger.

®  All cables are intact and well insulated.
e  All cables are of proper size.
e All cables are correctly connected and secured.

Power-on Process

Power on the devices in the following sequence: Inverter > SmartLogger > PC terminal.

[l noTE

The PC terminal refers to a PC where the NetEco1000 is installed.

Step Operation

1 Perform the requirements mentioned in Checking Before Powering On the
SmartLogger.

2 Start the inverter and correctly set the communications parameters

(including Address, and Baud rate).

For details about how to set communications parameters, see the user
manual of the corresponding inverter or SUN2000 APP User Manual.

3 Connect the output terminal of the power adapter for the SmartLogger to
the power port POWER and the input terminal to the AC socket.
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Step Operation

4 Set the search address segment and baud rate for the RS485 port on the
SmartLogger monitoring panel.

If the SmartLogger is powered on for the first time, set the search address
segment and baud rate for the RS485 port in the Wizard, as shown in 5.2
Setting Initialization Parameters. If it is not powered on for the first time,
set the parameters in the Comm. Param. under the Settings, as shown in
6.2.26 Setting Communications Parameters.

5 Wait for the SmartLogger to search for inverters. After the search is
completed, the SmartLogger automatically connects to all inverters.

Alternatively, you can skip this operation and manually search for, add, or
delete inverters in follow-up operations. For details, see 6.2.34 Managing
Devices.

6 (Optional) Manually add an environment monitoring instrument, power
meter, PLC, or third-party device.

For details, see 6.2.34 Managing Devices.

NOTICE

Before adding an environment monitoring instrument or power meter, log in to the
WebUI and correctly set parameters for the device to be added. Before adding a
third-party device, import a correct configuration file for the device.

7 (Optional) Start the PC and correctly set parameters of the Ethernet and
management system on the SmartLogger.

® Use the delivered 12 V power adapter when starting the SmartLogger. Confirm with the
local Huawei engineers if using other types of power adapters.

e | og in to the SmartLogger on the monitoring panel. When you log in to the Settings page
or Maintenance page, an identity authentication is required. The initial password is
000001.

e Use the initial password upon first power-on and change it immediately after login. To
ensure account security, change the password periodically and keep the new password in
mind. Not changing the initial password may cause password disclosure. A password left
unchanged for a long period of time may be stolen or cracked. If a password is lost,
devices cannot be accessed. In these cases, the user is liable for any loss caused to the PV
plant.

5.2 Setting Initialization Parameters

When starting the SmartLogger for the first time, set initialization parameters on the
monitoring panel.
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Context

[l noTE

If the SmartLogger is started for the first time, set the initialization parameters by referring to this
section. If it is not started for the first time, it directly performs the automatic search and then the default

page.

Procedure

e  The following table describes the process for setting initialization parameters. The
parameter values in the following figures are for reference only.

LCD Operation Procedure

1. After startup, the SmartLogger enters the
initialization page.

sg The default system language is English.

2. Press 4J to enter the Wizard page.

To return to the default page, press ESC. If
some later re-settings are required, refer to
IR R IR e N el 6.2.20 Setting the System Language, 6.2.21
ESC :Cancel J:Enter Setting System Time Parameters, and 6.2.26
Setting Communications Parameters.

WN1zard 3. Select a display language and then press

The pages will be displayed in the selected
language.

Deutsch
Italiano

B35

Fran¢ais
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LCD Operation Procedure
N1zard 4. Set the correct date and time and then press
Date&Time
1Z: * To select the specific parameter, press 4J

DST:Disable
Date:2016-02-27
Time:10:53:11

To set the parameter value, press 4\ or

v,

® The date and time are displayed in the
formats of YYYY-MM-DD and hh:mm:ss
respectively. YYYY stands for the year,
MM the month, DD the date, hh the hour,
mm the minute, and ss the second.

NOTICE
After the Time is successfully set, this time can be
synchronized in all the inverters connected to the
SmartLogger.

izard—->Ethernet
:Disable

IP address:192.168. 0. 10

Subnet mask:255, 255, 255, 0

Gateway:192.168. 0. 1

DNS-1:192.168. 0. 1

DNS-2: 0. 0. 0. 0
Submi t

5. Set the Ethernet parameters and then press

Nizard
Search Address Segments
[egetetegil i 001-100
RS485-2:001-100
RS485-3:001-100

6. Set the RS485 search address segment and
then press 4J

You need to set the search address segments
for RS485-1, RS485-2, and RS485-3
respectively.

Initialization—->3earch Devices

ESC :Cancel

7. On the page, press 4J
After the search is complete, the SmartLogger

displays a search result. Press 4J to end this
operation.
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Visiting some menu requires identity authentication. Therefore, after you set the initialization parameters,
change the password immediately to ensure the security of the user account. For details, see Change the
Password.

—-End
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User Interface

This topic describes the monitoring menu and operations.

Context

The screenshots shown in this document are from SmartLogger V100R001C00SPC118. Data
in the screenshots is for reference only.

6.1 Monitoring Menu Hierarchy

The SmartLogger LCD menus include Power Station, Devices, Alarms, Settings,
Maintenance, and About. The Settings and Maintenance screens vary with the login users.

Table 6-1 LCD monitoring menus

Main Menu Second-Level | Third-Level Menu
Menu

Default screen | Power Station | E-Daily, E-Month, E-Year, E-History, E-Total

Devices Logger(Local), Inverter, Logger, Power Meter, PLC,
PID, EMI, Custom Device

Alarms Active Alarms, Alarm History, Sort By

Settings For the user operation permissions of the menu, see
Table 6-2.

Maintenance For the user operation permissions of the menu, see
Table 6-3.

About -

[l noTE

e indicates that the user has permission to operate the menu; o indicates that the user does not have
permission to operate the menu.
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Table 6-2 User operation permissions of the Settings menu

Settings Common User | Advanced Special User
User

Third-Level Fourth-Level

Menu Menu

User Param. Language ) ) o)
Date&Time ) ° o
Date Format ° ° o
Contrast ) ° o
Currency ° ) o
Electricity ) ° o
price/kWh
CO2 emission | e ° o
reduction

User Password | - ) ° °

Comm. Param. | RS485-1to o o o
RS485-3
Ethernet o ° o
Management o ° o
System
Modbus TCP o ) o
IEC103 o ° o
SmartLogger o ) o
Address

Restore - o ) °

Defaults

Table 6-3 User operation permissions of the Maintenance menu
Maintenance Common User | Advanced Special User
User

Third-Level Fourth-Level

Menu Menu

USB Expansion | Device Logs o ° °
Firmware o ° °
Upgrade
Batch Upgrade | o ° °
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Maintenance Common User | Advanced Special User
User
Third-Level Fourth-Level
Menu Menu
Exportall data | o ° °
files
Importall data | o ° °
files
Offline config | o ° °
Device Mgmt. Auto. Search o ° °
Add Manually | o ° °
Single Remove | o ° °
Batch Remove | o ° °
Addr. Allocate | o ° °
Config Import | o ° °
Alarm Reset o ° °
Batch o ° °
Power-On/Off
Batch Reset o ° °
Data Clear - o ° °
System Reset - o ° °

6.2 Monitoring Operations

This topic describes how to operate on the monitoring panel, such as querying site and device
information and setting system parameters and user parameters.

6.2.1 Querying Power Station Information

Procedure

This topic describes how to view the power station information on the monitoring panel of the
SmartLogger, such as the daily, monthly, yearly, historical, and total energy yield.

The following table describes the procedure for viewing power station information. The
parameter values in the following figures are for reference only.
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NOTICE

e The daily energy yields can be stored for 30 days on an hourly basis.

e The monthly energy yields can be stored for 1 year on a daily basis.

e The yearly energy yields can be stored for 10 years on a monthly basis.
e The historical energy yields can be stored for 25 years on a yearly basis.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

Elam®mz |y @

Power Station

2. Choose @ and press 4J

Fower Station \

E-Nonth
E-Year
E-History
E-Total

3. Press A and W to view the running
data of the power station.

The running data includes the daily, monthly,
yearly, historical, and total energy yield. For
details, see step 4 to step 8.
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LCD

Operation Procedure

Power Station—>E-Dailw

2015-09-15

kWh

04:00 02:00 12:00 16:00 20:00

N

0. 65kih

0. 68kg [ €0

ESC A v A

v

Power Station—->E-Daily

2015-09-15 15H

IR

kKWh

04:00 08:00 12:00 16:00 20:00

0. S6kth

0. 56kg [ €0

ESC A v

4. View the daily energy yield.

a. On the E-Daily screen, view the total
energy yield and hourly energy yield of the
power station on the current day.

The displayed information includes the energy
yield histogram, date, total energy yield on the
current day, CO2 emission reduction, and
revenue.

To view the energy yield in the past 30 days
(including the current day), press 4 or V.

NOTE

In the daily energy yield histogram, the abscissa
stands for time (each block stands for one hour).
The ordinate stands for the total energy yield of all
the inverters connected to the SmartLogger (each
block stands for the total energy yield during the
last hour).

b. Press 4J to view the energy yield of a
specific hour on the current day.

Press A or W to switch between hours.
Then you can view the total energy yield, CO;
emission reduction, and revenue
corresponding to the CO; emission reduction
during an hour before this sharp time.

NOTE
The selected block is displayed in white.
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LCD

Operation Procedure

Power Station—>E-MNonth

2015-07

4 H 12 1e 20 24

2%

4

6. 13kkh

B. 11kg | €6

ESC A v

|

v

Power Station—>E-Nonth

2015-07-01

4 & 1z 16 20 24

28

o

5. 49kth

5. 4Tkg [ €5

ESC A v

5. View the monthly energy yield.

a. On the E-Month screen, view the total
energy yield and daily energy vyield in the
current month.

The displayed information includes the energy
yield histogram, Month, total energy yield of
the current month, CO; emission reduction,
and revenue.

To view the energy yield in the past 12 months
(including the current month), press 4\ or

NOTE

In the monthly energy yield histogram, the
horizontal axis stands for day (each block stands for
one day). The vertical axis stands for the total
energy yield of all the inverters connected to the
SmartLogger (each block stands for the total energy
yield on that day).

b. Press 4J to view the energy yield on a
specific day of the current month.

Press A or W to switch between days.
Then you can view the total energy yield, CO,
emission reduction, and revenue
corresponding to the CO; emission reduction
on the current day.

NOTE
The selected block is displayed in white.
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Power Station—>E-Year

2015

1 2 3 4 5§ € 7 2 2 10 11 12
T. 36Kk
T. 34kg | €7
ESC A v ,_l

v

Power Station—->E-Vear

2015-07

1 2 5 4 5 & T & % 10 11 12

6. 16kth

6. 14kg [ €6

ESC A v

6. View the yearly energy yield.

a. On the E-Year screen, view the total energy
yield of the current year and monthly energy
yield.

The displayed information includes the energy
yield histogram, year, total energy yield of the
current year, CO, emission reduction, and
revenue corresponding to the CO2 emission
reduction.

To view the energy yield in the past 25 years
(including the current year), press 4\ or

NOTE

In the yearly energy yield histogram, the horizontal
axis stands for month (each block stands for one
month). The vertical axis stands for the total energy
yield of all the inverters connected to the
SmartLogger (each block stands for the total energy
yield in that month).

b. Press 4J to view the monthly energy yield
of the current year.

Press A or W to switch between months.
Then you can view the total energy yield, CO-
emission reduction, and revenue
corresponding to the CO, emission reduction
in the current month.

NOTE
The selected block is displayed in white.
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Power Station—>E-History

1991 - 2015
2 KWh
o . . . v L
29 a4 49 04 03 14
7. 4TkHh
7. 45kg | =X
ESC o

v

Power Station—->E-History

2015
o Kum
o v v v v H >
249 a4 a4 04 09 14
T. 4Tkfh
T.45kg | £7
ESC A v

7. View the historical energy yield.

a. On the E-History screen, view the total
energy yield over the past 25 years (including
the current year) and yearly energy yield.

The displayed information includes the energy
yield histogram, Year, total energy yield, CO;
emission reduction, and revenue.

NOTE

In the historical energy yield histogram, the
horizontal axis stands for year (each block stands
for one year). The vertical axis stands for the total
energy yield of all the inverters connected to the
SmartLogger (each block stands for the total energy
yield in that year).

b. Press 4J to view the yearly energy yield
over the past 25 years (including the current
year).

Press A or W to switch between years.
Then you can view the total energy yield, CO;
emission reduction, and revenue
corresponding to the CO; emission reduction
in the current year.

NOTE
The selected block is displayed in white.

Power Station—>E-Total

E-Total:1l. 6THWh
Reduced COZ:16. 68t
Revenue: 16681 €

8. On the E-Total screen, view the total
energy yield, CO> emission reduction, and
revenue of all the devices connected to the
SmartLogger.

The total energy yield of the devices before
they connect to the SmartLogger is also
counted in the system after they are connected.

—End

6.2.2 Querying Inverter Information

This topic describes how to query the running information and version of each inverter

connected to the SmartLogger.

Procedure

e  The following table describes the procedure for viewing inverter information. The
parameter values in the following figures are for reference only.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd.

66




SmartL.ogger1000
User Manual

6 User Interface

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

mn
2. Select mm and press <J

Devices—>Select (1/2)

SUN2000(1--2) :
EMI(2--1): Online

On-grid

3. Select an inverter and press 4J

NOTE

SUN2000 (1--2) on the left indicates that the
inverter connects to Port 1 of the SmartLogger and
the communications address of the RS485 port is 2.

The device status is displayed behind the
device name.

The follow-up operations are described as
follows:

* To view the operating data of the inverter,
perform step 4.

e To view the version of the inverter,
perform step 5.
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Naintenance
About

v

SUN2000(3-1)

E-Nonth
E-Year
E-History
E-Total
Input Data
Output Data

4. Select Running and press 4J
Press A and W to select the target
parameter, and then press <J

SUN2000(3-1)

Running
Naintenance

About

SUN2000(3-1)

Type: SUNZ000
Nodel : SUN2000-28KTL
Version:V100R001C815PC110
SN: INVSUNZ000V1R1C81001

www, huawel. com

5. Select About and press 4J

~--End
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6.2.3 Manually Powering On or Off the Inverter on the
monitoring panel

Procedure

This topic describes how to power on or off the inverter on the monitoring panel.

e  The following table shows the procedure for powering on or off the inverter on the
monitoring panel. The parameter values in the following figures are for reference only.

Choose Batch Power-On/Off under Maintenance to power on or off all inverters that

connect to the SmartLogger.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

N
2. Choose mm and press 4J

Devices—>Select (1/2)
On—grid

SUNZ2000(1--2) :
EMI{(2--1): Online

3. Select an inverter and press <J

NOTE
SUN2000 (1--2) on the left indicates that the

inverter connects to Port 1 of the SmartLogger and
the communications address of the RS485 port is 2.
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LCD

Operation Procedure

SUN2000(3-1)

Running

Naintenance

About

4. Choose Maintenance, and press 4J

Maintenance—>Login

IES N dvanced Usergs

Password: 000000

5. Because of permission restriction, log in as
Common User, Advanced User, or Special
User.

‘SUNZOOO(S—I) \

Reset

6. Choose Power-On/Off, and press 4J

e Perform step 7 if you want to power on the
inverter manually.

e Perform step 8 if you want to power off the
inverter manually.
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SUN2000 (1--7)

Power-0ff

v

SUN2000 (1--7)

— ]

Power on?

ESC :Car

o :Enter

7. Power on manually.

a. Choose Power-On and press ¢J

b. Enter 4J again to verify your settings.

SUN2000 (1--7)

Power-On

v

SUN2000 (1--7)

Power off?
ESC :Cancel

o :Enter

8. Power off manually.

a. Choose Power-Off, and press 4J

b. Enter ¢J again to verify your settings.

—-End

6.2.4 Sending a Reset Command to the Inverter

You can send a reset command to the inverter on the LCD.
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Procedure

The following table describes the procedure for sending a reset command to the inverter.
The parameter values in the following figures are for reference only.

LCD

Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

[ ]
2. Choose mm and press 4J

Devices—>Select (1/2)

SUN2000(1--2) : On-grid
ENI(2--1): Online

3. Select an inverter and press 4J

NOTE

SUN2000 (1--2) on the left indicates that the
inverter connects to Port 1 of the SmartLogger and
the communications address of the RS485 port is 2.

SUN2000(3-1)

Running

Naintenance

About

4. Choose Maintenance, and press 4J
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Maintenance—>Login 5. Because of permission restriction, log in
as Advanced User,.

IES N dvanced Usergs

Password: 000000

SUN2000(3-1) 6. Choose Reset and press |
Power-On/0ff

Maintenance—->Reset 7. Press 4J

Reset the system?

ESC :Cancel o :Enter

—End

6.2.5 Querying Information about the EMI

This topic describes how to query the EMI information on the monitoring panel.

Procedure

e  The following table describes the procedure for querying information about the EMI.
The parameter values in the following figures are for reference only.
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2017-08-10 16:32:24
1. On the default screen, press 4J to enter

the main menu.

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

[ ]
2. Choose mm and press <J

EEH® s Y E

Devices
Devices—>Select (5/5) 3. Choose the name of the EMI and press 4J
[ogger (Local) :Online to view information about the instrument.
SUN2000(3-2) :On-grid The device status is displayed behind the
PLC (3-249) :Online device name.

PID(3-1) :Rurning
EMI(1-1) :Online

4. Choose Running and press <J

® To view the running information of the
EMI, perform step 5 only.

® To view the communications address of the
EMI, perform step 6 only.
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ation

Comm. Address

v
EMI(1-1)

Total irradi. :220.0W/m 2

Daily irradiat: (. 704kWh/m"2

PV temperature: 39, 0dezC

Ambient temp:25, 0degC
Wind speed:?23. Om/s

Wind direction: 45 (Northeast)

5. Choose Running Infomation and press

EMI(1-1)

Running Infomation

Comm. Addr

v
EMI(1-1)

Port number:1
Comm. address:1
Logical address:9

6. Choose Comm. Address and press 4J

~--End

6.2.6 Querying Master SmartLogger Information

This topic describes how to query Master SmartLogger information.
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Procedure

®  To query Master SmartLogger information, perform the steps described in the following
table. The parameter values in the figures are for reference only.

LCD

Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

[ ]
2. Choose mm and press 4J

Devices—>Select (1/1)

Logger (Local)

v

Logger (Local)

E-Total : 834. OkiWh
Reduced C0Z:831. dkg
Input power:20. 202kW

Active power:20. 000kW
React. power:0. 300kVar
Power factor:0.999

E-Daily:12. 00kWh |

3. Choose Logger (Local) and press 4J to
view the Master SmartLogger information.

~--End
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6.2.7 Querying Slave SmartLogger Information

This topic describes how to query Slave SmartLogger information on the monitoring panel.

Context

The Slave SmartLogger mainly applies to power grid scheduling of large-sized power stations.
One SmartLogger can connect to a maximum of 80 devices. When there are more than 80
inverters in the power station, a certain number of Slave SmartLoggers should be configured.
The power grid scheduling command sent to the Master SmartLogger is synchronized to the
Slave SmartLogger to enable the centralized power grid scheduling of the power station.

Devices can only be manually added and removed in the Slave SmartLogger on the
monitoring panel or the embedded WebUI.

The Slave SmartLogger and the Master SmartLogger should be within the same local area
network (LAN).

Procedure

®  To query Slave SmartLogger information, perform the steps described in the following
table. The parameter values in the figures are for reference only.

LCD Procedure

2017-08-10 16:32:24 {| 1 O the default screen, press «d toenter

the main menu.

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

N
2. Select mm and press <J

EEH® s Y E

Devices
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LCD

Procedure

Devices—>Select (1/2)

Logger (net. 22. 243) : Disconnec
Power Meter(1--2): Online

3. Choose Logger to view the status and IP
address of the Slave SmartLogger.

The device status is displayed behind the
device name.

—End

6.2.8 Querying Information About the Modbus Power Meter

You can query information about the Modbus power meter over the LCD.

Procedure

e The following table describes the procedure for querying information about the Modbus
power meter. The parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

T kWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

N
2. Select mm and press 4J
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LCD

Operation Procedure

Devices—>Select (3/3)

[ogger (Local) :Online
SUN2000(3-1) :On-grid

Power Meter(1-1):0nline

3. Choose Power Meter and press 4J to
query the power meter information.

NOTE
Power Meter (1-1) on the left indicates that the
power meter connects to Port 1 of the SmartLogger
and the communications address of the RS485 port
is 1.

The device status is displayed behind the

device name.

Eunning

4. Choose Running and press <J

® To view the running information of the
power meter, perform step 5 only.

e To view the communications address of the
power meter, perform step 6 only.

ower Meter(1-2)

Rurming Infomation

Comm. Address

v

Power Meter (1-2)

Phase A voltage:1001.
Phase B voltage:100%Z.
Phase C voltage:1003.
A-B line voltage:1004.
B—C line wvoltage:1005.
C—A line voltage:1006.

Phase & current:1007.

00V
00V
00V
ooV
00V
00V
0A

5. Choose Running Infomation and press
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LCD

Operation Procedure

Power Meter(1-1)

Comm. Addr

Running Infomation

v

Power Meter(1-1)

Port number:1
Comm. address:l
Logical addr. :2

6. Choose Comm. Address and press 4J

—End

6.2.9 Querying Information About the DL/T645 Power Meter

You can query information about the DL/T645 power meter information on the LCD.

Procedure

e  The following table describes the procedure for querying information about the DL/T645
power meter. The parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0 @:0 D:0

1. On the default screen, press 4J to enter

the main menu.
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LCD

Operation Procedure

EEH® s Y E

Devices

N
2. Select mm and press 4J

Devices—>Select (2/2)

[ogger (Local) :Online

Power Meter(3-1):0Online

3. Choose Power Meter and press <J

NOTE

Power Meter (3-1) on the left indicates that the
power meter connects to port 3 of the SmartLogger
and its RS485 communications address is 1.

The device status is displayed behind the
device name.

ower Meter(3-1)

Running
Settings

4. Choose Running and press 4J

* To view the running information of the
power meter, perform step 5 only.

e To view the communications address of the
power meter, perform step 6 only.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd. 81




SmartL.ogger1000
User Manual

6 User Interface

Operation Procedure

5. Choose Running Infomation and press

v

Power Meter (3-1)

Phase A voltage:0. 00V
Phase B voltage:0. 00V
Phase C voltage:0. 00V
A-B line wvoltage:0. 00V
B-C line wvoltage:0. 00V
C-4& line wvoltage:0. 00V

Power meter No. :00000000(

Power Meter (3-1)

Running Infomation

Comm. Addr

v

Power Meter (3-1)

Port number:3
Comm. address:l
Logical addr. :5

6. Choose Comm. Address and press 4J

~--End

6.2.10 Setting DL/T645 Power Meter Parameters

You can set DL/T645 power meter parameters on the LCD.
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Procedure

e  The following table describes the procedure for setting DL/T645 power meter
parameters. The parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Daily: 24. 04kWh

Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0

®:0 @:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

[ ] |
2. Select mm and press 4J

Devices—>Select (2/2)

[ogger (Local) :Online

Power Meter(3-1):0Online

3. Choose Power Meter and press 4J

NOTE

Power Meter (3-1) on the left indicates that the
power meter connects to port 3 of the SmartLogger
and its RS485 communications address is 1.

The device status is displayed behind the
device name.

Power Meter (3-1)

Running

Settings

4. Choose Settings and press J
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LCD

Operation Procedure

Settings—>Login

Password: 000000

5. Because of permission restriction, log in
as Advanced User,.

Fower Meter(3-1) \

Power Neter(3-1)

Protocol versionHDNSEEEEIN
Mum of lead bvtes:4

6. Choose Running Param. and press J

~—-End

6.2.11 Querying PLC Information

This section describes how to query the running information and version of a PLC connected

Procedure

to the SmartLogger.

e  The following table describes the procedure for viewing the information about a PLC.
The parameter values in the figures are for reference only.
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LCD Operation Procedure

2017-08-10 16:32:24
1. On the default screen, press 4J to enter

the main menu.

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

mn
2. Select mm and press <J

EEH® s Y E

Devices
Devices—>Select (3/4) 3. Select PLC and press |
[Logger (Local) :Online NOTE
SUN2000(3-2) :On-grid PLC (3-249) in the left figure indicates that PLC is

LC(3-249) :0nline connected to Port 3 of the SmartLogger, whose
PLCL3-249) :0nline RS485 address is 249.

The device status is displayed behind the
device name.

PID(3-1) :Rurning

The subsequent operations are as follows:

® To view the running information of the
PLC, perform step 4 to 6.

e To view the version information of the
PLC, perform step 7 only.

4. Select Running and press 4J

Naintenance
About
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ing Infomation

Comm. Address

PLC(3-249)

CCO net status:networked
Device ident. :Search complete
SNID:1

5. Select Running Infomation and press 4J

PLC(3-249)

Running Infomation

Comm. Addr

PLC(3-249)

Port number:3
Comm. address:249
Logical addr. :6

6. Select Comm. Address and then press 4J
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LCD

Operation Procedure

PLC (3-249)

Running
Naintenance

PLC(3-249)

Version:V100RO01CTZ5PC108
SN: SOUTHDEVICEPLC000249

7. Select About and press 4J

—End

6.2.12 Setting PLC Running Parameters

Procedure

You can set the PLC running parameters on the monitoring panel.

e The following table describes the procedure for setting the PLC running parameters. The
parameter values in the following figures are for reference only.

LCD Procedure
Z017-05-10 16.32.24
— 1. On the default screen, press 4J to enter
! the main menu.
o 0300 08,00 12,00 18100 20.00 5

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

A0 @:0 ®:0
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LCD

Procedure

EEH® s Y E

Devices

N
2. Choose mm and press 4J

Devices—>Select (3/4)

[ogger (Local) :Online
SUN2000(3-2) :0n-grid
PLC(3-249) :0Online

PID(3-1) :Rurning

3. Select PLC and press J

NOTE

PLC (3-249) in the left figure indicates that PLC is
connected to Port 3 of the SmartLogger, whose
RS485 address is 249.

PLC(3-249)

Running

Naintenance

About

4. Choose Maintenance and press 4J

Maintenance—>Login

IES N dvanced Usergs

Password: 000000

5. Because of permission restriction, log in
as Advanced User,.
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LCD Procedure
FLC (3-249) \ 6. Choose Running Param. and press |
¢ Baud rate is set to 115200 by default,

Restart

LC (3-249)
:115200bps

Anti-crosstalk:Enable

Net. freq. band:2. 5-5.7 (MHz)
Box—-type TF No. :1

Winding No. :1
Networking:Enable

which provides optimal communications
performance and does not need to be
changed.

¢ When Anti-crosstalk is set to Enable, the
inverters equipped with the PLC STA
module on the SN list can connect to the
network.

* When Box-type TF No. and Winding No.
of the PLC CCO are consistently set, the
inverters equipped with the PLC STA
module can be automatically added to the
STA list.

e When the PLC CCO is SUN2000
V100R001C72SPC104 or later versions,
you can set Networking. When the
SmartLogger communicates with the
SUN2000 over PLC, set Networking to
Enable (Enable by default). When the
SmartLogger communicates with the
inverter over RS485 only, set Networking
to Disable.

——End

6.2.13 Sending a Reset Command to the PLC

You can send a reset command to the PLC on the monitoring panel.

Procedure

e The following table describes the steps for sending a reset command to the PLC. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

1. On the default screen, press <J to enter
the main menu.
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LCD

Operation Procedure

EEH® s Y E

Devices

N
2. Choose mm and press 4J

Devices—>Select (3/4)

[ogger (Local) :Online
SUN2000(3-2) :0n-grid
PLC(3-249) :0Online

PID(3-1) :Rurning

3. Select PLC and press J

NOTE

PLC (3-249) in the left figure indicates that PLC is
connected to Port 3 of the SmartLogger, whose
RS485 address is 249.

PLC(3-249)

Running

Naintenance

About

4. Choose Maintenance and press 4J

Maintenance—>Login

IES N dvanced Usergs

Password: 000000

5. Because of permission restriction, log in
as Advanced User,.
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Confirm to restart?

ESC :Cancel o :Enter

LCD Operation Procedure
PLC (3-249) 6. Choose Restart and press pul |
Running Param.
Restart
PLC (3-249) 7 Press « to0 verify your settings.

~—-End

6.2.14 Querying PID Information

Procedure

This topic describes how to query the running information and version of a PID connected to

the SmartLogger.

e  The following table describes the procedure for viewing the information about a PID.
The parameter values in the figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd. 91




SmartL.ogger1000
User Manual

6 User Interface

LCD

Operation Procedure

EEH® s Y E

Devices

N
2. Select mm and press 4J

Devices—>Select (4/4)

[ogger (Local) :Online
SUN2000(3-2) :0n-grid
PLC (3-249) :0Online

PID(3-1) :Rurning

3. Select a PID and press <J
NOTE

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its

RS485 communications address is 1.
The subsequent operations are as follows:

® To view the operating data of the PID,
perform step 4 only.

e To view the version information of the
PID, perform step 5 only.

Eunning
Settings
About

Rurnming Infomation

Comm. Address

4. Select Running and press J

Press A and W to select Runing
Infomation or Comm. Address, and then

press 4J
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LCD

Operation Procedure

PID(3-2)

Running
Settings

v
PID(3-2)

Version:V200R1001C00
SN:0Z1TNRT4810000000002

5. Select About and press 4J

—End

6.2.15 Setting the PID Module Running Parameters

You can set the PID module running parameters on the LCD.

Procedure

e  The following table describes the procedure for setting the PID module running
parameters. The parameter values in the figures are for reference only.

LCD Operation Procedure
2017-08-10 16:32:24
— 1. On the default screen, press 4J to enter
! the main menu.
o 0400 08,00 12,00 16100 20100 N

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

A0 @:0 ®:0
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LCD

Operation Procedure

EEH® s Y E

Devices

N
2. Choose mm and press 4J

Devices—>Select (4/4)

[ogger (Local) :Online
SUN2000(3-2) :0n-grid
PLC (3-249) :0Online

PID(3-1) :Rurning

3. Select a PID and press <J

NOTE

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1.

PID(3-2)

Running

Settings

About

4. Choose Settings and press 4J

Settings—>Login

Password: 000000

5. Because of permission restriction, log in
as Advanced User,.
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LCD

Operation Procedure

FID(S—I) \

Power-On/0ff
Data Clear

:Disabled

Output enabled:Disable
PV tvype:P-tyvpe
PV/PE offset wvolt. :0.0V
Operation mode:Normal
Commiss. out.wvolt:0. 0¥

Nax. DC voltage:NA V

6. Choose Running Param. and press 4J

—End

Parameter Description

Table 6-4 describes the PID module running parameters.

Table 6-4 Running parameter descriptions

No. | Parameter | Function Parameter | Description
Name Value
1 Offset mode | Specifies the Disabled Set this parameter to Disable if the PID module is
offset mode of not required.
the PID module. - - )

N/PE Set this parameter to N/PE if the PID module is
required to use voltage output from the inductor
virtual midpoint N.

PV/PE Set this parameter to PV/PE if the PID module is
required to use voltage output from the negative PV
terminal.

This mode is applicable only to SUN80OO.

Automatic In the SUN2000, Automatic indicates the N/PE
offset mode.

2 Output Specifies whether | Enable Set this parameter to Enable to allow the PID
enabled the PID module module output.
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No. | Parameter | Function Parameter | Description
Name Value
output is enabled. | pjsaple Set this parameter to Disable to forbid the PID
module output.

3 PV type Specifies the type | P-type Set this parameter to P-type if the PV module type
of the PV module is P. In this case, the PID module output voltage is
used in the power positive.
station. For - -
details about the | N-type Set this parameter to N-type if the PV module type
PV module type, is N. In this case, the PID module output voltage is
consult the negative.
manufacturer.

4 PV/PE Specifies the DC | 0-200 V It is recommended that the offset voltage be set to a

offset volt. voltage when the value ranging from 50 V to 200 V.
offset mode is set
to PV/PE.
5 Operation Specifies whether | Commissio | In commissioning mode, if you need to set the
Mode the PID module ning output mode to PV/PE or N/PE, set Output
is currently enabled to Enable. The PID module delivers output
working in voltages based on the value of Commiss. out.volt.
norma_l or NOTE
commissioning Before the first power-on, to check whether the PID
mode. functions properly, it is recommended that Operation
mode be set to Commissioning.
Normal In normal mode, the PID module operates
automatically after the PID module, inverter, and
SmartLogger communicate with each other
properly.
6 Commiss. Specifies the 0-500 V It is recommended that the commissioning voltage
out.volt output voltage for the 1000 V/1100 V inverter be set to a value

when the PID ranging from 50 V to 400 V.

modul_e vyorks in NOTE

commissioning After this parameter is set and the output from the PID

mode. module becomes stable, use a multimeter that is set to the
DC position to measure the three-phase (A, B, and C)
voltages of the power grid to the ground, and check
whether the voltages are the same as the configured values.

7 Max. DC Specifies the 500-1500 V | If the PV module type is P, the parameter value

voltage PV-PE voltage indicates the highest DC voltage between PV+ and
when Operation PE; if the PV module type is N, the parameter value
Mode is set to indicates the highest DC voltage between PV- and
Normal or PE.
Commissioning.
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Name Value
8 Maximum Specifies the 0-500 V If the compensation mode is PV/PE, the parameter
output maximum output value indicates the highest DC output voltage
voltage voltage of the between PV and PE; if the compensation mode is
PID module N/PE, the parameter value indicates the highest DC
when Operation output voltage between N and PE.
Mode is set to
Normal or
Commissioning.
9 IMD access | Specifies whether | Enable Select Enable if you allow the PID module and
the PID module IMD to operate in cycle mode.
and insulation Only the IMDs of mainstream suppliers such as
monitor device DOLD and BENDER are supported, and the IMDs
(IMD) can must have enabled dry contacts.
operate in cycle
mode. Disable Select Disable if you forbid the access of IMDs.
10 Periodic Specifies the 60-480 min | The IMD device is shut down when the PID module
PID runtime | operating time is operating.
segment of the
PID module
when the PID
module and IMD
operate in cycle
mode.
11 Periodic Specifies the 15-480 min | The PID module is standby when the IMD device is
IMD operating time operating.
runtime segment of the
IMD when the
PID module and
IMD operate in
cycle mode.
12 IMD control | Dry contact No. DO1, DO2, | Setappropriate ports based on the cable connections
dry contact | over which the and DO3 between the IMD and the SmartLogger.
SmartLogger
controls the IMD

6.2.16 Manually Powering On or Off the PID on the monitoring

panel

This topic describes how to power on or off the PID on the monitoring panel.

Procedure

The following table shows the procedure for powering on or off the PID on the
monitoring panel. The parameter values in the following figures are for reference only.
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LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

EEH® s Y E

Devices

[ ]
2. Choose mm and press <J

Devices—>Select (4/4)

PID(3-1) :Rurning

[Logger (Local) :Online NOTE
SUN2000(3-2) :0n-grid
PLC (3-249) :Online

3. Select a PID and press 4J

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1.

PID(3-2)

Running

Settings

About

4. Choose Settings and press <J
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LCD

Operation Procedure

Settings—>Login

User Name :RXsyteista=tsMil=i=sy

Password: 000000

5.

Because of permission restriction, log in

as Advanced User,.

PID(3-1)

Running Param.

Power-On/0ff

6. Choose Power-On/Off, and press <J

Perform step 7 if you want to power on the
inverter manually.

Data Clear e Perform step 8 if you want to power off the
inverter manually.
ID(3-2) 7. Power on manually.
a. Choose Power-On and press ¢J
Power-0ff J . ] .
b. Enter again to verify your settings.
PID(3-2)

— ]

Power on?

ESC :Cancel

o :Enter
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LCD

Operation Procedure

PID(3-2)

Power-On

Power-Off

PID(3-2)

Power off?

ESC :Cancel o :Enter

8. Power off manually.
a. Choose Power-Off, and press ¢J
b. Enter 4J again to verify your settings.

—End

6.2.17 Clearing Historical PID Information

You can clear the active alarms and historical alarms stored on the PID module over the LCD.

Procedure

e The following table describes the procedure for clearing historical PID information. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.
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LCD

Operation Procedure

EEH® s Y E

Devices

N
2. Choose mm and press 4J

Devices—>Select (4/4)

[ogger (Local) :Online
SUN2000(3-2) :0n-grid
PLC (3-249) :0Online

PID(3-1) :Rurning

3. Select a PID and press <J

NOTE

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1.

PID(3-2)

Running

Settings

About

4. Choose Settings and press 4J

Settings—>Login

Password: 000000

5. Because of permission restriction, log in
as Advanced User,.
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LCD

Operation Procedure

PID(3-1)

Running Param.
Power-On/0ff

Data Clear

PID(3-1)

Clear data historv?

ESC :Car o :Enter

6. Choose Data Clear and press 4J

—End

6.2.18 Querying Custom Device Information

This topic describes how to query the running information and version of a custom device

connected to the SmartLogger.

Procedure

e  The following table describes the procedure for viewing the information about a custom
device. The parameter values in the figures are for reference only.

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

LCD Operation Procedure
2017-08-10 16:32:24
— 1. On the default screen, press 4J to enter
! the main menu.
e 00.00 03.00 12,00 16.00 20.00 A
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LCD Operation Procedure

N
2. Select mm and press 4J

EEH® s Y E

Devices
Devices—>Select (5/6) 3. Select a custom device and press <J
Logger (Local) :Online NOTE
SUN2000(3-2) :On-grid Custom Devicel (2-1) in the left figure indicates
. . : that the custom device is connected to the Port 2 of
PLC (3 249) .On.l 1ne the SmartLogger, and its RS485 communications
PID(3-1) :Runing address is 1.

Custom Devicel (2-1):0nline
EMI(1-1) :Disconnection

v

Custom Devicel (2-1)
Port number:2

Comm. Address:1

[ogical addr. :10

~—-End

6.2.19 Querying Alarm Records
This topic describes how to query active and historical alarms for the SmartLogger and the
connected inverters and how to set the alarm record sort mode on the monitoring panel.
Context

The LCD displays a maximum of 8000 latest alarm records.

Procedure

e  The following table describes the procedure for querying active and historical alarms and
setting the alarm record sort mode. The parameter values in the figures are for reference
only.
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LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

n 0 & i =

Alarms

2. Choose IZ' and press <J

&] arm

Active Alarms
Alarm History
Sort By

3. Press W, choose the appropriate menu,

and press .

Perform step 4 and step 5 to view active
alarms.

Perform step 6 and step 7 to view historical
alarms.

Perform step 8 to set the alarm sort mode.

Active Alarms—>Select(1/1)

SUN2000 (1-7) (7)

4. On the Active Alarms screen, select the

target device name and press 4J to view all
the active alarms for this device.
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LCD

Operation Procedure

bctive Alarms(1/1)

OVersion Mismatch /ID:1

v

Version Mismatch(l/1)
Alarm ID:504
Severity:Minor (@
Generated:2013-08-13 11:26:18
Info:
Reason ID =1

5. Select one of the alarm records by pressing
A or ¥ and view the alarm details by

pressing <J
NOTE

For details about the alarm list of the
SmartLogger1000, see 9.3 Alarms.

For details about the alarm list of the SUN2000,
see the Troubleshooting in the SUN2000 series
user manual.

Al arm Histor

SUNZ2000 (1-7)

6. On the Alarm History screen, select the

target device name and press 4J to view all
the historical alarms for this device.
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Abnormal /ID:29

MGrid Volt.
MGrid Volt. Abnormal/ID:29
MGrid Volt. Abnormal/ID:29
OVersion Mismatch/ID:1

v

Grid Volt. Abnormal (1/4)

Alarm ID:301
Severity:Major M
Generated:2013-08-13 11:24:27
Cleard:2013-08-13 11:26:45
Info:
Reason ID = 29

7. Select one of the historical alarms by
pressing 4 or W and view the alarm

details by pressing <J
NOTE

For details about the alarm list of the
SmartLogger1000, see 9.3 Alarms.

For details about the alarm list of the SUN2000,
see the Troubleshooting in the SUN2000 series
user manual.

4] arm

Active Alarms
Alarm History

8] arm

Sort By

Generation time

Alarm severity

8. On the Sort By page, you can select the
way of sorting alarms.

~--End
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6.2.20 Setting the System Language

This topic describes how to set the display language for the SmartLogger on the monitoring
panel.

Procedure

e The following table describes the procedure for setting the display language. The

parameter values in the following figures are for reference only.
LCD

Operation Procedure

2017-08-10 16:32:24
— 1. On the default screen, press 4J to enter
' the main menu.

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

M

2. Choose Q and press 4J

B mE] D E

Settings

Settings—>Login 3.Because of permission restriction, log in as

Common User, or Advanced User.
NOTE

After passing the permission validation, the system

keeps the authentication information for 30 seconds.
Password: 000000 If you exit from the Settings page and log in again

within 30 seconds, no authentication is required.
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LCD Operation Procedure

‘Settings \ 4. Choose User Param., and press 4J

User Password
Comm. Param.
Restore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

‘lilser Param. \ 5. Choose Language, and press 4J

Date&Time
Date Format
Contrast
Currency
Electricity price/kWh
C02 emission reduction

Settings—>User Param. 6. On the Language page, select a display
Language language, and press 4—(']
English The pages will be displayed in the selected
nejyvy language.
Deutsch
Italiano
B

Fran¢ais

~—-End

6.2.21 Setting System Time Parameters

This topic describes how to set the date, time and date format for the SmartLogger on the
monitoring panel.

Procedure

e  The following table describes the procedure for setting the time and date. The parameter
values in the following figures are for reference only.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 108



SmartL.ogger1000

User Manual

6 User Interface

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

B mE] D E

Settings

2. Choose Q and press 4J

Settings—>Login

NOTE

3.Because of permission restriction, log in as
Common User, or Advanced User.

Password: 000000

After passing the permission validation, the system
keeps the authentication information for 30 seconds.
If you exit from the Settings page and log in again
within 30 seconds, no authentication is required.

‘Settings \

User Password
Comm. Param.
Restore Defaults

Here use the pages displayed when you

log in to the SmartLogger as Advanced
User.

4. Choose User Param., and press <J
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LCD

Operation Procedure

User Param.

Language

Date&Time

Date Format
Contrast
Currency

Electricity price/kWh
C0Z emission reduction

User Param.

Language
Date&Time

Date Format

Contrast
Currency

Electricity price/kWh
C0Z emission reduction

5. Choose Date&Time or Date Format by
pressing W, and press 4J

NOTICE

e Modifying Date&Time will affect the integrity
of the SmartLogger's energy yield and
performance data. Hence, do not change it at
will.

e After Date&Time is successfully set, this time
can be synchronized in all the inverters
connected to the SmartLogger.

User Param.

DST
Date
Time

Date&Time
‘UTC+08:00 Beijing
:Disable
:2017-08-10
:16:48:02

6. On the Date&Time page, set the date and
time, set the time zone, enable or disable the

daylight saving time, and press ¢J

To select the specific parameter, click 4J To
set the parameter value, set 4 or V.

User Param.

Date Format

YYYY-JN-DD
MM-DD-YYYY
DD-M-YYYY

7. On the Date Format page, select a date
format, and press .

—-End

6.2.22 Setting SmartLogger Contrast

You can set the SmartLogger contrast on the monitoring panel.
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Context
In addition to the method provided in this section, you can also press and hold 4 or W on
the home screen to adjust the contrast.
Procedure
®  To set the SmartLogger contrast, perform the steps in the following table: The parameter
values in the figures are for reference only.
LCD

Procedure

2017-08-10 16:32:24
— 1. On the default screen, press 4J to enter
' the main menu.

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

A0 @:0 ®:0

M

2. Choose Q and press 4J
EonmE

Settings

Settings—>Login 3.Because of permission restriction, log in as

Common User, or Advanced User.

NOTE
) After passing the permission validation, the system
User Name:3f§ keeps the authentication information for 30 seconds.
Password: 000000

If you exit from the Settings page and log in again
within 30 seconds, no authentication is required.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 111



SmartL.ogger1000
User Manual

6 User Interface

LCD

Procedure

‘Settings \

User Password
Comm. Param.
Restore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose User Param., and press 4J

User Param.

Language
Date&Time
Date Format

Contrast

Currency
Electricity price/kWh
C0Z emission reduction

5. Select Contrast and press 4J

ser Param. —>Contrast

16

6. On the Contrast tab, press 4 and W to
set the contrast.

NOTE
The contrast value ranges from zero to ten.

~—-End

6.2.23 Setting the Currency and Currency Factor

Procedure

This topic describes how to set the currency and currency factor for the SmartLogger.

e The following table describes the procedure for setting the currency and currency factor.
The parameter values in the following figures are for reference only.
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LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

B mE] D E

Settings

2. Choose Q and press 4J

Settings—>Login

Password: 000000

3.Because of permission restriction, log in as
Common User, or Advanced User.

NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.
If you exit from the Settings page and log in again
within 30 seconds, no authentication is required.

‘Settings \

User Password
Comm. Param.
Restore Defaults

Here use the pages displayed when you

log in to the SmartLogger as Advanced
User.

4. Choose User Param., and press <J

Perform step 5 to set the currency.
Perform step 6 to set the currency factor.
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LCD

Operation Procedure

User Param.

Language
Date&Time
Date Format
Contrast

Currency
Electricity price/kWh
C0Z emission reduction

v

User Param.

5. Set the currency.
a. Select Currency by pressing W, and press

b. Select a currency, and press 4J

Electricity price/kWh

C0Z emission reduction

User Param.

Electricity price/kWh

B10 000

Currency
GBP
USD
CNY
JPY
Iser Param. 6. Set the currency factor.
Language NOTICE
. Set the currency before you set the currency factor.
Date&Time The currency factor is the electricity price per kWh,
Date Format which is used to calculate the energy yield revenue.
Contrast a. Select Electricity price/kwWh by pressing
Currency W, and then press <=,

b. Set the currency factor by pressing 4\ or
W, and then press <.

~--End
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6.2.24 Setting the CO; Emission Reduction Coefficient

Procedure
e  The following table describes the procedure for setting the CO, emission reduction
coefficient. The data on the following figures are for reference only.
LCD Display Procedure

2017-08-10 16:32:24
— 1. On the default screen, press 4J to enter
! the main menu.

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

2. Choose Q and press 4J

B mE] D E

Settings

Settings—>Login 3.Because of permission restriction, log in as

Common User, or Advanced User.
NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.
If you exit from the Settings page and log in again
within 30 seconds, no authentication is required.

User Name :RXsigrsle=ts

Password: 000000

‘Settings \ 4. Choose User Param., and press 4J

User Password
Comm. Param.
Restore Defaults

Here use the pages displayed when you

log in to the SmartLogger as Advanced
User.
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LCD Display

Procedure

User Param.

Language
Date&Time
Date Format
Contrast
Currency
Electricity price/kWh

C02 emission reduction

... —>C02 emission reduction
C02 emission reductioniifieeRls

5. Select CO2 emission reduction and press

—End

6.2.25 Changing a Password

Context

Procedure

This topic describes how to change a password on the monitoring panel.

®  The initial password is 000001 for Common User, Advanced User, and Special User.

®  Use the initial password upon first power-on and change it immediately after login. To
ensure account security, change the password periodically and keep the new password in
mind. Not changing the initial password may cause password disclosure. A password left
unchanged for a long period of time may be stolen or cracked. If a password is lost,
devices cannot be accessed. In these cases, the user is liable for any loss caused to the PV

plant.

®  You are advised to change the password at least once every half year to prevent
unauthorized use of your account, which affects system security.

Change the password in compliance with the following principles:

®  Six characters are required.

®  The password consists of digits, uppercase letters, and lowercase letters.

e  The following table describes the procedure for changing a password. The parameter
values in the following figures are for reference only.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd. 116




SmartL.ogger1000
User Manual

6 User Interface

LCD
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2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced CO2: 240. 40kg
fctive power: 0. 00W

M

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

B mE] D E

Settings

2. Choose Q and press 4J

Settings—>Login

User Name :R¥y

3. Because of permission restriction, log in as
Common User, Advanced User, or Special
User.
NOTE

After the authentication is successful, the system

User Param.

User Password

Comm. Param.
Restore Defaults

Password: 000000 keeps the authentication information for 30 seconds.
If you exit from the Settings screen and log in again
within 30 seconds, no authentication is required.
Settings 4. Select User Password by pressing W, and

press <J

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.
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Settings—>User Password

Enter old password:

@ o]0 o] o] o]

(000000-2ZZZZZ)

5. Enter the old password and press 4J

Increase or decrease the value by pressing 4\
or W Switch between data bits by pressing

Settings—>User Password

Enter new password:

@ o]0 o] o] o]

(000000-2ZZZZZ)

6. Enter a new password and press 4J

Increase or decrease the value by pressing 4\
or W Switch between data bits by pressing

Settings—>User Password

@ o]0 o] o] o]

(000000-2ZZZZZ)

Confirm new password agaln:

j.JEnter the new password again and press

NOTE
Ensure that you enter the new password twice
coherently. Otherwise, an error message is
displayed.
After the password is changed successfully,
the LCD displays operation success
information.

LLl NnoTE

If you want to change the password for another account, exit from the Settings screen (without logging
in to the Maintenance screen), wait 30 seconds, log in by using the account for which you want to
change the password, and perform step 3 to step 7 in the preceding table.

—-End

6.2.26 Setting Communications Parameters

Context

You can set the SmartLogger parameters for communication on the monitoring panel.

e  Correctly set RS485 parameters to ensure normal communication between the
SmartLogger and the inverters and between the SmartLogger and the environmental

monitoring instrument.
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Procedure

e  Correctly set Ethernet parameters to ensure proper operation of Ethernet ports and
functions of logging in to the embedded WebUI, connecting to the element management

system, and sending emails.

®  Set management parameters properly to ensure normal communication between the

SmartLogger and the NMS.

e  The following table describes the procedure for setting communications parameters. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

A0 @:0 ®:0

1. On the default screen, press <J to enter
the main menu.

B mE] D E

Settings

2. Choose Q and press 4J

Settings—>Login

User Name :R¥y

Password: 000000

3. Because of permission restriction, log in as
Advanced User,.

NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.
If you exit from the Settings screen and log in again
within 30 seconds, no authentication is required.
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LCD

Operation Procedure

Settings

User Param.
User Password

Comm. Param.
Restore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

. Select Comm. Param. and press 4J

Perform step 5 and step 6 to set the
parameters for the RS485.

Perform step 7 and step 8 to set the
parameters for the Ethernet.

Perform step 9 and step 10 to set the
management parameters.

Perform step 11 and step 12 to set the
parameters for the Modbus TCP.

Perform step 13 and step 14 to set the
parameters for the IEC103.

Perform step 15 to set the SmartLogger
address.

settings—>Comm. Param.

RS485-2
RS485-3
Ethernet
Nanagement System
Nodbus TCP
IEC103

5. Select an RS485 port by pressing 4\ or
W and then press <=,

There are three RS485 ports: RS485-1,
RS485-2, and RS485-3. The corresponding
port for RS485-1 is COML1; RS485-2 is
COMZ2; RS485-3 is COMS.

omm. Param. —>RS5485-1
Nodbus

Baud rate:9600
Parityv:None
Stop bit:l
Start address:1
End address:247

(2]

. Set RS485 parameters and then press <J

The following baud rates are
supported:2400 bps, 4800 bps, 9600 bps,
19200 bps and 115200 bps. 9600 bps is
recommended.

1 < Start Address < End Address < 247.
The address segments for these three ports
can overlap.

Set the address scope properly. The
broader the scope is, the longer the time is
for searching the devices.

Stop Bit supported by the SmartLogger is
lor?2.

Protocol, Parity, and Stop Bit must be set
to the same values for all devices
connected to the same RS485 port.
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Operation Procedure

settings—>Comm. Param.

R5485-1
R5485-2
R5485-3

Ethernet

Nanagement System

Nodbus TCP
IEC103

7. Press W, select Ethernet, and press 4J

et

mm. Param. —>Ethernet

8. Set Ethernet parameters and then press <J

:Disable NOTE
IP address:192.168., 0. 10[ If the SmartLogger connects to the Internet through
Subnet mask: 0 0 0 0 a router, note the following when setting Ethernet
. ’ ’ ’ parameters:

Gat eway - 0. 0. 0. 0 e If you set Auto obtain IP to Enable, the DHCP
DNS-1: 0. 0. 0. 0 server on the network assigns IP addresses. In
DNS-2: 0 0 0 0 this case, you must ensure that a DHCP server is

Submi ' ) working on the network.
o t e Set the gateway address to the IP address of the
router.

e Ensure that the IP address of the SmartLogger is
in the same network segment as the gateway
address.

e Set the domain name server (DNS) address to
the 1P address of the router or obtain the DNS
address from the network provider.

Settings—>Comm. Param. || 9 Tap "W, choose Management System, and
R5485-1 tap
RE485-2
RE5485-3
Ethernet
Nanagement System
Nodbus TCP
IEC103
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Operation Procedure

... —>Nanagement System

Server:192.168. 0.
Port number:16100
Address mode:Logical address

SSL encrypt. :Enable
2nd challenge:Disable

Network Test

10

10. After setting the management system

parameters, tap <.

Server: Fill in the IP address of the NMS
server.

Port number: When the SmartLogger
connects to the Huawei NMS, the port
number is 16100 by default. When the
SmartLogger connects to a third-party
NMS, set Port number according to the
server port enabled in the third-party NMS.

In most cases, set Address mode to
Comm. Address. If the devices connected
to the three RS485 ports of the
SmartLogger have duplicate addresses, you
must set Address mode to Logical addr..

If SSL encrypt. is set to Disable, data will
be transmitted without being encrypted,
which may result in user data theft.
Therefore, exercise caution when deciding
to enable this function.

If 2nd challenge is set to Disable, the
secondary challenge authentication result is
not checked, which may result in user data
theft. Therefore, exercise caution when
deciding to enable this function.

settings—>Comm. Param.

RS485-1
RS485-2
RS485-3
Ethernet
Nanagement System

‘ IEC103

11. Press W, select Modbus TCP, and press
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Operation Procedure

omm. Param. —>Nodbus TCP
:Disable

Client 1 IP: 0.
Client 2 IP: 0.
Client 3 IP: 0.
Client 4 IP: 0.
Client 5 IP: 0. 0.
Address mode:Logical address

cooo
cooope
o o O O O

12. Set Modbus TCP parameters and then
press <.

* Modbus-TCP is a general standard
protocol without a security authentication
mechanism. Therefore, the function of
connecting to a third-party NMS using
Modbus-TCP is disabled by default to
reduce network security risks. Parameters
must be set correctly to enable the
function.

® In most cases, set Address mode to
Comm. Address. If the devices connected
to the three RS485 ports of the
SmartLogger have duplicate addresses, you
must set Address mode to Logical addr..

e Set the client IP addresses correctly.

settings—>Comm. Param.

R5485-1
R5485-2
R5485-3

Ethernet

Nanagement System
Modbus TCP

13. Press W, choose IEC103, and press 4J

omm. Param. —>IEC103
‘No

Addressi126
IEC103 IP: 0. 0. 0. 0O

14. Set IEC103 parameters and then press

NOTE

IEC103 is a general standard protocol without a
security authentication mechanism. Therefore, the
function of connecting to the NMS using IEC103 is
disabled by default to reduce network security risks.
Parameters must be set correctly to enable the
function.
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settings—>Comm. Param.

15. Select SmartLogger Address and then

RS485-2
RS485-3
Ethernet
Nanagement System
Nodbus TCP
IEC103

| 3

press <,

—End

6.2.27 Restoring Factory Settings

This topic describes how to restore factory settings for the SmartLogger on the monitoring
panel. After this operation, all parameters, excluding the current date and time, will restore to
the default factory settings. However, the running information, alarm records, and system logs
do not change.

Context

NOTICE

e After restoring factory defaults for the SmartLogger, set the user parameters and
communications parameters in time and log in to the WebUI to set the environmental
monitoring instrument parameters and power grid dispatching parameters.

e The displayed language is English by default.

Procedure

e The following table describes the procedure for restoring factory settings. The parameter
values in the following figures are for reference only.
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LCD

Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

A0 @:0 ®:0

1. On the default screen, press 4J to enter

the main menu.

B mE] D E

Settings

2. Choose Q and press 4J

Settings—>Login

3. Because of permission restriction, log in as
Advanced User or Special User.

NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.

User Param.
User Password
Comm. Param.

Restore Defaults

Here use the pages displayed when you

log in to the SmartLogger as Advanced
User.

Password: 000000 If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
Settings 4. Choose Restore Defaults, and press <J
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LCD Operation Procedure

settings->Restore Defaults 5. On the displayed page, press 4J

settings—>Restore Defaults 6. Press = to0 complete the settings.

Complete

:Enter

~—-End

6.2.28 Downloading Device Data Using a USB Flash Drive

You can download device logs using a USB flash drive over the monitoring panel, so that you
can use the logs for issue review and troubleshooting.

Context

Side View of the shell shows the USB port in the SmartLogger.

Procedure

e The following table describes the procedure for downloading data using a USB flash
drive. The parameter values in the following figures are for reference only.

LCD Operation Procedure
2017-08-10 16:32:24
— 1. On the default screen, press 4J to enter
! the main menu.
e 00.00 03.00 12,00 16.00 20.00 i

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0
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Operation Procedure

HEEHELE-J |1 |=

Maintenance

2. Choose Ji and press 4J

Maintenance—>Login

User Name :K¥svgastei=Xs AF

Password: 000000

3. Because of permission restriction, log in as
Advanced User or Special User.

NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.
If you exit the screen and log in again within the 30
seconds, no permission authentication is required.

Faint enance \

Device Ngmt.
Data Clear
System Reset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press 4J

NOTE

o Before this operation, connect the USB flash
drive to the USB port.

e The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.
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Operation Procedure

%aint enance—>USE Expansion \

Firmware Upgrade
Batch Upgrade
Export all data files
Import all data files
Offline config

v

Device Logs—>Select (1/2)

Logger (Local)

SUN2000 (1-7)

5. Choose Device Logs and press ¢J

--End

6.2.29 Upgrading Firmware by Using a USB Flash Drive

You can upgrade the firmware on the monitoring panel by using a USB flash drive. You can
upgrade the firmware of the SmartLogger and devices connected to the SmartLogger.

Context
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NOTICE

e You have obtained the upgrade package with the help of the supplier or Huawei engineers.
e Save the package under the root directory and do not extract the package.

e When upgrading the firmware for the SUN2000, change the file name of the package to
sun2000_usb.zip.

e When upgrading the firmware for the PID, change the file name of the package to
pid_usb.zip.

e When upgrading the firmware for the PLC, change the file name of the package to
plc_usb.zip.

e When upgrading the SmartLogger1000, ensure that the file name of the package is
logger_usb.tar.gz.

Procedure

The following table describes the procedure for upgrading the firmware by using a USB
flash drive. The parameter values in the figures are for reference only.

LCD Operation Procedure

2017-08-10 16:32:24
1. On the default screen, press <J to enter

the main menu.

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

2. Choose ji and press J

HEHEUE-Y ' §=

Naintenance
Maintenance—>Login 3. Because of permission restriction, log in as
Advanced User or Special User.
NOTE

. After passing the permission validation, the system

b dermam — o ¢ . . R .

User Name :GlaygsteZ g keeps the authentication information for 30 seconds.
Password: 000000 If you exit the screen and log in again within the 30

seconds, no permission authentication is required.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 129



SmartL.ogger1000
User Manual

6 User Interface

LCD

Operation Procedure

Faint enance \

Device Ngmt.
Data Clear
System Reset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press 4J

NOTE

o Before this operation, connect the USB flash
drive to the USB port.

e The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.

Maintenance->USB Expansion

Device Logs

Firmware Upgrade
Batch Upgrade
Export all data files
Import all data files
Offline config

5. Choose Firmware Upgrade, and press

Firmware Upgrade—>Select(1/2)
Logger (Local )

SUN2000 (1-7)

6. Press <J to select a specific device.

The SmartLogger and the inverters connected
to it can be upgraded.

The SUN2000 (1-7) on the left indicates that
this inverter connects to the Port 1 of the
SmartLogger and the communications address
for the RS485 port is 7.

Maintenance->USB Expansion

Curr. Ver. :V100R001CO0SPCO02
Target Ver. :¥100R001CO0SPCO03

ESC :Cancel ol :Enter

(The inverter upgrade screen is used as an
example.)

7. After checking that Target Version is
correct, press 4J

NOTICE

For the SUN2000, its firmware can be upgraded
only if the device status is On-grid or Shutdown.
Check the device status before firmware upgrade.

The SmartLogger, inverter, PLC, or PID will
restart after being upgraded.
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6.2.30 Batch Upgrade
This topic describes how to perform a batch upgrade for the SUN2000 on the monitoring
panel.
Context

NOTICE

The SUN2000 that can be upgraded in batches on the SmartLogger must be SUN2000
V100R001C11SPC409, SUN2000 V100R001C81SPC101 and its later patch versions, or
SUN2000 V200R001CO00 and its later patch versions.

Procedure

e The following table describes the batch upgrade procedure. The parameter values in the
figures are for reference only.

LCD Procedure

— 2017-08-10 16:32:24 {| 1 O the default screen, press o toenter

the main menu.

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

2. Choose Ji and press 4J

HEHEUE-A Y =

Naintenance
Maintenance—>Login 3. Because of permission restriction, log in as
Advanced User or Special User.
NOTE

N After passing the permission validation, the system
User Name :jfayg ' keeps the authentication information for 30 seconds.
Password: 000000 If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
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LCD

Procedure

Faint enance \

Device Ngmt.
Data Clear
System Reset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press 4J

NOTE

o Before this operation, connect the USB flash
drive to the USB port.

e The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.

Maintenance->USB Expansion

Device Logs
Firmware Upgrade

Batch Upgrade
Export all data files
Import all data files

Offline config

5. Choose Batch Upgrade and press 4J

%at ch Upgrade \

6. Choose SUN2000 and press 4J

Batch Upgrade

Target ver. :¥200R001CO0SPCO04

ESC :Cancel ol :Enter

7. After checking that Target ver. is correct,
press <.

NOTICE
e For the SUN2000, its firmware can be upgraded
only if the device status is On-grid or
Shutdown. Check the device status before
firmware upgrade.

e The upgrade takes 20 minutes when the baud
rate is 9600 bps.

e After the upgrade is successful, the SUN2000
automatically restarts.

~—-End
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6.2.31 Exporting All Files

You can export all files from the SmartLogger on the monitoring panel.

Context
If the SmartLogger needs to be replaced, you can export all files before the replacement and
then import the exported files to the new SmartLogger to ensure data integrity.
Procedure
e The following table describes the procedure for exporting all files. The parameter values
in the figures are for reference only.
LCD

Procedure

— 2017-08-10 16:32:24 {| 1 O the default screen, press o toenter
! the main menu.

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

M

2. Choose ji and press 4J
R

Maintenance

Maintenance—>Login 3. Because of permission restriction, log in as

Advanced User or Special User.

NOTE
. [ After passing the permission validation, the system
IED SN R dvanced U keeps the authentication information for 30 seconds.
Password: 000000

If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
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LCD Procedure
Hiiaint gnance \ 4. Choose USB Expansion and press 4J
NOTE
Device Ngmt. e Before this operation, connect the USB flash

drive to the USB port.

e The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following

Data Clear
System Reset

steps.
Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.
Maintenance—>USB Expansion 5. Select Export all data files and press |

Device Logs
Firmware Upgrade
Batch Upgrade

Export all data files
Import all data files
Offline config

—End

6.2.32 Importing All Files

You can import all files to the SmartLogger on the monitoring panel.

Context

If the SmartLogger needs to be replaced, you can export all files before the replacement and
then import the exported files to the new SmartLogger to ensure data integrity.

Procedure

e The following table describes the procedure for importing all files. The parameter values
in the figures are for reference only.
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LCD

Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

HEHEUE-A Y =

Maintenance

2. Choose LT_ and press 4J

Maintenance—>Login

User Name :Rtyevstei=te ISy

3. Because of permission restriction, log in as
Advanced User or Special User.

NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.

Password: 000000 If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
flaintenance 4. Choose USB Expansion and press <J

USB Expansion

Device Ngmt.
Data Clear
System Reset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

NOTE
o Before this operation, connect the USB flash
drive to the USB port.

e The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd.

135




SmartL.ogger1000
User Manual 6 User Interface

LCD Procedure

Maintenance->USB Expansion 5. Select Import all data files and press 4J
Device Logs
Firmware Upgrade
Batch Upgrade
Export all data files

Import all data files
Offline config

—End

6.2.33 Offline Configuration

You can import offline configuration files to the SmartLogger through the monitoring panel.

Procedure

e  The following table lists the procedure for offline configuration. The parameter values in
the following figures are for reference only.

LCD Operation Procedure

2017-08-10 16:32:24

1. On the default screen, press 4J to enter

T kWh .
the main menu.

04:00 08:00 12:00 16:00 20:00 i

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

2. Choose ﬁ and press 4J

HEEHELE-J |1 |=

Maintenance
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Operation Procedure

Maintenance—>Login

User Name :K¥svgastei=Xs AF

Password: 000000

3. Because of permission restriction, log in as
Advanced User or Special User.

NOTE
After passing the permission validation, the system
keeps the authentication information for 30 seconds.
If you exit the screen and log in again within the 30
seconds, no permission authentication is required.

Faint enance \

Device Ngmt.
Data Clear
System Reset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press <J

NOTE

e Before this operation, connect the USB flash
drive to the USB port.

e The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.

Maintenance->USB Expansion

Device Logs
Firmware Upgrade
Batch Upgrade
Export all data files

Import all data files

5. Choose Offline config and press <J

5B Expansion—>0ffline config
Latest S

atatus
Enable offline config

6. After the configuration file is imported,
choose Latest Status to view the import status
of the last offline configuration file and choose
Enable offline config to import other offline
configuration files.

—End
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6.2.34 Managing Devices

You can search, add, delete, and assign addresses to devices that are connected to the
SmartLogger on the monitoring panel.

Context

®  Provided that all the inverters are correctly connected to the SmartLogger and that all the
communications parameters are correctly set, the SmartLogger can perform the
automatic search and detect all the connected inverters.

e  Before you perform the Auto. Search operation, if the SmartLogger is connected to
devices that no longer exist in the PV power system, remove them from the SmartLogger
manually. Otherwise, these devices are still detectable with Disconnection status.

e  After you add, delete, or replace a device, or change the RS485 address, search for
devices again or restart the SmartLogger (the SmartLogger automatically searches for
devices after it restarts).

e  EMI, slave SmartLogger, power meter, PLC, and third-party devices cannot be
automatically recognized, and must be manually added.

®  For devices that no longer exist in the PV power system, perform Single Remove or
Batch Remove in time to avoid wasting the system resources.

®  The RS485 addresses of all inverters are the same when delivered. If the firmware
version of the SUN2000 is V100R001C00SPCO010 or later, or V100R001C81SPC105 or
later, you can perform automatic address assignment on the SmartLogger and adjust the
addresses to realize remote site setup and improve maintenance efficiency.

e When connecting a third-party device, you need to import a configuration file for the
device, and then manually add the device.

e If you perform Alarm Reset, all active and historical alarms for the selected device will
be deleted and the SmartLogger will be enabled to collect new alarm data.

NOTICE

e |f Data Clear is performed on Huawei devices such as the inverter and PID module,
Alarm Reset must be performed on the SmartLogger and NMS. Otherwise, the
SmartLogger cannot collect alarm information generated by the devices after Data Clear
is performed.

e |f Alarm Reset or Data Clear is performed on the SmartLogger, Alarm Reset must also
be performed on the NMS. Otherwise, the NMS cannot obtain alarm information collected
by the SmartLogger after Alarm Reset or Data Clear is performed.

Procedure

e  The following table describes the procedure for managing the devices. The parameter
values in the following figures are for reference only.
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Operation Procedure

2017-08-10 16:32:24

KWh

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M

M0 @:0 D:0

1. On the default screen, press 4J to enter
the main menu.

HEHEUE-A Y =

Maintenance

2. Choose ﬁ and press 4J

Maintenance—>Login

User Name :EXeVg

Password: 000000

3. Because of permission restriction, log in as
Advanced User or Special User.

NOTE

After passing the permission validation, the system
keeps the authentication information for 30 seconds.

USB Expansion

Device Ngmt.
Data Clear
System Reset

If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
Maintenance 4. Choose Device Mgmt. and press <J

e Perform step 5 to enable the SmartLogger
to automatically search for devices.

e Perform step 6 to add devices to the
SmartLogger.

® Perform step 7 to remove a single device.

e Perform step 8 to remove devices in
batches.

e Perform steps 9-12 to automatically assign
addresses.

e Perform step 13 to import a configuration
file.

e Perform step 14 to reset alarms.

e Perform steps 15-17 to start or shut down
inverters in batches.

e Perform step 18 to reset inverters in
batches.
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Operation Procedure

aintenance—>Device MNzmt.

Add Nanually
Single Remove
Batch Remove
Addr. Allocate
Config Import
Alarm Reset

v

Device Mzmt. —>Auto.

search

Search agai

ESC :Cancel

5. Choose Auto. Search and press ¢J

Before performing the automatic search,
ensure that all the devices can normally
communicate with the SmartLogger.

NOTE
e After you add, delete, or replace a device, or
change the RS485 address, search for devices
again.
e |fadevice is added, search for the device on the
SmartLogger or restart the SmartLogger and
then search for the device on the NMS.

Maintenance->Device Nemt. |
Auto. Search
Single Remove
Batch Remove
Addr. Allocate
Config Import
Alarm Reset

v

Device Mzmt. —>Add Nanually
Device type: S
Comm. protocal ‘Modbus-ETU
IP address: 0. 0, 0, 0

6. Choose Add Manually and press 4J

NOTE
e EMI, slave SmartLogger, power meter, PLC,

and third-party devices must be manually
added.

e |f the communication is abnormal, or the
address on the port has been used, the device
cannot be added.
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Operation Procedure

Maintenance->Device Nemt.

Auto. Search
Add Nanually

Single Remove
Batch Remove
Addr. Allocate
Config Import
Alarm Reset

v

Single Remove—>Select(4/4)

PID(1-2)

SUN2000(1-1)

Custom Devicel (3-1)

7. Choose Single Remove and press 4J
twice.

NOTE
For devices that no longer exist in the PV power
system, remove them in time to avoid wasting
system resources.

Maintenance->Device Nemt.

Auto. Search
Add Nanually
Single Remove

Batch Remove

Addr. Allocate

Config Import
Alarm Reset

v

Device Mzmt. —>Batch Remove

ESC :Can

1cel

Ly

o

o :Enter

8. Choose Batch Remove and press 4J

NOTE
For devices that no longer exist in the PV power
system, remove them in time to avoid wasting
system resources.
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LCD

Operation Procedure

Maintenance->Device Nemt. |

Auto. Search
Add Nanually
Single Remove
Batch Remove

Addr. Allocate
Config Import
Alarm Reset

v

ddr. Allocate—->Addr. Allocate
ﬁﬁﬁ:u

9. Select Addr. Allocate, set the start
addresses assigned for RS485-1, RS485-2, and

RS485-3, and then press <J to allocate the
addresses.

fddr. Allocate

ESC :Cancel

10. Press 4J to confirm the address
assignment.
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... —>hddr. Adjustment

Adjust the address?

ESC :Cancel

...—>Addr. Adjustment

ANM0107164901D2001 22 4 B2 lop

11. After the setting of Addr. Allocate is
completed, press 4J to adjust addresses.

Device Mzmt. —>Auto. Search

ESC :Cance .J :Enter

v

Device Mzmt. —>Auto. Search

Search complete.
Device found 5 PCS.

:Enter

12. After the setting of Addr. Adjustment i
completed, press <J to search the devices.

S
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Operation Procedure

Maintenance->Device Nemt.

Auto. Search
Add Nanually
Single Remove
Batch Remove
Addr. Allocate

‘ Alarm Reset

v

evice MNgmt. —>Config Import

Custom Device
Custom Device
Custom Device
Custom Device
Custom Device

=1 S N o L DN

Custom Device

13. Choose Config Import, select a custom

device as required, and press 4J to import a
configuration file.

NOTE
e Before importing a configuration file, you must
plug in a USB drive that contains the
configuration file.

e After importing a configuration file, you need to
manually add a third-party device.

Maintenance->Device Nemt.

Auto. Search
Add Nanually
Single Remove
Batch Remove
Addr. Allocate
Config Import

4] arm Reset—>Select (1/5)

SUN2000(3-2)

PLC (3-249)

PID(3-1)

Custom Devicel (2-1)
FMI(1-1)

14. Choose Alarm Reset, select a device as
required, and press 4J
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Maintenance->Device Ngmt. 15. Choose Batch Power-On/Off and press
Add Nanually

Single ERemove
Batch Remove
Addr. Allocate
Config Import
Alarm Reset

| 3

Batch Power-On/0ff

’- .. —>Batch Power—On/Off \ 16. Choose Batch Power-On and press |

Batch Power-Off

v

Batch Power—-On

Batch power on?

ESC :Cancel o :Enter
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LCD Operation Procedure
... —>Batch Power-On/Off 17. Choose Batch Power-Off and press ¢J
Batch Power—-On
Batch Power-Off
Batch Power-Off
Batch power off?
ESC :Cancel o :Enter
Maintenance—>Device Mgmt. | 18. Choose Batch Reset and press Pl I
Single Remove confirm the batch reset operation.
Batch Remove
Addr. Allocate
Confiz Import
Alarm Reset
Batch Power-On/0Off
Device Mzmt. —>Batch Reset
ESC :Cancel o :Enter
----End
6.2.35 Clearing Data
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Context

Clear data if the SmartLogger location changes and its historical data need to be deleted.

NOTICE

e After the data clear operation is performed, all information stored on the SmartLogger,
including energy yield, performance data, and alarms, will be removed.

e After the data clear operation is performed, the devices connected to the SmartLogger are
not removed. If an original device will not connect to the SmartLogger, remove the device.

e |f you perform Data Clear on the SmartLogger, you also have to perform Alarm Reset on
the NMS. Otherwise, the alarm information collected by the NMS and SmartLogger will
be different.

Procedure

e  The following table describes the procedure for clearing data. The parameter values in
the figures are for reference only.

LCD Operation Procedure
2017-08-10 16:32:24
— 1. On the default screen, press <J to enter
' the main menu.
e 00.00 03.00 12,00 16.00 20.00 i

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

2. Choose Ji and press J

HEHEUE-Y ' §=

Naintenance
Maintenance—>Login 3. Because of permission restriction, log in as
Advanced User or Special User.
NOTE

. M _ After passing the permission validation, the system
LS EV LY, dvanced User keeps the authentication information for 30 seconds.
Password: 000000 If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
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Operation Procedure

Maintenance

USB Expansion

Device Ngmt. NOTICE
Cleared data cannot be restored. Therefore, perform
this operation with caution.

Data Clear
System Reset

4. Press W, select Data Clear, and press

Maintenance->Data Clear

ESC :Cancel o :Enter

Clear historical data?

5. On the displayed screen, press 4J

Maintenance->Data Clear

Complete

:Enter

6. After the data is cleared, press ¢J No
further operation is required.

—End

6.2.36 Resetting the System

You can reset the system on the LCD.

Procedure

The following table lists the procedure for resetting the system. The parameter values in

the following figures are for reference only.
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LCD

Operation Procedure

2017-08-10 16:32:24

1I('|I'h

04:00 08:00 12:00 16:00 20:00

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

A0 @:0 ®:0

1. On the default screen, press 4J to enter
the main menu.

HEHEUE-A Y =

Maintenance

2. Choose LT_ and press 4J

Maintenance—>Login

User Name :K¥svgastei=Xs AF

3. Because of permission restriction, log in as
Advanced User or Special User.

NOTE

After passing the permission validation, the system

USB Expansion
Device Ngmt.
Data Clear

-
System Reset

keeps the authentication information for 30 seconds.
Password: 000000 If you exit the screen and log in again within the 30
seconds, no permission authentication is required.
Maintenance 4. Choose System Reset by pressing W, and

press 4J
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LCD Operation Procedure

5. Press 4J

|]|[aint enance—>aystem Reset

—End

6.2.37 Querying Product Information

This topic describes how to query the information about the SmartLogger on the monitoring
panel.

Procedure

e  The following table describes the procedure for querying product information. The
parameter values in the following figures are for reference only.

LCD Operation Procedure

2017-08-10 16:32:24 {| 1 O the default screen, press « toenter

the main menu.

KWh

04:00 08:00 12:00 16:00 20:00 M

E-Dailwv: 24. 04kWh
Reduced C02: 240, 40kg
fctive power: 0. 00W

M0 @:0 D:0

fibout 2. Select and press |

Type:SmartLogger1000
Nodel :SmartLogger1000-10
Version:V100R001C00SPC118
SN:2102310PQW10EBO00368

www, huawel. com

~--End
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7 WebUI

7.1 Note

NOTICE

e The web software version corresponding to the WebUI snapshots in this document is
SmartLogger V100R001C00SPC118. The data on the WebUI snapshots is for reference
only.

e Parameters displayed on operation pages vary depending on the role that you use to log in
to the WebUI. This document describes the operation pages displayed after you log in as
Advanced User.

e Configurable parameters vary depending on the device model and grid code. The actual
display prevails. The parameter list provided in this document includes all configurable
parameters.

e The 600 V and 1000 V inverters refer to the inverters with the maximum input voltage of
600 V and 1000 V respectively. The 1100 V inverters refer to the inverters with the
maximum input voltage of 1100 V and the SUN2000-33KTL-US/36KTL-US/40KTL-US.
The maximum input voltage can be queried from the product nameplate or the appropriate
user manual.

7.2 Preparations for Login

Operating Environment

The operating environment for the WebUI should meet the following requirements:

®  Operating system: Windows

e Internet Explorer 8 to Internet Explorer 11, Firefox17—-Firefox39, or
CHROME41-CHROME45 (Windows 7)

®  Minimum resolution: 1024x768

LLl NnoTE

e For Internet Explorer 8, the recommended release is 8.0.7601.17514 or later.
e For Internet Explorer 10, the compatible mode is recommended.
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Setting the IP Address

Correctly set the IP address, subnet mask, and gateway for the SmartLogger, PC, and network
devices (when connected).

Setting the LAN

NOTICE

e |f the SmartLogger is connected to a local area network (LAN) and a proxy server has
been set, you need to cancel the proxy server settings.

e |f the SmartLogger is connected to the Internet and the PC is connected to the LAN, do not
cancel the proxy server settings.

Step 1 Open Internet Explorer.
Step 2 Choose Tools > Internet Options.
Step 3 Click the Connections tab and then click LAN settings.

Figure 7-1 LAN setting (1)

Internet Options [ ? -Ehl

| General I Security I Privacy I Content |[C0nnecﬁons IPrograms I .ﬁ.dvanced|

To setup an Internet connection, dick
Setup.

Dial-up and Virtual Private Metwork settings

Choose Settings if you need to configure a proxy Settings
server for a connection,

@) Mever dial a connection
Dial whenever a network connection is not present
Always dial my default connection

Local Area Netwark (LAN) settings

LAN Settings do not apply to dial-up connections. I LAN settings I

Choose Settings above for dial-up settings.

OK l l Cancel Apply

Step 4 Deselect User a proxy server for your LAN.
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Figure 7-2 LAN setting (2)

Local Area Network (LAN) Settings [

Automatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.

[¥]Automatically detect settings:

|:| lUse automatic configuration script

Proxy server

@lse a proxy server for your LAM (These settings will not apply to
ial-up or VPM connections).
o

al Advance

Bypass proxy server for local addresses

Step 5 Click OK.
----End

Setting Internet Explorer Security

To export fault information and operation logs, you need to set the Internet Explorer security.

Step 1 Open Internet Explorer.
Step 2 Choose Tools > Internet Options.

Step 3 Click the Security tab and then click Sites in Trusted sites.
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Figure 7-3 Internet Explorer security setting (1)
Internet Options Im

| General | Security |Privaq-' I Content I Connections I Programs I Advan::edl

Select a zone to view or change security settings.

Internet  Local intranet M Restricted

sites

Trusted sites —_—

e 5= |
This zone contains websites that you . J
trust not to damage your computer or

your files,
‘fou have websites in this zone.,

Security level for this zone
Allowed levels for this zone: All

Low

- Minimal safeguards and warning prompts are provided
-Mast content is downloaded and run without prompts
- All active content can run

= - Appropriate for sites that you absolutely trust

["]Enable Protected Mode {requires restarting Internet Explorer)

[ Custom level... H Default level ]

[ Reset all zones to default level ]

[ 0K J [ Cancel Apply

Step 4 Enter the website address of the WebUI (enter the default IP address 192.168.0.10 of the

SmartLogger for the first login), click Add, and then click Close.

Figure 7-4 Internet Explorer security setting (2)
Trusted sites u

) You can add and remove websites from this zone. All websites in
! this zone will use the zone's security settings.

Add this website to the zone:
( |
Websites:

* hisilicom. com - Remove

= hisilicon.com |
* hislicon.com
* huawei.com

e leeimesimid e e mmmm

[ require server verification (https:) for all sites in this zone

Close
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Step 5 Set Security level for this zone to Medium or Low.

—-End

7.3 Logging In to the WebUI

Context

The SmartLogger has been connected to a PC directly or over the Ethernet. For details, see
4.8 Connecting an Ethernet Network Cable.

If you log in to the WebUI for the first time, a security risk warning shown in Figure 7-5 is
displayed. Click Continue to this website. to continue the WebUI login.

L] NnoTE
[ ]

It is recommended that users use their own certificates. If the certificate is not replaced, the security
risk warning will be displayed during each login.

e After logging in to the WebUI, you can import a certificate under Network Security Certification
on the 7.11.3 Setting Security Parameters page.

e The imported security certificate needs to be bound to the SmartLogger IP address. Otherwise, the
security risk warning will still be displayed during login.

Figure 7-5 Security risk warning

@ There is a problem with this website's security certificate.
A

The security certificate presented by this website was not issued by a trusted certificate authority.
The security certificate presented by this website was issued for a different website's address

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.

& Click here to close this webpage.

[‘:2‘ Continue to this website (not rsmmr'vendedl‘]

® More information

Procedure

Step 1 Enter https://XX.XX.XX.XX in the address box of the browser, and press Enter. The login
page is displayed.
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Figure 7-6 Login page

O

- -
HUAWEI

@ power system

nspire

(EDETTEL- N English v

(EETR N ETL N Advanced User v

Password

[l noTE

XX XX.XX.XX is the IP address for the SmartLogger. For example, the default IP address for the
SmartLogger is https://192.168.0.10.

Step 2 Specify Language, User Name, and Password, and then click Log In.

L] noTE

e The user name is Common User, Advanced User, or Special User. The password is 000001 in
V100R001C95SPCO010 or earlier and is Changeme in V100R001C95SPC020 or later.

e Use the initial password upon first power-on and change it immediately after login. To ensure
account security, change the password periodically and keep the new password in mind. Not
changing the initial password may cause password disclosure. A password left unchanged for a long
period of time may be stolen or cracked. If a password is lost, devices cannot be accessed. In these
cases, the user is liable for any loss caused to the PV plant.

e If you enter wrong passwords for five consecutive times in 5 minutes, your account will be locked
out. You have to try again with the account 10 minutes later.

If any page is blank or a menu cannot be accessed after you log in to the WebUI, clear the
cache, refresh the page, or log in again.

~—-End

7.4 WebUI Menu

The WebUI varies with the role that you use to log in.

L1l noTE

e indicates that the user has permission to operate the menu; o indicates that the user does not have
permission to operate the menu.
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Table 7-1 Users and permission on the WebUI
Menu Common Advanced Special User
User User
Main Menu | Second-Lev | Third-Leve | Fourth-
el Menu 1 Menu Level
Menu
Over View Plant - - . ° °
Running
Info.
Active Alarm | - - ) ° °
Plant Yield - - ° ° °
Performance | - - . ° °
Data
Device - - ° ° °
Running
Info.
Monitoring SmartLogger | Running - ) ° °
1000 Info.
Active - ) ° °
Alarm
About - ° ° °
Inverter? Running - ° ° °
Info.
Active - ) ° °
Alarm
Performance | - ) ° °
Data
Yield - ° ° °
Running Grid o ° °
Param. Paramete
rs
Protect o ° °
Paramete
rs
Feature o ° °
Paramete
rs
Power o o °
Adjustme
nt
Tracking - o ) o
System
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Menu Common Advanced Special User
. . User User
Main Menu | Second-Lev | Third-Leve | Fourth-
el Menu 1 Menu Level
Menu
LVRT - o o °
Characteristi
¢ Curve
About - ° ° °
PLC Running - ° ° °
Info.
STA List - o ° o
Networking | - o ° o
Settings
About - ° ° °
EMI Running - ) ° °
Info.
Performance | - ° ° °
Data
Running - o ° o
Param.
About - ° ° °
Power Running - ° ° °
Meter” Info.
Performance | - ° ° °
Data
Running - o ° o
Param.
About - ° ° °
PID Running - ° ° °
Info.
Active - ° ° °
Alarm
Performance | - ° ° °
Data
Running - o ° o
Param.
About - ° ° °
PID-PVBOX | Running - ° ) °
Info.
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Menu Common Advanced Special User
) . User User
Main Menu | Second-Lev | Third-Leve | Fourth-
el Menu 1 Menu Level
Menu
Active - ° ° °
Alarm
Performance | - ° ° °
Data
Running - o ° o
Param.
About - ° ° °
PID-SSC Running - ° ° °
Info.
Active - ° ° °
Alarm
Performance | - ° ° °
Data
Running - o ° o
Param.
About - ° ° °
Custom Running - ° ° °
Device Info.
Teleindicati | - ) ° °
on
Telemeterin | - ) ° °
g
Telecontrol | - ) ° °
Teleadjust - ° ° °
Query Alarm - - ° ° °
History
Operation - - o ) °
Log
Export Data | - - o ° °
Settings User Param. | Date&Time | - . ° o
Plant - ° ° o
Currency - ° ) o
Comm. Ethernet - o ° o
Param.
RS485 - o ° °
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Menu Common Advanced Special User
) User User
Main Menu | Second-Lev | Third-Leve | Fourth-
el Menu 1 Menu Level
Menu
Power - o ° °
Meter
Managemen | - o ) o)
t System
Modbus - o ° °
TCP
IEC103 - o ° o
IEC104 - o ° o
Extended FTP - o) ° o
Param. :
Email - o ° o
Port Settings | DO - o ° o
usB - o ° o
Alarm - - o ° o
Output
Active Power | - - o o °
Control
Reactive - - o o) °
Power
Control
Remote - - ) o °
Shutdown
DI Port - - ) o °
Settings
Export - - o o °
Limitation
Maintenance | Firmware - - o ° °
Upgrade
Product - - ° ° °
Information
Security - - ° ° °
Settings
System - - o ) °
Maint.
Device Log - - o ) °
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Menu Common Advanced Special User
User
Main Menu | Second-Lev | Third-Leve | Fourth-
el Menu 1 Menu Level
Menu
Onsite Test Inspection - o °
Spot-check® | - o °
License - - o °
Management
Device Connect - o °
Mgmt. Device
Device list - o °
Export - o °
Param.
Alarm Reset | - o °
Collect Perf. | - o °
Data
Adjust total | - o °
energy yield
[ noTE

e a: In the inverter, Tracking System and LVRT Characteristic Curve are only available for the
1100 V inverter.

e b: The power meter can support the standard Modbus-RTU or DL/T645 protocol. Running Param.

is only available for the power meter that supports DL/T645.

e c: The spot-check function is available only for the inverter for which Grid Code is set to Japan
standard.

7.5 Icon Description

Icon Description Icon Description
@] Click the About icon to ﬂ Click the Drop-down
query the WebUI version icon to select a parameter
information. IEI or time.
I} Click the Exit icon to log Alarms are classified into

out.

major, minor, and
warning ones. Click the
Alarm icon to query an
alarm.
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Icon Description Icon Description
» Click the ‘3 Click the Start icon to
Increase/Decrease icon to start the device.
£ adjust time.
@ The Select icon indicates o Click the Stop icon to
- that a parameter is : shut down the device.
selected.
The Select icon indicates | Click the Reset icon to
that a parameter is not W reset the device.
selected. Click the icon to
select a parameter.
- R Hide icon and Display ® The inverter is in
icon. Click them to hide On-grid state.
and expand parameters. e The EMI, power
meter, slave
SmartLogger, or
MBUS is in Online
state.
e ThePIDisin
Running state.
The device is in o The inverter is in

Disconnection state.

If a device is in
Disconnection state, its
parameters cannot be set.

Loading state.

e Theinverterisin
Initializing,
Power-off, Idle, or
other state in which it
is not feeding power
into the grid.

e The PID device is in
Power-off, Idle or
other state in which it
is not running

properly.

Ascending order or
descending order icon.
Click the icon to sort the
items in ascending or
descending order for the
corresponding column.

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd.

162




SmartL.ogger1000
User Manual

7 WebUI

7.6 WebUI Layout

Figure 7-7 WebUI layout

13 Locking

14 Mo, vake for reactive adjustment 29921 Kar
i, vale for reactive adiust

Max, value for active adjustment 100000 kw

4
l—l'_El
Deployment Wizard | Over View m Query | Settings | Maintensnce F A @0 @) — 5
[ m Acthe Arm Aot
Slgml Name Value Unit
Energy yield of currert day 6920 KW
2 Total energy yied 1609.08 K
Reduced CO2 emission 1604.25 kg
4 Input power 4412 W
Active power 4273 KW
& Reactive power 0.000 War
Power tactor 1000
8 Inverter efficlency 26.90 %
DC curent ]
10 Grid Aphose cutent 6 A
11 Grid 8phas t A ,_6
12 GridCph et 6 A

Uniocked

nent 49927 Kvar

NA KW
NA KVar

NA
192 168.0.10

TIGEESTIWTIL

Table 7-2 WebUI layout description

No. Function Description
1 Secondary Under the primary navigation menu, choose the device to
navigation menu | be queried or the parameter to be set under the secondary
navigation menu.
2 Tertiary After choosing a secondary menu, choose a tertiary menu
navigation to access the query or setting screen.
menu?
3 Primary Click the corresponding primary navigation menu before
navigation menu | you perform any operation over the WebUI.
4 Display Select the display language or choose to log out.
language
5 Alarm icon Displays the severities and number of alarms in the system.
You can access the alarm page by clicking the number.
6 Details page Displays the details of the queried information or
parameter settings.
7 Power grid Displays the current power grid scheduling mode of the
scheduling status | system.
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No. Function Description

8 System time Displays the current system time.

a: There are no tertiary navigation menus under certain secondary navigation menus.

7.7 Overview

7.7.1 Plant Running Information

Choose Over View > Plant Running Info. and query information on the displayed page.

Figure 7-8 Plant running information

Power Station Information

Plant name
Plant address
Number of inverters 5
Total rated power 96.00kW
Active power E-Daily E-Total Reduced CO2 emission Revenue
0.31kW 460.23MWh 28.47MWh 28.39t
< ®@Power O Yield
Active power(kW)
2.0
1.6
:
0.8
0.4 ft A
Al %ﬂ,‘f W
i AVl
0.0
00:00 04:00 08:00 12:00 16:00 20:00 00:00 h

L1l noTE

The PV plant running information contains only the information about all the Huawei SUN2000s
connected to the SmartLogger.

7.7.2 Active Alarm

Choose Over View > Active Alarm and query alarms on the displayed page.
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Figure 7-9 Active alarm

Active Alm Quantity: 5

Device |All ESeverity All E|Sorting made |Time E

Alarm ID Severity Device Alarm Name Gel
111 Warning 40KTL-US(COM1-8) Abnormal String 6 201
109 Warning 40KTL-US(COM1-8) Abnormal String 4 201
108 Warning 40KTL-US(COM1-8) Abnormal String 3 201
107 Warning 40KTL-US(COM1-8) Abnormal String 2 201
106 Warning 40KTL-US(COM1-8) Abnormal String 1 201

e

7.7.3 Plant Yield

Choose Over View > Plant Yield and query energy yield data on the displayed page.

Figure 7-10 Energy yield

)
“4 1w 1/1 Page | |[EYY

MR vonth  Year 3
Yield
kwh
&’
2.00
1.60 5
1.20
0.80
«
0.40
00:00 04:00 08:00 20:00 00:00
Time Yield(kWh) Reduced CO2 emission(kg) Revenue(€)
Total 414 413 -
00:00:00-01:00:00 0.00 0.00 -
01:00:00-02:00:00 0.00 0.00 --
02:00:00-03:00:00 0.00 0.00 -
03:00:00-04:00:00 0.00 0.00 -
04:00:00-05:00:00 0.00 0.00 -
05:00:00-06:00:00 0.00 0.00 - =

L1l noTE

You can select a tab on the tertiary navigation tree to query the energy yield data of the specific period.
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NOTICE

e The daily energy yields can be stored for 30 days on an hourly basis.

e The monthly energy yields can be stored for 1 year on a daily basis.

e The yearly energy yields can be stored for 10 years on a monthly basis.
e The historical energy yields can be stored for 25 years on a yearly basis.

7.7.4 Performance Data

Choose Over View > Performance Data and query related information on the displayed
page.

Figure 7-11 Performance data

®Table O Curve O Export Time ¢ [2017 ][5 v[[20 v >

Generation time E-Daily(kWh) Input power(kW) Active power(kW) A
2017-5-20 00:00:00 0.00 3.549 3415 22,
2017-5-20 00:05:00 268 3.548 3449 22,
2017-5-20 00:10:00 5.37 3.582 3407 22,
2017-5-20 00:15:00 8.07 3493 3.359 22,

d 2017-5-20 00:20:00 10.76 3476 3402 22,
2017-5-20 00:25:00 1346 3478 3374 22
2017-5-20 00:30:00 16.17 34606 3421 22,
2017-5-20 00:35:00 18.86 3.542 3.397 22,
2017-5-20 00:40:00 21.57 3.535 3440 22,
2017-5-20 00:45:00 24.27 3.506 3412 22,
2017-5-20 00:50:00 26.94 3.581 3447 22,
2017-5-20 00:55:00 29.64 3.582 3418 22‘\‘

< >
W4 1M 1/11 Page
(Ll noTE
e You can click an option in the upper left corner of the page to display the data in the specified format

or export the data.

e When changing the name of the exported file after data is exported, retain the extension .tar.gz.
Otherwise, the file will be unusable.

7.7.5 Device Running Information

Choose Over View > Device Running Info. to enter the page. You can check or import the
device running information here.
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Figure 7-12 Device running information

Total Device Qty.:6

Device
28KTL(COMG6-1)
40KTL(COMB-2)
30KTL-US(COMB-3)
SOKTL{COME6-4)
40KTL-US(COMG6-5)
45KTL-US(COMB-7)

.
= =3

Address
6-1
6-2
6-3
6-4
6-5
6-7

7.8 Device Monitoring

7.8.1 SmartLogger

Device status
Disconnection
Disconnection
Disconnection
Disconnection
Disconnection

Disconnection

E-Daily(kWh)
0.00
0.00
0.00
0.00
0.00
0.00

Active power(kW)
0.000
0.000
0.000
0.000
0.000
0.000

7.8.1.1 Querying Master SmartLogger-Related Information

Reactive power(kVar)

0.000
0.000
0.000
0.000
0.000
0.000

Choose Monitoring > Logger(Local) and query master SmartLogger-related information on
the displayed page.
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Figure 7-13 Querying master SmartLogger-related information

AT Aciive larm

No.
1

B e N oM oB oW o

Signal Name

Energy yield of current day
Total energy yield
Reduced CO2 emissicn
Input power

Active power

Reactive power

Power factor

Inverter efficiency

DC current

Grid A phase current
Grid B phase current
Grid € phase current
Locking

Max. value for reactive sdjustment

Min. value for resctive adjustment
Max. value for active adjustment
Remote scheduling (P)

Remote scheduling (Q)

Remote scheduling (P)

Remote scheduling (PF)
Management System

€D Key No.

NMS1 P

NMS2 P

NMS3 P

NMSa P

NMSS P

1EC104-1 1P

L] NnoTE

You can click a tab on the tertiary navigation menu to query master SmartLogger-related information.

About

Value

0.00
0.00
0.00
0.000
0.000
0.000
0.000
0.00
0.0

Locked
0.000
0.000
0.000
NA

NA

NA

NA

NA
EISQGN6G395E
NA
NA

NA

NA

NA

NA

unit
Kwh
Kwh
kg

kw
KVar

kVar

kw
kVar

7.8.1.2 Querying Slave SmartLogger-Related Information

Select a slave SmartLogger on the Monitoring tab page to query its information.

Figure 7-14 Querying slave SmartLogger-related information

No.  Signal Name
SN
IP Address

Bow N e

7.8.2 Inverter

7.8.2.1 Querying Related Information

Device status

Logical addr.

Value Unit
2102311NAE10GE000029

192.168.0.10

OnLine

12

On the Monitoring tab page, select the inverter to be queried and access the query page to

query related information.
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Figure 7-15 Querying inverter-related information

Running Info. Active Alarm

0ow

Performance Data Yield About

Signal Name Value Unit
Device status Grid dispatch: cos(Phi)-P curve

Rated power 50.000 w
Energy yield of current day 143 KWh
Total energy yield 53676.87 KWh
Reduced CO2 emission 53515.83 kg
Input power 0.000 W
Active power 0.000 W
Reactive power 0.000 KVar
Power factor 0.000

PV1/PV2/PV3/PV4/PV5/PV6/PYT/PVS voltage 588.3/588.3/586.9/586.9/588.0/588.0/148.3/148.3 v
PV9/PV10/PV11/PVI2 voltage 148.2/148.2/147.8/147.8 v
PV1/PV2/PV3/PV4/PV5/PV6/PYT/PVS current -0.05/0.04/0.00/0.02/-0.02/0.04/0.00/0.00 A
PVS/PV10/PV11PV12 current 0.00/0.00/0.00/0.00 A
Grid AB/BC/CA voltage 517.7/517.6/515.0 G
Grid A/B/C phase current 0.011/0.011/0.011 A
Grid frequency 49.99 Hz
Cabinet temperature 323 degC
Locking Locked

Startup time 2019-01-14 10:14:00

Shutdlown time
Collect DSP data
Active power adjustment

Reactive power adjustment

[l noTE

e You can click the

2019-01-13 00:46:30
Normal
P = 100.0%(Active power deration percent)

Q: cos(Phi)-P curve

Running Info. 4 , Active Alarm

Performance Data

Yield o

About

information.

e You can click the Start, Stop, or Reset icon to send the corresponding command to the inverter.

7.8.2.2 Setting Running Parameters (Advanced User)

Settings Page

tab on the tertiary navigation menu to query inverter-related

Because of permission restriction, log in as Advanced User. Select the inverter to be set on
the Monitoring page and click the Running Param. tab.
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Figure 7-16 Running Param. (advanced user)

Running Info. Active Alarm Performance Data Yield Running Param. About
¥ Grid Parameters Protect Parameters Feature Parameters
CIan No. Signal Name Value Unit
O 1 Grid code VDE-AR-N-4105 ﬂ
| 2 Isolation Input ungrounded(with TF) ﬂ

e The parameter list provided in this document includes all configurable parameters.
Configurable parameters vary with the device model and grid code. The actual screen
prevails.

e |f you change the grid code, some parameters may be restored to factory defaults. After the
grid code is changed, check whether the previously set parameters are affected.

Grid Parameters

Table 7-3 Parameter description

No. Parameter Description Value Range

1 Grid code Set this parameter based on the grid N/A
code of the country or region where the
inverter is used and the inverter
application scenario.

2 Isolation Specifies the inverter working mode * Input grounded (with TF)
based on the grounding status at the DC | o Input ungrounded
side and the connection to the power (without TF)
grid.

¢ Input ungrounded (with
TF)
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Protection Parameters

Table 7-4 Parameter description

No. Parameter Description Unit | Value Range
1 Insulation To ensure device safety, the MQ The value range for the 600 V
resistance inverter detects the insulation inverter is [0.02, 1.5], that for
protection resistance of the input side to the the 1000 V inverter is [0.033,
ground when it starts a self-check. 1], and that for the 1100 V
If the detected value is less than inverter is [0.033, 1.5].
the preset value, the inverter does
not export power to the power
grid.
Feature Parameters
Table 7-5 Parameter description

No. Parameter | Description Unit Value Range | Remarks

1 MPPT When the inverter is used in N/A e Disable The scan interval is
multi-peak scenarios where PV strings are e Enable set through MPPT
scanning obviously shaded, enable this scanning interval.

function. Then the inverter will
perform MPPT scanning at
regular intervals to locate the
maximum power.

2 MPPT Specifies the MPPT scan min [5, 30] This parameter is
scanning interval. displayed only when
interval MPPT multi-peak

scanning is set to
Enable.

3 RCD RCD refers to the residual N/A * Disable N/A

enhancing current of the inverter to the e Enable

ground. To ensure device
security and personal safety,
RCD should comply with the
standard. If an AC switch with a
residual current detection
function is installed outside the
inverter, this function should be
enabled to reduce the residual
current generated during
inverter running, thereby
preventing the AC switch from
misoperations.
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4 Reactive In some specific application N/A ¢ Disable For the inverters
power output | scenarios, a power grid e Enable except the 600 V
at night company requires that the inverter, this
inverter can perform reactive parameter is available
power compensation at night to only when Isolation is
ensure that the power factor of set to Input
the local power grid meets ungrounded (with
requirements. TF).
5 Strong If the value of power grid short | N/A e Disable N/A
adaptability | circuit capacity/power plant e Enable
installed capacity is less than 3
and the power grid impedance
exceeds the upper threshold, the
power grid quality will be
affected and the inverter may be
unable to run properly. Set
Strong adaptability to Enable.
6 Power If Power quality optimization | N/A e Disable N/A
quality mode is set to Enable, the e Enable
optimization | inverter output current
mode harmonics will be optimized.
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No. Parameter

Description

Unit

Value Range

Remarks

7 PV module
type

This parameter is used to set
different types of PV modules
and the shutdown time of the
concentration PV modules. If
the concentration PV modules
are shaded, the power drops
drastically to 0 and the
SUN2000 shuts down. The
energy Yyield would be affected
since it takes too long for the
power to resume and SUN2000
to restart. The parameter does
not need to be set for crystalline
silicon and filmy PV modules.

¢ If PV module type is set to
Crystalline silicon or Film,
the SUN2000 automatically
detects the power of PV
modules when they are
shaded and shuts down if the
power is too low.

¢ \When the concentration PV
modules are used:

- If PV module type is set
to CPV 1, the inverter
can quickly restart in 60
minutes when the input
power of PV modules
drops drastically due to
shading.

- If PV module type is set
to CPV 2, the inverter
can quickly restart in 10
minutes when the input
power of PV modules
drops drastically due to
shading.

N/A

e Crystalline
silicon

e Film

e CPV1

e CPV2

N/A

8 Crystalline
silicon PV
compensatio
n mode

This parameter reduces the DC
voltage of PV modules to the
PE by reducing the impedance
of the inverter input side to the
PE, thereby effectively reducing
PID effect of PV modules.

N/A

e OQutput
disabled
e P-type
output
e N-type
output

This parameter is
displayed if PV
module type is set to
Crystalline silicon.
Set this parameter to
P-type output for
P-type PV modules
and N-type output for
N-type PV modules.
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No. Parameter | Description Unit Value Range | Remarks

9 Communicati | The standards of certain N/A e Disable If Communication

on interrupt | countries and regions require e Enable interrupt shutdown
shutdown that the inverter must shut down is set to Enable and
after the communication is the inverter
interrupted for a certain time. communication has
been interrupted for a
specified time (set by
Communication
interruption
duration), the
inverter will
automatically shut
down.

10 Communicati | Specifies the duration for min [1, 120] N/A

on determining communication

interruption | interruption, and is used for

duration automatic shutdown for
protection in case of
communication interruption.

11 Communicati | If this parameter is enabled, the | N/A * Disable For the 600 V

on resumed inverter automatically starts e Enable inverter, this

startup after communication recovers. parameter is displayed
If this parameter is disabled, the when
inverter needs to be started Communication
manually after communication interrupt shutdown
recovers. is set to Enable.

12 Soft start Specifies the duration for the S [20, 1800] This parameter is set

time power to gradually increase to 360 by default if

when the inverter starts. the Australian

ASATTT grid code is
selected, to 300 by
default if the Italian
CEIO-21 or CEIO-16
grid code is selected,
and to 600 by default
if the Egyptian
EGYPT grid code is
selected.

13 AFCI The North American standard N/A * Disable This parameter is
requires the inverter to provide e Enable supported by only the
the DC arc detection function. products marked -US.

14 Arc detection | Adjusts the sensitivity of arc N/A e High l:dr;p(igtt?gr[:(r)]rqlo de and

raT:JIggéatlon detection. * Moderate | AFC] self-test are
e Low displayed only when
AFCl is set to
15 AFCI Send the AFCI self-test N/A N/A Enable.
self-test command manually.
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No. Parameter | Description Unit Value Range | Remarks

16 Current error | When the 1V curves of PV A [0.00, 2.00] N/A
during strings are being scanned, the
scanning current change of PV strings

operating properly should be
monitored to avoid inaccurate
scanning caused by sunlight
change. If the current exceeds
the specified value, it is
determined that the sunlight
changes, and the IV curves
should be scanned again.

17 OVGR If this parameter is set to N/A * Disable This parameter is
linked Enable, the inverter shuts down e Enable displayed after the
shutdown after receiving the OVGR Japanese grid code is

signal. If this parameter is set to selected.
Disable, the inverter does not

shut down after receiving the

OVGR signal.

18 Dry contact Identifies the dry contact signals | N/A e NC Set this parameter to

function from the SmartLogger. e OVGR OVGR for OVGR
signals, and set it to
NC for other signals.
This parameter is
displayed after the
Japanese grid code is
selected.

19 Hibernate at | The inverter monitors PV N/A e Disable N/A
night strings at night. If Hibernate at e Enable

night is set to Enable, the
monitoring function of the
inverter will hibernate at night,
reducing power consumption.

20 PLC For inverter models that support | N/A * Disable e If Tracker
communicati | both RS485 and PLC e Enable controller is set to
on communication, when RS485 a model, this

communication is used, you are
advised to set PLC
communication to Disable to
reduce power consumption.

parameter cannot
be set to Enable.

e If the inverter
communicates
with the
SmartLogger over
PLC, this
parameter cannot
be set to Enable
on the WebUI.
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No. Parameter | Description Unit Value Range | Remarks

21 Upgrade This parameter is mainly used N/A ¢ Disable After the inverter
delay in the upgrade scenarios where e Enable upgrade starts, if

the PV power supply is Upgrade delay is set
disconnected at night due to no to Enable, the
sunlight or unstable at dawn or upgrade package is
dusk due to poor sunlight. loaded first. After the
PV power supply
recovers and the
activation conditions
are met, the inverter
automatically
activates the upgrade.

22 String The inverter monitors PV N/A e Disable If PV strings are
monitor strings in real time. If any PV e Enable easily shaded, you are

string is abnormal (such as advised to set String
being shaded or with decreased monitor to Disable to
energy yields), the inverter prevent false alarms.
generates an alarm to remind

maintenance personnel of

timely maintenance.

23 String Specifies the delay time for min [2, 720]
detection low | generating abnormal string
power delay | alarms when the inverter detects

that a PV string is working with

low power. This parameter is

mainly used in the scenario

where PV strings are shaded for

a long time in the morning and

evening, and is used to prevent

false alarms. ) )
This parameter is

24 String Specifies the delay time for min [2, 720] displayed when
detection generating abnormal string String monitor is set
high power alarms when the inverter detects to Enable.
delay that a PV string is working with

high power.

25 String Specifies the thresholds for % [1, 100]
detection determining whether a PV
power string is working with high
segment power or low power. This
division parameter is used to distinguish
percentage the working status of PV

strings.

26 String Specifies the threshold for N/A e SUN2000- | This parameter is
detection determining PV string (8KTL-28 | displayed when
reference exception. The false alarms KTL): String monitor is set
asymmetric | caused by fixed shadow shading [0.05, 1] to Enable.
coefficient can be controlled by changing e Others: [5,

this parameter. 100]
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27 String Specifies the threshold for % [1, 100]
detection starting PV string exception
starting detection. The false alarms
power caused by fixed shadow shading
percentage can be controlled by changing
this parameter.
28 Shutdown at | If this parameter is set to N/A e Disable N/A
0% power Enable, the inverter shuts down e Enable
limit after receiving the 0% power
limit command. If this
parameter is set to Disable, the
inverter does not shut down
after receiving the 0% power
limit instruction.
29 Maximum Specifies the output upper kVA [Maximum If the maximum active
apparent threshold for the maximum active power, | power equals
power apparent power to adapt to the Smax_limit] Smax_limit, this
capacity requirements for parameter is not
standard and customized displayed.
transformers.
30 Maximum Specifies the output upper kw [0.1, For 1000 V inverters,
active power | threshold for the maximum Pmax_limit] this parameter is
active power to adapt to various configurable only for
market requirements. the
SUN2000-25KTL-US
, and the maximum
value is 27.5 kW.
31 Tracking Selects a controller vendor. N/A e No N/A
system tracking
controller controller
® Each
controller
vendor
32 Commanded | The standards of certain N/A e Disable N/A
shutdown countries and regions require e Enable
hold after that if the inverter is shut down
power based on a command and
recovery powers on again after power
recovers, it should still be in
commanded shutdown state.
33 Grounding If this parameter is set to N/A ¢ Disable N/A
abnormal Enable, the inverter shuts down e Enable
shutdown after receiving the grounding

error signal. If this parameter is
set to Disable, the inverter does
not shut down after receiving
the grounding error signal.
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34 String Specifies the connection mode N/A e Automatic | N/A
connection of PV strings. detection
mode e When the PV strings e AllPV
connect to the inverter strings
separately (fully separate separated
connection), there is no need e AllPV
to set this parameter. The strings
inverter can automatically connected
detect the connection mode
of the PV strings.
¢ \When the PV strings
connect to one another in
parallel outside the inverter
and then connect to the
inverter independently (fully
parallel connection), set this
parameter to All PV strings
connected.
35 PID e When PID protection at N/A e Disable N/A
protection at night is set to Enable, the e Enable
night SUN2000 will shut down
automatically if it detects
abnormality in PID voltage
compensation during the
reactive power
compensation at night.
e When PID protection at
night is set to Disable, the
SUN2000 will operate in
grid-tied mode if it detects
abnormality in PID voltage
compensation during the
reactive power
compensation at night.
36 RS485-2 If this parameter is set to N/A e Disable N/A
communicati | Enable, the RS485-2 port can e Enable
on be used. If the port is not used,
it is recommended that this
parameter be set to Disable to
reduce power consumption.
37 Built-in PID | Specifies the operation mode of | N/A ¢ Disable N/A
running the SUN2000 built-in PID. e Repair
mode
38 PID Specifies whether to enable the | N/A e Disable N/A
nighttime PID nighttime off-grid repair. e Enable
off-grid
repair
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39 PID daytime | Specifies whether to enable the | N/A ¢ Disable N/A
off-grid PID daytime off-grid repair. e Enable
repair

7.8.2.3 Setting Running Parameters (Special User)

Settings Page

Because of permission restriction, log in as Special User. Select the inverter to be set on the
Monitoring page and click the Running Param. tab.

Figure 7-17 Running Param. (special user)

o d DDDDDDDE

Grid Parameters Protect Parameters Feature Parameters

Power Adjustment

Running Info. Active Alarm Performance Data i  Running Param. About

No. Signal Name

Value

1 Grid code VDE-AR-N-4105
2 Auto start upon grid recovery Enable
3 Grid connection duration after power grid recovery |60
4 Grid reconnection voltage upper limit 253.0
5 Grid reconnection voltage lower limit 1955
6 Grid reconnection frequency upper limit 50.05
7 Grid reconnection frequency lower limit 47.50
5 Reactive power compensation (cosy-P) trigger 105
voltage
9 Reactive power compensation (cosi-P) exit voltage |98

Unit
~
v
(0-900) B
(230.0-312.8) v
(103.5-218.5) v
(50.00-56.00) Hz
(42.50-50.00) Hz
(100-110) %
(90-100) %

@1 w 1/1 Page
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NOTICE

e The parameter list provided in this document includes all configurable parameters.
Configurable parameters vary with the device model and grid code. The actual screen
prevails.

e If you change the grid code, some parameters may be restored to factory defaults. After the
grid code is changed, check whether the previously set parameters are affected.

Grid Parameters

Table 7-6 Parameter description

No. Parameter Description Unit | Value Range Remarks

1 Grid code Set this parameter based N/A N/A N/A
on the grid code of the
country or region where
the inverter is used and the
inverter application
scenario.

2 Output mode | Specifies whether the N/A ¢ Three-phase This parameter is
inverter has an output three-wire supported by the
peutral wire pasgd on the e Three-phase SUN2000-33KTL,
inverter application four-wire SUN2000-33KTL-A,
scenario. SUN2000-36KTL,

SUN2000-50KTL-MO,
SUN2000-60KTL-MO,
and the inverters named
with -US.

3 PQ mode If PQ mode 1 is selected, | N/A e SUNZ2000-36K | This parameter is
the maximum AC output TL: PQ mode | supported by the
power equals the 1 (Pmax =40 SUN2000-36KTL,
maximum apparent power. kW), PQ mode | SUN2000-42KTL,

If PQ mode 2 is selected, 2 (Pmax = 36 SUNZ2000-50KTL-MO,
the maximum AC output kw) and
power equals the rated SUN2000-42K | SUN2000-60KTL-MO.
OUtpUt power. TL: PQ mode 1

(Pmax = 47

kW), PQ mode

2 (Pmax =42

kW)

SUN2000-50K

TL-MO,

SUN2000-60K

TL-MO: PQ

mode 1, PQ

mode 2
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4 Auto start Specifies whether to allow | N/A e Disable
upon grid the inverter to e Enable N/A
recovery automatically start after

the power grid recovers.

5 Grid Specifies the waiting time | s [0, 900] This parameter can be
connection for inverter restart after the set to [150, 900] for the
duration after | power grid recovers. 1000 V and 1100 V
power grid inverters under the
recovery Japanese grid codes.

6 Grid The standards of certain \Y/ [100%Vn,
reconnection | countries and regions 136%Vn]
voltage upper | require that the inverter
limit must not connect to the

power grid when the .

power grid voltage is In 1000 V inverters, the

higher than the upper SUN2000-(8KTL-28K

limit. TI__) does not support
this parameter.

7 Grid The standards of certain \Y/ [45%Vn, 95%Vn] | v/, represents the rated
reconnection | countries and regions voltage.
voltage lower | require that the inverter
limit must not connect to the

power grid when the
power grid voltage is
lower than the lower limit.

8 Grid The standards of certain Hz [100%Fn, 112%Fn]
reconnection | countries and regions
frequency require that the inverter
upper limit must not connect to the

power grid when the .

power grid frequency is In 1000 V inverters, the

higher than the upper SUN2000-(8KTL-28K

limit. TL) does not support
this parameter.

9 Grid The standards of certain Hz [85%Fn, 100%Fn] | Ep represents the rated
reconnection | countries and regions frequency.
frequency require that the inverter
lower limit must not connect to the

power grid when the
power grid frequency is
lower than the lower limit.

10 Reactive Specifies the voltage % [100, 110] N/A
power threshold for triggering
compensation | reactive power
(coso-P) compensation based on the
trigger coso-P curve.
voltage
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11 Reactive Specifies the voltage % [90, 100] N/A

power threshold for exiting
compensation | reactive power
(cosp-P) exit | compensation based on the
voltage cos@-P curve.
Protection Parameters
Table 7-7 Parameter description

No. Parameter | Description Unit | Value Range Remarks

1 Unbalance | Specifies the inverter % [0.0, 50.0] N/A
voltage protection threshold in
protection the case of unbalanced

power grid voltage.

2 Phase The Japanese standard i [3, 15] Configurable
protection requires that during abruptly changed
point passive islanding phase angles are 3<

detection, protection 6<9< 12<and 15<

should be triggered if an which are displayed

abrupt voltage phase after the Japanese

change is detected. grid code is
selected.

3 Phase angle | The standards of certain | N/A ¢ Disable N/A
offset countries and regions e Enable
protection require that the inverter

needs to be protected
when the three-phase
angle offset of the power
grid exceeds a certain
value.

4 10 minute Specifies the 10-minute | V [1xVn, 1.36 x Vn]
ov overvoltage protection
protection threshold.

Vn represents the

5 10 minute Specifies the 10-minute ms e 1000 V inverter: rated voltage.
ov overvoltage protection [50, 600000]
protection duration. e Others: [50, 7200000]
time

6 Level-1 OV | Specifies the level-1 \Y/ [1xVn, 1.36 X Vn]
protection overvoltage protection

threshold. Vn represents the

7 Level-1 OV | Specifies the level-1 ms e 1000 V inverter: rated voltage.
protection overvoltage protection [50, 600000]
time duration.

e Others: [50, 7200000]
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8 Level-2 OV | Specifies the level-2 \Y/ e SUNZ2000-65KTL-C1
protection overvoltage protection [TOKTL-C1: [1x
threshold. Vn, 1.5 xVn]
e Others: [1xVn, 136 |/ represents the
x V] rated voltage.
9 Level-2 OV | Specifies the level-2 ms e 1000 V inverter:
protection overvoltage protection [50, 600000]
time duration. e Others: [50, 7200000]
10 Level-1 UV | Specifies the level-1 \Y/ [0.15x Vn, 1 x Vn]
protection undervoltage protection
threshold. Vn represents the
11 Level-1 UV | Specifies the level-1 ms e 1000 V inverter: rated voltage.
protection undervoltage protection [50, 600000]
time duration. e Others: [50, 7200000]
12 Level-2 UV | Specifies the level-2 Vv [0.15Xx Vn, 1 x Vn]
protection undervoltage protection
threshold. Vn represents the
13 Level-2 UV | Specifies the level-2 ms e 1000 V inverter: rated voltage.
protection undervoltage protection [50, 600000]
time duration. e Others: [50, 7200000]
14 Level-1 OF | Specifies the level-1 Hz [1x Fn, 1.15 x Fn]
protection overfrequency protection
threshold. Fn represents the
15 Level-1 OF | Specifies the level-1 ms e 1000 V inverter: rated frequency.
protection overfrequency protection [50, 600000]
time duration. e Others: [50, 7200000]
16 Level-2 OF | Specifies the level-2 Hz [1xFn, 1.15 x Fn]
protection overfrequency protection
threshold. Fn represents the
17 Level-2 OF | Specifies the level-2 ms e 1000 V inverter: rated frequency.
protection overfrequency protection [50, 600000]
time duration. e Others: [50, 7200000]
18 Level-1 UF | Specifies the level-1 Hz [0.85 x Fn, 1 x Fn]
protection underfrequency
protection threshold. Fn represents the
19 Level-1 UF | Specifies the level-1 ms [50, 7200000] rated frequency.
protection underfrequency
time protection duration.
20 Level-2 UF | Specifies the level-2 Hz [0.85 x Fn, 1 x Fn] En represents the
protection underfrequency rated ?‘re Lenc
protection threshold. g y
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21 Level-2 UF | Specifies the level-2 ms e 1000 V inverter:
protection underfrequency [50, 600000]
time protection duration. e Others: [50, 7200000]
22 Level-3 OV | Specifies the level-3 \% e SUN2000-65KTL-C1 | | In 1000 V/
protection overvoltage protection [TOKTL-C1: [1x inverters. onl
threshold. Vn, 1.5 xVn] the inver:[ers y
e Others: [1x Vn, 1.36 marked "-US"
x Vn] support this
23 Level-3 OV | Specifies the level-3 ms e 1000 V inverter: parameter.
protection | overvoltage protection [50, 600000] . \én represenlts
time duration. « Others: [50, 7200000] | e fated voltage.
24 Level-4 OV | Specifies the level-4 \% * SUN2000-65KTL-C1 | | In 1000 V/
protection overvoltage protection [T0KTL-C1: [1x inverters. onl
threshold. Vn, 1.5 x Vn] the inver:[ers y
e Others: [1 x Vn, 1.36 marked "-US"
x'Vn] support this
25 Level-4 OV | Specifies the level-4 ms e 1000 V inverter: parameter.
protection overvoltage protection [50, 600000] * Vnrepresents
time duration. « Others: [50, 7200000] | M fated voltage.
26 Level-3 UV | Specifies the level-3 \Y [0.15x Vn, 1 x Vn] * |n 1000V
protection undervoltage protection inverters, only
threshold. the inverters
— - marked "-US"
27 Level-3 UV | Specifies the level-3 ms e 1000 V inverter: support this
protection | undervoltage protection [50, 600000] parameter.
the rated voltage.
28 Level-4 UV | Specifies the level-4 \Y/ [0.15Xx Vn, 1 x Vn] e In 1000V
protection undervoltage protection inverters, only
threshold. the inverters
— - marked "-US"
29 Level-4 UV | Specifies the level-4 ms e 1000 V inverter: support this
protection | undervoltage protection [50, 600000] parameter.
time duration. * Others: [50, 7200000] | & /n represents
the rated voltage.
30 Level-5 OV | Specifies the level-5 \% [1xVn,1.5xVn]
protection overvoltage protection
threshold. Vn represents the
31 Level-5 OV | Specifies the level-5 ms [50, 7200000] rated voltage.
protection overvoltage protection
time duration.
32 Level-6 OV | Specifies the level-6 \Y/ [1xVn, 1.5xVn] VI represents the
protection overvoltage protection rated \F;ol tage
threshold. ge.
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33 Level-5 QV | Specifies the level-6 ms [50, 7200000]
protection overvoltage protection
time duration.
34 Level-5 UV | Specifies the level-5 \% [0.15x Vn, 1 x Vn]
protection undervoltage protection
threshold. Vn represents the
35 Level-5 UV | Specifies the level-5 ms [50, 7200000] rated voltage.
protection undervoltage protection
time duration.
36 Level-6 UV | Specifies the level-6 \Y/ [0.15Xx Vn, 1 x Vn]
protection undervoltage protection
threshold. Vn represents the
37 Level-6 UV | Specifies the level-6 ms [50, 7200000] rated voltage.
protection undervoltage protection
time duration.
38 Level-3 OF | Specifies the level-3 Hz [1xFn, 1.15 x Fn]
protection overfrequency protection
threshold. Fn represents the
39 Level-3OF | Specifies the level-3 ms [50, 7200000] rated frequency.
protection overfrequency protection
time duration.
40 Level-4 OF | Specifies the level-4 Hz [1xFn, 1.15 x Fn]
protection overfrequency protection
threshold. Fn represents the
41 Level-4 OF | Specifies the level-4 ms [50, 7200000] rated frequency.
protection overfrequency protection
time duration.
42 Level-5 OF | Specifies the level-5 Hz [1x Fn, 1.15 x Fn]
protection overfrequency protection
threshold. Fn represents the
43 Level-5 OF | Specifies the level-5 ms [50, 7200000] rated frequency.
protection overfrequency protection
time duration.
44 Level-6 OF | Specifies the level-6 Hz [1x Fn, 1.15 x Fn]
protection overfrequency protection
threshold. Fn represents the
45 Level-6 OF | Specifies the level-6 ms [50, 7200000] rated frequency.
protection overfrequency protection
time duration.
46 Level-3 UF | Specifies the level-3 Hz [0.85 X Fn, 1 x Fn] En represents the
protection underfrequency rated ?cre uenc
protection threshold. g Y
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47 Level-3 UF | Specifies the level-3 ms [50, 7200000]
protection underfrequency
time protection duration.
48 Level-4 UF | Specifies the level-4 Hz [0.85 x Fn, 1 x Fn]
protection underfrequency
protection threshold. Fn represents the
49 Level-4 UF | Specifies the level-4 ms [50, 7200000] rated frequency.
protection underfrequency
time protection duration.
50 Level-5 UF | Specifies the level-5 Hz [0.85 X Fn, 1 x Fn]
protection underfrequency
protection threshold. Fn represents the
51 Level-5 UF | Specifies the level-5 ms [50, 7200000] rated frequency.
protection underfrequency
time protection duration.
52 Level-6 UF | Specifies the level-6 Hz [0.85 X Fn, 1 x Fn]
protection underfrequency
protection threshold. Fn represents the
53 Level-6 UF | Specifies the level-6 ms [50, 7200000] rated frequency.
protection underfrequency
time protection duration.
54 Overfreque | Specifies the grid Hz e 50Hz: 50.5Hz,
ncy overfrequency protection 51.0 Hz, 51.5 Hz, and
protection threshold. 52.0 Hz NIA
threshold e 60 Hz: 60.6 Hz, 61.2
Hz, 61.8 Hz, and 62.4
Hz
55 Overfreque | Specifies the grid S 0.5s, 1.0s, 1.5s,and 2.0s | N/A
ncy overfrequency protection
protection duration.
duration
56 Underfrequ | Specifies the grid Hz e 50Hz: 49.5Hz,
ency underfrequency 49.0 Hz, 48.5 Hz,
protection protection threshold. 48.0 Hz, 47.5 Hz, and
threshold 47.0 Hz N/A
e 60 Hz: 59.6 Hz, 59.0
Hz, 58.4 Hz, 57.8 Hz,
and 57.2 Hz
57 Underfrequ | Specifies the grid S 0.5s, 1.0s, 1.5s,and 2.0s | N/A
ency underfrequency
protection protection duration.
duration
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58 AC Specifies the grid \Y/ 110.0V, 1125V, 115.0
overvoltage | overvoltage protection V, and 120.0 V N/A
protection threshold.
threshold
59 AC Specifies the grid S 0.5s, 1.0s, 1.5s,and 2.0s | N/A
overvoltage | overvoltage protection
protection duration.
duration
60 AC Specifies the grid \Y/ 80.0V,825V,85.0V,
undervoltag | undervoltage protection 87.5V,and 90.0 V N/A
e protection | threshold.
threshold
61 AC Specifies the grid S 0.5s, 1.0s, 1.5s,and 2.0s | N/A
undervolt undervoltage protection
duration.
62 AC Specifies the level-1 N/A ¢ Disable
overvoltage | overvoltage protection. e Enable N/A
protection
enable
63 FRT When the power grid N/A ¢ Disable N/A
voltage is abnormally e Enable
low for a short time, the
inverter cannot
disconnect from the
power grid immediately
and has to work for some
time. This is called
LVRT.
64 Active Specifies whether to N/A e Disable
|sland|r_1g gnablg the active e Enable N/A
protection islanding protection
enable function.
65 Passive Specifies whether to N/A ¢ Disable N/A
islanding enable the passive e Enable
protection islanding protection
enable function.
66 Voltage The Japanese standard ° 39699912<and 15°
phase jump | requires that during
detection passive islanding
value for detection, protection N/A
passive should be triggered if an
islanding abrupt voltage phase
change is detected.
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67 Frequency Refers to a control N/A ¢ Disable N/A
feedback module that calculates e Enable
module the reactive power based

on the offset deviation of
grid frequency and
promotes frequency
offset when islanding
occurs.

68 Step Refers to a control N/A ¢ Disable
injection module that injects step e Enable
module reactive power to

promote frequency offset
when the offset deviation
. N/A
of grid voltage and
frequency is very small.
When islanding occurs,
the inverter and load
reaches balance.

69 Frequency Specifies level-1 gain of | N/A [0, 100] N/A
feedback the frequency feedback
module K1 | module.
value

70 Frequency | Specifies level-2 gain of | N/A [0, 100]
feedback the frequency feedback N/A
module K2 | module.
value

71 Restart Specifies how the N/A e Manual N/A
mode after | inverter restarts after a e Automatic
grid failure | grid fault is rectified.

72 Restart Specifies the delay s 6s, 150s, 180s, 240s, and
duration before restart after a grid 300s N/A
after grid fault is rectified.
failure

73 System soft | Specifies the duration for | s [20, 800] N/A
start time the power to gradually

increase when the
inverter starts.

74 Voltage rise | The Japanese standard N/A e Disable N/A
suppression | requires that the inverter e Enable

should control the active
power and reactive
power when the output
voltage exceeds a certain
value to ensure the grid
voltage stability.
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75 Voltage rise | The Japanese standard \Y/ 107.0 v, 107.5V, 108.0
suppression | requires that the inverter V, 108.5V, 109.0 V,
reactive should adjust the reactive 109.5V, 110.0 Vv, 110.5
adjustment | power to prevent the grid V,111.0V, 1115V, N/A
point voltage from rising when 112.0 V,and 112.5V
the output voltage
exceeds a certain value.
76 Voltage rise | The Japanese standard \Y/ 109.0V, 1095V, 110.0 | e The parameter
suppression | requires that the inverter V, 1105V, 1110V, value is
active should derate the active 1115V, 1120V, 1125 automatically
derating power to prevent the grid V, 1130V, 1135V, displayed after
point voltage from rising when 114.0 V,and 1145V Voltage rise
the output voltage suppression
exceeds a certain value. reactive
adjustment
point is set.
® The value of
Voltage rise

suppression
active derating
point must be
greater than that
of Voltage rise
suppression

reactive
adjustment
point.
Feature Parameters
Table 7-8 Parameter description
No. Parameter Description Unit | Value Range Remarks
1 LVRT When the power grid N/A e Disable This parameter is set to
voltage is abnormally low e Enable Enable by default if

for a short time, the
inverter cannot disconnect
from the power grid
immediately and has to
work for some time. This is
called LVRT.

the German
BDEW-MV grid code
is selected.
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2 LVRT Specifies the threshold for | V [50%Vn, 92%Vn] This parameter is
threshold triggering LVRT. displayed when LVRT

is set to Enable.

In 1000 V inverters,
the
SUN2000-(8KTL-28K
TL) does not support
this parameter.

Vn represents the rated
voltage.

3 LVRT Specifies whether to shield | N/A ¢ Disable This parameter is
undervoltage | the undervoltage protection e Enable displayed when LVRT
protection function during LVRT. is set to Enable.
shield

4 LVRT During LVRT, the inverter | N/A [0, 3] This parameter is
reactive needs to generate reactive displayed when LVRT
power power to support the power is set to Enable.
compensation | grid. This parameter is used This parameter is set to
power factor | to set the reactive power 2.5 by default if the

generated by the inverter. South African grid
code is selected.
For example, if you set
LVRT reactive power
compensation power
factor to 2, the
reactive power
generated by the
inverter is 20% of the
rated power when the
AC voltage drops by
10% during LVRT.

5 HVRT When the power grid N/A e Disable N/A

voltage is abnormally high e Enable

for a short time, the

inverter cannot disconnect

from the power grid

immediately and has to

work for some time. This is

called HVRT.

6 HVRT Specifies the threshold for | V [105%Vn, This parameter is
triggering triggering the HVRT. The 130%Vn] displayed when HVRT
threshold threshold settings should is set to Enable.

meet the local grid
standard.

7 Active Specifies whether to enable | N/A ¢ Disable N/A
islanding the active islanding e Enable

protection function.
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8 Passive Specifies whether to enable | N/A e Disable This parameter is
islanding the passive islanding e Enable displayed after the

protection function. Japanese grid code is
selected.

9 Voltage rise | The standards of certain N/A ¢ Disable This parameter is set to
suppression countries and regions e Enable Enable by default if

require that the active the Italian grid code
power of the inverter be CEI0-16 is selected.
derated according to a

certain gradient when the

output voltage exceeds a

certain value.

10 Voltage rise The standards of certain % [100, 115] e This parameter is
suppression countries and regions displayed when
reactive require that the inverter Voltage rise
adjustment must generate a certain suppression is set
point amount of reactive power to Enable.

when the output voltage e The value of
exceeds a certain value. Voltage rise

11 Voltage rise | The standards of certain % [100, 115] suppression active
suppression | countries and regions derating point
active require that the active must be greater
derating point | power of the inverter be than that qf

derated according to a Voltage rise
certain gradient when the suppression
output voltage exceeds a reactive .
certain value. adjustment point.

12 Frequency The inverter triggers N/A e Disable N/A
change rate protection when the power e Enable
protection grid frequency changes too

fast.

13 Frequency Specifies the frequency Hz/s e 1000 V inverter: | This parameter is
change rate change rate protection [0.1, 2.5] displayed if
protection threshold. e Others: [0.1, 5] Frequency change
point rate protection is set

— to Enable.

14 Frequency Specifies the frequency S [0.2,20.0]
change rate change rate protection
protection duration.
time

15 Soft start Specifies the time for the S [20, 800] This parameter is set to
time after power to gradually increase 360 by default if the
grid failure when the inverter restarts Australian AS4777

after the power grid
recovers.

grid code is selected,
and to 300 by default if
the Brazilian ABNT
NBR 16149 or South
African SA_RPPs grid
code is selected.
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Power Adjustment Parameters

Table 7-9 Parameter description

of the inverter will be
derated according to a
certain slope when the
grid frequency exceeds
the value that triggers
overfrequency derating.

No. Parameter Description Unit Value Range Remarks

1 Active power | Adjusts the change speed | %/s e 1000 V inverter: N/A
change of the inverter active [0.1, 50]
gradient power. e Others: [0.1,

1000]
2 Fixed active | Adjusts the active power | e 600 [ e 1000 V inverter: Pmax represents the
power derated | output of the inverter in \% [0, Pmax] maximum active
fixed values. inve | o Others: [0 power.
rter: Pmax_limit] In the 1000 V/
W inverter, the upper
e Oth threshold for the
ers: SUN2000-25KTL-U
kw Sis 27.5 kW, and the
upper threshold for
other models of
inverters is Pmax.

3 Active power | Adjusts the active power | % [0, 100] If this parameter is
percentage output of the inverter in set to 100, the
derating percentages. inverter delivers the

maximum output
power.

4 Reactive Adjusts the change speed | %/s [0.1, 1000] N/A
power change | of the inverter reactive
gradient power.

5 Power factor | Adjusts the power factor N/A (-1.000, N/A

of the inverter. —0.800]U[0.800,
1.000]

7 Overfrequenc | If this parameter is N/A e Disable N/A

y derating enabled, the active power e Enable
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8 Trigger The standards of certain Hz When the output * This parameter is
frequency of | countries and regions frequency is 50 Hz, for the inverters
over require that the output the value range is except the 1000 V
frequency active power of the [45.00, 55.00]. ones. Itis
derating inverter should be derated When the output displayed when

when the power grid frequency is 60 Hz, Overfrequency
frequency exceeds a the value range is derating is set to
certain value. [55.00, 65.00]. Enable.

- — ® The parameter

9 Quit Specifies the frequency Hz When the output setting should
frequency of | threshold for exiting frequency is 50 Hz, meet the
over overfrequency derating. the value range is following
frequency [45.00, 55.00]. condition: Quit
derating When the output frequency of

frequency is 60 Hz, over frequency

the value range is derating <

[55.00, 65.00]. Trigger
frequency of
over frequency
derating <
Cutoff frequency
of overfrequency
derating.

10 Cutoff Specifies the frequency Hz When the output e This parameter is
frequency of | threshold for cutting off frequency is 50 Hz, displayed when
overfrequenc | overfrequency derating. the value range is Overfrequency
y derating [45.00, 55.00]. derating is set to

When the output Enable.
frequency is 60 Hz, ® The parameter
the value range is setting should
[55.00, 65.00]. meet the

. following

11 Cutoff power | Specifies the power % [5, 20] condition: Quit
of threshold for cutting off frequency of
overfrequenc | overfrequency derating. over frequency
y derating derating <

Trigger

frequency of
over frequency
derating <
Cutoff frequency
of overfrequency
derating.
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12 Power Specifies the power %/min | [5, 20] This parameter is set
recovery recovery gradient for to 16 by default if the
gradient of overfrequency derating. Australian AS4777
overfrequenc grid code is selected,
y derating and to 15 by default

if the Italian CEI0-21
or CEI0-16 grid code
is selected.

13 Remote If this parameter issetto | N/A ¢ Disable N/A
power Enable, the inverter e Enable
schedule responds to the scheduling

instruction from the
remote port. If this
parameter is set to
Disable, the inverter does
not respond to the
scheduling instruction
from the remote port.

14 Schedule Adjusts the duration S [0, 86400] If this parameter is
instruction within which the setto 0, the
valid duration | scheduling instruction is instruction is valid

valid. permanently.

15 Maximum Specifies the output upper | kVA [Maximum active If the maximum
apparent threshold for the power, Smax_limit] | active power equals
power maximum apparent power Smax_limit, this

to adapt to the capacity parameter is not
requirements for standard displayed.
and customized inverters.

16 Maximum Specifies the output upper | KW [0.1, Pmax_limit] N/A
active power | threshold for the

maximum active power to
adapt to various market
requirements.

17 Shutdown at | If this parameter issetto | N/A ¢ Disable N/A
0% power Enable, the inverter shuts e Enable
limit down after receiving the

0% power limit
instruction. If this
parameter is set to
Disable, the inverter does
not shut down after
receiving the 0% power
limit instruction.

18 Reactive Adjusts the inverter N/A (-1.000, 1.000] N/A
power output reactive power.
compensation
(Qf5)
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19 Reactive Adjusts the power factor N/A (-1.000, N/A
power of the inverter. —-0.800]U[0.800,
compensation 1.000]

(PF)

20 Reactive In some specific N/A ¢ Disable For the inverters
power output | application scenarios, a e Enable except the 600 V
at night power grid company inverter, this

requires that the inverter parameter is available
can perform reactive only when Isolation
power compensation at is set to Input

night to ensure that the ungrounded (with
power factor of the local TF).

power grid meets

requirements.

21 Enable * When this parameter is | N/A e Disable N/A
reactive set to Enable, the e Enable
power system compensates
parameters at the reactive power at
night night based on the

value of Reactive
power compensation
at night.

* When this parameter is
set to Disable, the
system compensates
the reactive power at
night based on the
remote scheduling
command.

22 Reactive Sets the reactive power to | kVar (-Qmax, Qmax) N/A
power be compensated at night.
compensation | \when there is no input or
at night remote scheduling

command on the PV side,

this command is
responded.

7.8.2.4 Setting a Tracking System

If a PV string uses a tracking system with controllers, you can set parameters for the tracking
system over the WebUI.

L] noTE

The parameters vary depending on the controller manufacturer. Set parameters based on site

requirements.

This function applies only to the 1100 V SUN2000.

Because of permission restriction, log in as Advanced User. Choose Monitoring >
SUN2000 > Tracking System to access the target page.
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Figure 7-18 Setting a tracking system

Running Info. ~ Active Alarm  Performance Data  Yield ~ Running Param. _ABRICY IHeRS e, About

© Support System . Configure Para

Support System
Tracker controller  Tonking
Support system type  Tilted single axis

Total number of supports 8

Support Access Status System Status Azimuth (%) Starting Stop Clr Fault Azimuth
1 Connected Abnormal 0.00 Er
2 Connected Abnormal 0.00 Er
3 Connected Abnormal 0.00 Er
4 Connected Abnormal 0.00 [ “settings |
T Connected Abnarmal 000 [ “settings |
| 6 Connected Abnormal 0.00 [ “settings |
7 Connected Abnormal 0.00
Connected Abnormal 0.00

8
Batch CIr Fault_| Az Batch Setting

[l noTE

You can click the Select icon in the upper left corner of the page to select a setting page.

7.8.2.5 Setting the LVRT Characteristic Curve
LI noTe

Only the 1100 V SUN2000 supports the LVRT characteristic curve, and other models of SUN2000s do
not have this function.

Because of permission restriction, log in as Special User. Choose Monitoring > SUN2000 >
LVRT Characteristic Curve and set the characteristic curve on the displayed page.
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Figure 7-19 Setting the LVRT characteristic curve

Running Info. Active Alarm Performance Data Yield Running Param. LVRT Characteristic Curve About

Characteristic curve points 2 E

Ufue

»i(ms)

0.00 T T T T T T
-1000 1000 3000 5000 7000 9000 11000

t(ms) U/Uc(%)

A 20 (0~10000) 0.20 (0.00~1.00)
B 1000 (0~10000) 0.80 (0.00~1.00)
it | et congutons |

After you set the LVRT characteristic curve for one SUN2000, click Batch configurations to
synchronize the LVRT characteristic curve settings to other SUN2000s.

7.8.3 PLC

The SmartLogger is integrated with the PLC CCO and connected to the SUN2000 that
supports the PLC function over an AC power cable. Data is transmitted over the power cable

to implement PLC networking.

7.8.3.1 Querying Related Information

Choose Monitoring > MBUS and query related information on the displayed page.
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Figure 7-20 Querying MBUS-related information

METTTITITM STA List  Networking Settings ~ About W
No. Signal Name Value Unit

Device status OnLine

CCO net status networked

Device identification status Search complete

SNID 1

a2 W oo

L] noTE

You can click the __nunning Info. 4 , © About
query MBUS-related information.

7.8.3.2 Setting the STA List

Because of permission restriction, log in as Advanced User. Choose Monitoring > PLC >
STA List and set Baud rate for the listed devices on the displayed page.

tab on the tertiary navigation menu to

Figure 7-21 Setting the STA list

Running Info. ﬁﬂg‘ Networking Settings About
MBUS networking status: networking Number of online STAs: 0
No. MAC Address Device SN Comm Address Baud rate
Export STA List

e The STA list displays information about the SUN2000 equipped with the PLC STA module that is
being connected.

e When changing the name of the exported file after the STA list is exported, retain the
extension .tar.gz. Otherwise, the file will be unusable.
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7.8.3.3 Networking Settings

Because of permission restriction, log in as Advanced User. Choose Monitoring > PLC >
Networking Settings.

Running parameters

Figure 7-22 Running parameters

RunningInfo.  STA List About
® Running Param. (SN List
Clan No. Signal Name Value Unit
1 1 Baud rate 9600 v
O 2 Anti-crosstalk Disable v
1 3 Network frequency band 2-12 (MHz) M
(m} 4 Box-type transformer No. o (0-511)
] 5 Winding No. 0 ©-7

LLl NnoTE

e Baud rate is set to 115200 by default, which provides optimal communications performance and
does not need to be changed.

o If Anti-crosstalk is set to Enable, the inverter with a PLC STA in the SN list can access networking.

e Parameters Box-type transformer No. and Winding No. can be set for the PLC CCO with
SUN2000 V100R001C72SPC100 or later versions. In multi-split transformer scenarios, specify
Winding No. based on the actual winding number of the SmartLogger connected to the transformer.
When the box-type transformer and winding numbers of the inverter with an STA are consistent with
those of the PLC CCO, the inverter can access networking.

SN list

Figure 7-23 SN list

Running Info. STA List Networking Settings About

(O Running Param. ® SN List

m} No. SN Match Status Transformer No. Winding No. Device Comm Address
O 1 024LURBTHAD01296 @ 13 6 33KTL(COM3-1) 1
O 2 024LURBTHAD01364 @ 13 6 33KTLICOM3-3) 3

'

(i ] vete | ervort L impor | Syetronie ] Tempte |
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The SN list displays the relevant information of the inverters with PLC STASs that can be connected.

e Tap Synchronize, and synchronize the box-type transformer and winding numbers of the PLC CCO
to the inverter.

e NO.: number of the SNs used only to show the quantity of devices

e Device: device name of each inverter. The naming rule is Model(PLC-x) by default. For example:
40KTL(PLC-3).

7.8.4 EMI
7.8.4.1 Querying Related Information

Choose Monitoring > EMI and query related information on the displayed page.

Figure 7-24 Querying EMI-related information

METTTITT Performance Data  About

No.  Signal Name Value Unit
Dally Irradiation amount NA KWh/mA2
Total ifradiance NA W/mA2
PV module temperature NA degC
Ambient temperature NA degC

Wind speed NA m/s

R RS

Wind direction NA

L1l noTE

e You can click the - Rumming Info. j = Performance Data = ,, = About ., oy
the tertiary navigation menu to query EMI-related information.

e EMI performance data can be stored for a month and exported. When changing the name of the
exported file, retain the extension .tar.gz. Otherwise, the file will be unavailable.

7.8.4.2 Setting EMI Parameters

Devices from different vendors may support different protocol specifications. To normally
obtain information from the connected EMI, correctly configure the protocol specifications
over the SmartLogger WebUI based on the protocol specifications delivered by the vendor.

After the SmartLogger connects to the EMI, manually add the device. For details, see 7.11.8.1
Connecting Devices. Device Type should be set to EMI.

Because of permission restriction, log in as Advanced User. Choose Monitoring > EMI and
set EMI parameters.
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Figure 7-25 EMI

Running Info.  Performance Data AT T2, About

Envi

I model JinZhou YangGuang(PC-4)

Synchronize Environment Data | Disable

Master/Slave slave mode

®  When the connected device model is in the EMI model drop-down list, set the
parameters as follows.

Parameter Description

EMI model Set this parameter to the model of the corresponding EMI.

Currently, the following models are supported: ABB
VSN800-12, ABB VSN800-14, Gill MetPak Pro, Hukseflux
SRX, Ingenieurblro Si-RS485TC, Kipp&Zonen SMPX, Lufft
WSx-UMB, Lufft WSx-UMB (external sensors), Meier-NT
ADL-SR, Meteo control SR20-D2, Rainwise PVmet-150,
Rainwise PVmet-200, Soluzione Solare SunMeter, JinZhou
LiCheng, JinZhou YangGuang (PC-4), and HanDan

(RYQ-3).
Synchronize Environment | Retain the default value Disable.
Data NOTE
If Enable is selected, wind speed and direction will be sent to the
inverters in a PV plant with the tracking system.
Master/Slave When the SmartLogger connects to multiple EMIs, you can

set one of them to master mode. The inverter performance
data contains that of the EMI in master mode.

e If the connected EMI is a split-type one that supports the Modbus-RTU protocol, set the
parameters as follows.

Parameter Description

EMI model Set this parameter to Sensor(ADAM).

Synchronize Environment | Retain the default value Disable.

Data NOTE

If Enable is selected, wind speed and direction will be sent to the
inverters in a PV plant with the tracking system.

Master/Slave When the SmartLogger connects to multiple EMIs, you can
set one of them to master mode. The inverter performance
data is that of the EMI in master mode.

Read function code Read holding register 03H and Read input register 04H
are supported. Set this parameter based on the vendor's
protocol.

Data reporting mode Integer and Floating point are supported. Set this parameter
based on the vendor's protocol.
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Parameter Description
Word ordering Big endian and Little endian are supported. Set this
parameter based on the vendor's protocol.
Read mode Multiple read and Single read are supported.
Start address When Read mode is set to Multiple read, set the start
address.
End address When Read mode is set to Multiple read, set the end
address.
Signal Set this parameter based on the vendor's protocol.
NOTE NOTE
Signal-related parameters If the EMI can collect a certain signal, set Signal address to the
include Signal Name, Signal address of the corresponding register. If not, set Signal address to
address, Lower Thres., 65535.

Upper Thres., Spec, Start
(mV/mA), and End
(mV/mA).

® If the connected EMI is of another model, set the parameters as follows.

Parameter Description

EMI model Set this parameter to Other.

Synchronize Environment | Retain the default value Disable.

Data NOTE

If Enable is selected, wind speed and direction will be sent to the
inverters in a PV plant with the tracking system.

Master/Slave When the SmartLogger connects to multiple EMIs, you can
set one of them to master mode. The inverter performance
data contains that of the EMI in master mode.

Read function code Read holding register 03H and Read input register 04H
are supported. Set this parameter based on the vendor's
protocol.

Data reporting mode Integer and Floating point are supported. Set this parameter
based on the vendor's protocol.

Word ordering Big endian and Little endian are supported. Set this
parameter based on the vendor's protocol.

Read mode Multiple read and Single read are supported.

Start address When Read mode is set to Multiple read, set the start
address.

End address When Read mode is set to Multiple read, set the end
address.
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Parameter Description

Signal Set this parameter based on the vendor's protocol.

NOTE NOTE
Signal-related parameters If the EMI can collect a certain signal, set Signal address to the
include Signal Name, Signal address of the corresponding register. If not, set Signal address to
address, Gain, and Offset. 65535.

7.8.5 Power Meter

7.8.5.1 Querying Related Information

Choose Monitoring > Meter and query related information on the displayed page.

Figure 7-26 Querying the meter information

AT Performance Data . About

No.  Signal Name

1 Device status

2 Line voltage between phases A and B
3 Line voltage between phases B and C
4 Line voltage between phases C and A
5 Phase A voltage

3 Phase B voltage

7 Phase C voltage

8 Phase A current

9 Phase B current

10 Phase C current

1 Phase A active power
12 Phase B active power

13 Phase C active power

14 Active power
15 Reactive power
16 Power factor
17 Total active electricity
18 Total reactive electricity
19 Total positive active electricity
20 Total positive reactive electricity
2 Total negative active electricity
2 Total negative reactive electricity
LI noTe

e You can click the

Value Unit
Online

1004.00 v
1005.00 v
1006.00 v
1001.00 v
1002.00 v
1003.00 v
1007.0 A
1008.0 A
1009.0 A
1016.000 kW
1017.000 kW
1018.000 kW
1010.000 kW
1011.000 kVar
0.706

1019.00 kWh
1020.00 kVarh
1021.00 kWh
1022.00 kVarh
1023.00 kWh
1024.00 kVarh

Running Info. 4 ~ Performance Data  ,,  About

the tertiary navigation menu to query meter information.

e The performance data of the meter can be exported. When changing the name of the exported file,
retain the extension .tar.gz. Otherwise, the file will be unusable.

7.8.5.2 Setting Running Parameters

Because of permission restriction, log in as Advanced User. Choose Monitoring > Meter >
Running Param. to access the target page.

L] noTE

Set running parameters only for the power meter that supports the DL/T645 protocol.
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Figure 7-27 Setting running parameters

Running Info. Performance Data Running Param. About
Clan No. Signal Name Value Unit
=] 1 Protocol version DL/T645-2007 E
O 2 Number of lead bytes 4 (0-4)
] 3 Voltage change ratio 1.0 (0.1-2200.0)
O 4 Current change ratio 1.0 (0.1-2200.0)

4“4 1 »r» 1/1 Page Go to|

7.8.6 PID
7.8.6.1 Querying Related Information

Choose Monitoring > PID and query related information on the displayed page.

L] noTE

This document describes the page displayed when the PID01 module is connected as an example.

Figure 7-28 Querying PID module-related Information

m Active Alarm Performance Data Running Param. About a o
No. Signal Name Value Unit
1 Device status Disconnection
2 Output voltage NA v
3 Qutput current NA mA
4 Cabinet temperature NA degC
5 PV1 voltage NA v
6 PV2 voltage NA v
7 Grid AB line voltage NA v
8 Grid BC line voltage NA v
9 Grid CA line voltage NA v
10 Grid frequency NA Hz
11 Power grid imbalance NA %
12 Voltage harmonic NA %
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e Youcanclickthe _ _Running Info. 4 | Active Alarm  Performance Data

About tab on the tertiary navigation menu to query PID module-related information.

e Performance data of the PID module can be exported. When changing the name of the exported file,
retain the extension .tar.gz. Otherwise, the file will be unavailable.

7.8.6.2 Setting Running Parameters

Because of permission restriction, log in as Advanced User. Choose Monitoring > PID >
Running Param. to access the target page.

Figure 7-29 Setting running parameters

Running Info.  Active Alarm  Performance Data AT I About

Al No. Signal Name Value Unit
] QOffset mode Disabled v
2 Qutput enabled Disable ™
PV type P-type |
0 4 Operation mede Normal v
5 PV/PE offset voltage 0.0 (0.0-200.0)
6 Maximum DC voltage NA (500-1500) v
Maximum output voltage 0 (0-500)
8 IMD access Enable ™
9 Periodic PID runtime NA (60-480) min
Jm 10 Periodic IMD runtime NA (15-480) min
1 IMD control dry contact No v
“d4 1 W 1/1 Page

NOTICE

The parameter list provided in this document includes all configurable parameters.
Configurable parameters vary depending on the device model. The actual screen prevails.

Table 7-10 Parameter description

No | Paramet | Function Paramet | Description
er Name er Value
1 Offset Specifies the Disabled | Set this parameter to Disable if the PID module is not
mode offset mode of the required.
PID module.
N/PE Set this parameter to N/PE if the PID module is required
to use voltage output from the inductor virtual midpoint N.
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No | Paramet | Function Paramet | Description
er Name er Value

PV/PE Set this parameter to PV/PE if the PID module is required
to use voltage output from the negative PV terminal. This
mode is applicable only to SUN800O.

Automati | In the SUN2000, Automatic indicates the N/PE offset

c mode.

2 Output Specifies whether | Enable Set this parameter to Enable to allow the PID module
enabled the PID module output.

output is enabled. - - - -

Disable Set this parameter to Disable to forbid the PID module
output.

3 PV type Specifies the type | P-type Select this value if the PV module type is P. In this case,

of the PV module the PID module output voltage is positive.

used in the power ) - - -
station. For N-type Select this value if the PV module type is N. In this case,
details about the the PID module output voltage is negative.

PV module type,

consult the

manufacturer.

4 PV/PE Specifies the DC | 0-200V It is recommended that the offset voltage be set to a value
offset voltage when the ranging from 50 V to 200 V.
volt. offset mode is set

to PV/PE.
5 Operation | Specifies whether | Commissi | In commissioning mode, if you need to set the output
Mode the PID module is | oning mode to PV/PE or N/PE, set Output enabled to Enable.
currently working The PID module delivers output voltages based on the
in normal or value of Commissioning output voltage.
commissioning NOTE
mode. To check whether the PID module functions properly, it is
recommended that Operation mode be set to Commissioning
upon first power-on.

Normal In normal mode, the PID module operates automatically
after the PID module, inverter, and SmartLogger
communicate with each other properly.

6 Commissi | Specifies the 0-500V | Itis recommended that the commissioning voltage for the
oning output voltage 1000 V/1100 V inverter be set to a value ranging from 50
output when Operation V to 400 V.
voltage Mode is set to NOTE

Commissioning. After this parameter is set and the output from the PID module
becomes stable, use a multimeter that is set to the DC position to
measure the three-phase (A, B, and C) voltages of the power grid
to the ground, and check whether the voltages are the same as the
configured values.
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No | Paramet | Function Paramet | Description
er Name er Value

7 Maximum | Specifies the 500-1500 | If the PV module type is P, the parameter value indicates
DC PV-PE voltage \% the highest DC voltage between PV+ and PE. If the PV
voltage when Operation module type is N, the parameter value indicates the

Mode is set to highest DC voltage between PV—and PE.
Normal or
Commissioning.

8 Maximum | Specifies the 0-500 V | If the offset mode is PV/PE, the parameter value indicates
output highest output the highest DC output voltage between PV and PE. If the
voltage voltage of the offset mode is N/PE, the parameter value indicates the

PID module when highest DC output voltage between N and PE.
Operation Mode

is set to Normal

or

Commissioning.

9 IMD Specifies whether | Enable Select Enable if you allow the PID module and IMD

access the PID module operate in cycle mode.
and insulation Only the IMDs of mainstream suppliers such as DOLD
monitor device and BENDER are supported,and the IMDs must have
(IMD) can enabled dry contacts.
operate in cycle
mode. NOTICE
Only when IMD access is set to Enable, can you set Periodic
PID runtime, Periodic IMD runtime, and IMD control dry
contact.
Disable Select Disable if you forbid the access of IMDs.

10 | Periodic Specifies the 60-480 The IMD is shut down when the PID module is operating.
PID operating time minutes
runtime segment of the

PID module when
the PID module
and IMD operate
in cycle mode.

11 | Periodic Specifies the 15-480 The PID module is standby when the IMD is operating.
IMD operating time minutes
runtime segment of the

IMD when the
PID module and
IMD operate in
cycle mode.

12 | IMD Dry contact No. DO1, PIDO01: Set appropriate ports based on the cable
control over which the D02, and | connections between the IMD and the SmartLogger.
dry SmartLogger DO3
contact controls the IMD
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No | Paramet | Function Paramet | Description

er Name er Value
13 Clear Clears the active N/A You can select Clear Data to clear active alarms and

Data alarms and historical alarms for the PID module.

historical alarms
stored on the PID
module.

7.8.7 PID-PVBOX
7.8.7.1 Querying Related Information

Choose Monitoring > PID-PVBOX and query related information on the displayed page.

Figure 7-30 Querying PID-PVBOX-related information

M Active Alarm Performance Data Running Param. About @ 0
No. Signal Name Value Unit
1 Device function Repair
2 Device status Running
3 QOutput voltage 499.7 v
4 Qutput current 9 mA
5 PV1 voltage 0.0 v
6 Grid AB line voltage 475.5 v
7 Grid BC line voltage 475.2 v
8 Grid CA line voltage 477.1 v
9 Grid frequency 50.0 Hz
1 10 Consumed time to repair 0.5 h
11 Remaining time to repair 3.5 h
L] noTE
e Youcanclickthe _ Rumning Info. j | Active Alarm  Performance Data
About

tab on the tertiary navigation tree to query related information.

e The Performance Data of the PID-PVBOXcan be exported. When changing the name of the
exported file, retain the extension .tar.gz. Otherwise, the file will be unavailable.

7.8.7.2 Setting Running Parameters

Because of permission restriction, log in as Advanced user. Choose Monitoring >
PID-PVYBOX > Running Param. to enter the target page.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 208



SmartL.ogger1000

User Manual 7 WebUI
Figure 7-31 Setting running parameters
Running Info. Active Alarm Performance Data About

CJAn No. Signal Name Value Unit

| 1 Operation mode Commissioning ﬂ

(| 2 Commissioning output voltage 00 (0.0-100.0) v

O 3 Repair time 6.0 (0.0-6.0)
[ 4 Voltage to be repaired 500 (50-500) v
41 P o1/ Page

Parameter Description

Operation mode Specifies the current working mode of the PID module.

e Before setting this parameter to Commissioning, ensure that
inverters in a PV array are powered off and their DC switches are
turned off. This working mode is used during commissioning
after deployment or fault locating. In this case, the PID-PVBOX
delivers the output voltage based on the value of the
commissioned output voltage.

e Set this parameter to Normal after ensuring that the PID module
works normally.

Commissioning Specifies the output voltage when the PID module works in
output voltage commissioning mode.
Repair time Set the recovery time for each day.
Voltage to be Specifies the output voltage when the PID module works in normal
repaired mode.
7.8.8 PID-SSC

7.8.8.1 Querying Related Information

Choose Monitoring > PID-SSC and query related information on the displayed page.

Figure 7-32 Querying PID-SSC-related information

m Active Alarm Performance Data Running Param. About a o
No. Signal Name Value Unit
1 Device function Power
2 Device status Idle
3 Qutput voltage 0.0 v
4 Output current o} mA
5 Grid AB line voltage 521.5 v
| 6 Grid BC line voltage 524.3 v
7 Grid CA line voltage 525.6 v
8 Grid frequency 49.9 Hz
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e Youcanclickthe _ _Running Info. 4 | Active Alarm  Performance Data

About tab on the tertiary navigation tree to query related information.

e The Performance Data of the PID-SSC can be exported. When changing the name of the exported
file, retain the extension .tar.gz. Otherwise, the file will be unavailable.

7.8.8.2 Setting Running Parameters

Because of permission restriction, log in as Advanced user. Choose Monitoring >
PID-SSC > Running Param. to enter the target page.

Figure 7-33 Setting running parameters

Running Info. Active Alarm Performance Data Running Param. About

CJan No. Signal Name Value Unit
| 1 Operation mode Commissioning ﬂ

(| 2 Commissioning output voltage 0.0 (0.0-500.0) v
Parameter Description

Operation mode Specifies the current working mode of the PID module.

e Set this parameter to Commissioning during commissioning
after deployment or fault locating. In this case, the PID-PVBOX
delivers the output voltage based on the value of the
commissioned output voltage.

e Set this parameter to Normal after ensuring that the PID module
works normally.

Commissioning Specifies the output voltage when the PID module works in
output voltage commissioning mode. It is recommended that Commissioning
output voltage be set to a value greater than 250 V.

7.8.9 Custom Device

Custom Device: The SmartLogger can connect to the third-party devices supporting the
Modbus-RTU protocol, such as the box-type transformer and environmental monitoring
instrument (EMI). Since the protocol information points vary depending on vendors, you need
to obtain a protocol information file in .cfg format from Huawei and import the file into the
SmartLogger for successfully connecting to a third-party device.

LLl NnoTE

The SmartLogger supports the connection to a maximum of 10 types of custom devices and can connect
to multiple devices of the same type.
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7.8.9.1 Querying Related Information

Select a device on the Monitoring page and query related information on the displayed page.

Figure 7-34 Querying device information

¥ Running Info. Teleindication Telemetering Telecontrol Teleadjust

No. Signal Name Value Unit
1 SN CT02311HJBO0GB001486
2 Port number 6
3 Comm Address 1
4 Logical address 146
5 Device status Online
L] noTE

Click the _ running Info. j | Teleindication . = Telemetering | o on the tertiary
navigation menu to query device information.

7.8.9.2 Setting Telecontrol Parameters

Select a device on the Monitoring page, and select Telecontrol to go to the page.
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Figure 7-35 Setting Telecontrol Parameters

Running Info indicati i Teleadjust
Al No. Signal Name Value Unit
1 Power-On 0
2 Power-Off o
[ Submit | W1 P» 171 Page

7.8.9.3 Setting Teleadjust Parameters

Select a device on the Monitoring page, and select Teleadjust to go to the page.

Figure 7-36 Setting Teleadjust Parameters

Running Info. Teleindication Telemetering Telecontrol Teleadjust

AN No. Signal Name Value Unit
| 1 Protec. OV niveau-1 0
o 2 Durée protec. OV niv.1 0
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7.9 Querying Historical Data
7.9.1 Querying Historical Alarms

Choose Query > Alarm History and query alarms on the displayed page.

Figure 7-37 Historical alarms

Alarm History

Device | Logger(Local) || start time 2016-02-14 End time  2017-02-14

Sorting mode | Time E

Number of qualified operation logs: 0

No. Alarm ID Severity Device Alarm Name Generation time
2l
< i »
“41rmW 1/1 Page

7.9.2 Querying Operation Logs

Because of permission restriction, log in as Advanced User or Special User. Choose
Query > Operation Log and query logs on the displayed page.

Figure 7-38 Operation log

Operation Log
Number of qualified operation logs: 474
No. User Name Operation Time Operation Source Content
1 Advanced User 2019-03-01 17:1100 WEB Logger(Local)-End address-» 247
2 Advanced User 2019-03-01 171100 WEB Logger(Local)-Start address-»1
3 Advanced User 2019-03-01 171100 WEB Logger(Local)-Stop bit->1
4 Advanced User 2019-03-01 171100 WEB Logger(Local)-Parity->None
5 Advanced User 2019-03-01 171100 WEB Logger(Local)-Baud rate-> 115200
6 Advanced User 2019-03-01 171100 WEB Legger(Local)-Protocal- > Modbus
7 Advanced User 2019-03-01 174100 WEB Logger(Local)-End address- » 247
8 Advanced User 2019-03-01 171100 WEB Logger{Local)-Start address->1
9 Advanced User 2019-03-01 171100 WEB Logger{Local)-Stop bit->1
10 Advanced User 2019-03-01 171059 WEB Logger{Local)-Parity->None

Tu Advanced User 2019-03-01 171059 WEB Logger(Local)-Baud rate- > 115200
12 Advanced User 2019-03-01 171059 WEB Logger{Local)-Protocol- > Modbus
13 Advanced User 2019-03-01 171059 WEB Logger(Local)-End address-= 150
14 Advanced User 2019-03-01 171059 WEB Logger(Local)-Start address-»1
15 Advanced User 2019-03-01 171059 WEB Logger(Local)-Stop bit->1
16 Advanced User 2019-03-01 171059 WEB Logger(Local)-Parity->None
17 Advanced User 2019-03-01 17059 WEB Logger(Local)-Baud rate->115200
18 Advanced User 2019-03-01 1710559 WEB Logger(Local)-Protocal- > Modbus
19 Advanced User 2019-03-01 171045 WEB Logger(Local)-End address-= 247
20 Advanced User 2019-03-01 171045 WEB Logger(Local)-Start address-»1
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7.9.3 Exporting Data

Because of permission restriction, log in as Advanced User or Special User. Choose
Query > Export Data and export data on the displayed page.

Figure 7-39 Exporting data

Export Data

Alarm History ©Yield ©) Operation Log () Grid scheduling  C Al

Log archiving

[l noTE

When changing the name of the exported file, do not change the file name extension. Otherwise, the file
may be unavailable.
Opening the Exported File

The exported file is in CSV format and can be opened in Excel. After opening the file in Excel,
the cells may not be neatly organized. Set List separator to ,.

To view and change the list separator, perform the following steps:

1. Open Control Panel and choose Region and Language.
2. Under Formats, click Additional settings.
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Figure 7-40 Viewing and changing the list separator (1)
r S Region and Language ‘- g‘

Formats I‘ Location | Keyboards and Languages I Adminislmtwal
Format:
[ English (Arnerica) v]
Change serting method
Date and time formats
Short date: IMIW ']
[ Long date Idddd' MMMM dd, yyyy vI
Short time: lh:mm tt v]
Long time: lh:mrn:ss it 'l
First day of week: ISunday 'l
What does the notation mean?
Examples
I Short date: 6/25/2016
l Long date: Saturday, June 25, 2016
Short time: 8:31 PM
Leng time: 8:31:10 PM
.
Go online to learn about changing languages and regional formats
3. View and change the list separator.
- If List separator is ,, click OK.
- If List separator is not ,, change it to ,, and click OK.
Figure 7-41 Viewing and changing the list separator (2)
8 Customize Formit M‘
Numbers | currency | Tme [ Date [ sorting|
Example
Positive:  123,456,789.00 Negative:  -123,456,739.00
Decimal symbaol: 1 -
Me. of digits after decimal: [2 ']
Digit grouping symbol: . A
Digit grouping: [1?_:1',456,'."89 ']
MNegative sign symbol: - -
Negative number format: [-1‘1 v]
Display leading zeros: [.? ']
List separator: [, v]
Measurement system: [Metric ']
Standard digits: [018456?59 ']
L Use native digits: [Never ']
S e kst
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7.10 Settings

7.10.1 User Parameters

7.10.1.1 Setting the Date and Time

Because of permission restriction, log in as Common User or Advanced User. Choose

Settings > Date&Time to access the target page.

Figure 7-42 Setting the date and time

Date
Local time zone
Date
Time
Clock source
Synchronization server

Latest synchronization time

(UTC+08:00)Beijing |v|

10:16:21 (HH:MM:SS)
Management System ﬂ

NA

2018-09-21 10:10:55

=

e The Local time zone parameter is unavailable for zones without DST.

o After Date&Time is set, the date and time of all the inverters connected to SmartLogger
are updated accordingly. Ensure that the settings are correct.

e Modification of Date& Time may affect the recording of energy yield and performance

data. Therefore, do not change the time zone or system time arbitrarily.

7.10.1.2 Setting Plant Information

After you set plant information, a plant configuration file can be generated. You can upload
this file to a third-party hosting website to implement remote monitoring.

Because of permission restriction, log in as Common User or Advanced User. Choose

Settings > Plant to access the target page.
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Figure 7-43 Setting plant information

Plant Info.

Plant name

\
Plant address
\
\

Plant owner

|
|
|
|

Plant owner address

Country

[l noTE

When setting plant information, you cannot successfully enter any character such as
<>1,""?2()#&\$|%+;~"" in the English half-width status.

7.10.1.3 Setting Gain Parameters

Because of permission restriction, log in as Common User or Advanced User. Choose
Settings > Revenue to access the target page.

Figure 7-44 Setting gain parameters

| Gain Parameters

[<]

Currency | |EUR v
Electricity price/lWh 0.000-999.939)
€02 emission reduction coefficient Kka/kWh (0.000~10.000)

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 217



SmartL.ogger1000

User Manual

7 WebUlI

L] noTE

Electricity price/kWh indicates the local power price, and is used to calculate the translation gain of the
energy yield.

7.10.2 Communications Parameters

7.10.2.1 Setting Wired Network Parameters

Because of permission restriction, log in as Advanced User. Choose Settings > Wired
Network to access the target page.

Figure 7-45 Setting wired network parameters

Auto obtain IP

Auto chtain [P Dissble (cenfigurable on the LCD}

P address

0, 0 0 0

DHS Server Address

NOTICE

If the SmartLogger connects to the Internet through a router, note the following when setting
wired network parameters:

e Set the gateway address to the IP address of the router.

e Ensure that the IP address of the SmartLogger is in the same network segment as the
gateway address.

e Set the domain name server (DNS) address to the IP address of the router or obtain the
DNS address from the network provider.

LLl NnoTE

If the IP address is changed, you need to use the new IP address to log in to the system.

7.10.2.2 Setting RS485 Parameters

Because of permission restriction, log in as Advanced User or Special User. Choose
Settings > RS485 to access the target page.

Figure 7-46 RS485 parameters

RS485

RS485 Protocol Baud rate Parity Stop Bit Start address End address
RS485-1 Modbus v [ss00 v| [None RRE o 1-24 247
RS485-2 Modbus RREE] *|  [None R v 1 247
RS485-3 DL/Te45 A 9600 v None 1 M 1 4 247

Submit
¥ Night Comm. Settings

Records

L1l noTE

o RS485-1 to RS485-3 correspond to the communications ports COM1 to COM3, and the default
baud rate is 9600 bps. The baud rates for devices connected to the same RS485 port must be the
same.
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Set the protocol supported by the RS485 port based on either the protocol supported by the
connected device or the status of the device in the network. When the SmartLogger serves as a slave
node to interconnect with a third-party device over Modbus-RTU, set Protocol to Modbus-Slave.
When the connected SUN2000 performs rapid power grid scheduling using both PLC and RS485,
set Protocol to Modbus-Control.

Protocol, Parity, and Stop Bit must be set to the same values for all devices connected to the same
RS485 port.

1 < start address < end address < 247. The address segments for each RS485 port from RS485-1 to
RS485-3 can overlap.

Set the address range as required. A larger address range requires a longer searching time. The start
and end addresses have no impact on the devices that have been connected.

Night Comm. Settings: If you do not need to query device information at night, enable Night
silent.

Records: The SmartLogger can export RS485 communication packets.

7.10.2.3 Setting Power Meter Parameters

Because of permission restriction, log in as Advanced User or Special User. Choose
Settings > Power Meter to access the target page.

Figure 7-47 Setting power meter parameters

Power Meter Param. Settings(Modbus-RTU)

Intelligent Power Meter Type | ABB A44 v
Meter feedback output Enable
Voltage change ratio (1.0

Current change ratio  |1.0

Feedback GCP Param. Settings

No
No
No
No
No

Feedback Parameter Start Current (mA) End Current (mA) Start Data End Data
v 4.000 20.000 -2 0.000 0.000
v 4.000 20.000 0 0.000 0.000
v 4.000 20.000 - 0.000 0.000
v 4.000 20.000 0.000 0.000
v 4.000 20.000 0.000 0.000
=

®  When the model of the connected power meter is in the Intelligent Power Meter Type
drop-down list box, set the parameters as follows.

Parameter Description
Intelligent Power Meter Set this parameter to the corresponding meter model.
Type

Currently, the following meter models are supported: ABB
A44, Acrel PZ96L, algodue UPM209, CHNT DTSU666,
Elster A1800ALPHA, Janitza UMG103/UMG104/UMG604,
Lead LD-C83, MingHua CRDM-830, Mitsubishi
LMS-0441E, NARUN PD510, NetBiter CEWE, People
RMB858E, Schneider PM1200, SFERE PD194Z, Socomec
COUNTIS E43, and Toshiba S2MS.

Meter feedback output Set this parameter based on whether the power meter needs to

report the data of the grid-tied point.

Voltage change ratio e Set this parameter to 1 when the power meter uploads the
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Parameter

Description

Current change ratio

primary value.

e Set this parameter based on the actual transformer ratio
when the power meter uploads the secondary value.

Feedback Parameter

Set this parameter based on the parameter name to be
reported.

Start Current (mA)

End Current (mA)

Indicates the valid value range of signals carried by the
analog output loop. The current range is less than or equal to
the current range set in the AO specifications. Start Data
corresponds to End Data.

Start Data

End Data

Indicates the valid value range of signals of Feedback
Parameter. Set the two parameters as required. An excessive
range results in low precision of the feedback while an
insufficient range results in the incompleteness of the
feedback.

e |f the connected power meter is of another model, set the parameters as follows.

Parameter

Description

Intelligent Power Meter
Type

Set this parameter to Other.

Read function code

Read holding register 03H and Read input register 04H
are supported. Set this parameter based on the vendor's
protocol.

Read mode

Multiple read and Single read are supported.

Word ordering

Big endian and Little endian are supported. Set this
parameter based on the vendor's protocol.

Meter feedback output

Set this parameter based on whether the power meter needs to
report the data of the grid-tied point.

Voltage change ratio

Current change ratio

e Set this parameter to 1 when the power meter uploads the
primary value.

e Set this parameter based on the actual transformer ratio
when the power meter uploads the secondary value.

Signal

NOTE

Signal-related parameters
include Signal Name,
Signal address, Number of
Registers, Gain, Data Type,
and Unit.

Set this parameter based on the vendor's protocol.

NOTE

If the power meter can collect a certain signal, set Signal address to
the address of the corresponding register. If not, set Signal address to
65535.

Feedback Parameter

Set this parameter based on the parameter name to be
reported.

Start Current (mA)

Indicates the valid value range of signals carried by the
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Parameter Description

End C

analog output loop. The current range is less than or equal to
the current range set in the AO specifications. Start Data
corresponds to End Data.

urrent (mA)

Start Data Indicates the valid value range of signals of Feedback

Parameter. Set the two parameters as required. An excessive

End Data range results in low precision of the feedback while an

insufficient range results in the incompleteness of the
feedback.

7.10.2.4 Setting Management System Parameters

To set parameters correctly, ensure that the SmartLogger can connect to Huawei management
systems, such as NetEco and FusionSolar, or a third-party management system.

Because of permission restriction, log in as Advanced User. Choose Settings >

Manag

ement System to access the page.

Figure 7-48 Setting management system parameters

Manageme!

nt System
Server | ﬂ
Port number  |16100 (1~65535)
Address mode  Logical address ﬂ
S5L encryption  |Enable ﬂ
Secand challenge authentication  Disable v

=

¥ Security Certificate

[ no

TE
Set Server to the IP address or domain name of the management system server.

If the SmartLogger connects to the Huawei management system, retain the default value 16100 for
Port number. If it connects to a third-party management system, set Port number based on the
server port enabled in the third-party management system.

Generally, Address mode is set to Comm. Address. If the devices connected to the three RS485
ports on the SmartLogger have duplicate addresses, Address mode must be set to Logical address.

If SSL encryption is set to Disable, data will be transmitted without being encrypted, which may
result in user data theft. Therefore, exercise caution when deciding to set SSL encryption to
Disable.

If Second challenge authentication is set to Disable, the second challenge authentication result will
not be verified, which may result in user data theft. Therefore, exercise caution when deciding to set
Second challenge authentication to Disable.

Obtain the documents about security certificate from the management system.

7.10.2.5 Setting Modbus TCP Parameters

Set Modbus TCP parameters for the SmartLogger to communicate with a third-party NMS.

Because of permission restriction, log in as Advanced User or Special User Choose

Setting

s > Modbus TCP to access the target page.
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Figure 7-49 Setting Modbus TCP parameters

Modbus TCP

Link setting Enable(Limited)
Client 1 IP Address 0, 0,
Client 2 IP Address
Client 3 IP Address

Client 4 IP Address

o o o o
o

Client 5 IP Address

Address mode |Comm. Address

o
o| o| of o] ©
‘#Iiooooo{i

SmartLogger address |0

oo

LLl NnoTE

Modbus TCP is a general standard protocol without a security authentication mechanism. To reduce
network security risks, the function of connecting to a third-party NMS using Modbus TCP is
disabled by default. To use this function, set Link setting to Enable(Limited) or
Enable(Unlimited). If you select Enable(Limited), the SmartLogger can communicate with up to
five third-party NMSs whose IP addresses are set under Modbus TCP. If you select
Enable(Unlimited), the SmartLogger can communicate with all third-party NMSs with valid IP
addresses.

If the function of connecting to a third-party NMS using Modbus TCP is enabled, data will be
transmitted without being encrypted, which may result in user data theft. Therefore, exercise caution
when deciding to enable this function.

In most cases, set Address mode to Comm. Address. If the devices connected to the COM ports of
the SmartLogger have duplicate communications addresses, you must set Address mode to Logical
address.

7.10.2.6 Setting IEC103 Parameters

Third-party devices that use the IEC103 interface protocol may be connected to PV plants.
The SmartLogger can read the information about such third-party devices and upload the
information to the NMS, enhancing the PV plant solution.

As Huawei inverter devices (such as SUN2000s) support protocols different from third-party
devices that use standard IEC103 (such as box-type transformers, combiner boxes, and
inverters), they cannot be connected in series on the same RS485 bus.

Mode for the SmartLogger to connect to the IEC103 device: When the SmartLogger connects
to the NMS, it transparently transmits IEC103 device information to the NMS.

Because of permission restriction, log in as Advanced User. Choose Settings > IEC103 to
access the target page.
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Figure 7-50 Setting IEC103 parameters

IEC103
[EC103 portNo.  [No [=]
IEC103 address 126 (1-255)

IEC103 IP 0, 0, 0, 0O

=

(L] noTE

e Third-party devices and Huawei devices must be connected to different ports of the SmartLogger.
Otherwise, the communication will be abnormal.

e The value of IEC103 IP must be consistent with the IP address of the NMS.

7.10.2.7 Setting IEC104 Parameters

IEC104 is a general standard protocol without a security authentication mechanism. To reduce
network security risks, connection to a third-party NMS over the IEC104 protocol is disabled
by default. The SmartLogger can connect to a maximum of five third-party NMSs.

If the SmartLogger connects to a third-party NMS over the IEC104 protocol, IEC104
parameters must be correctly set to enable the third-party NMS to monitor the running status
of devices connected to the SmartLogger.

Because of permission restriction, log in as Advanced User. Choose Settings > IEC104 to
access the target page.

Figure 7-51 Setting IEC104 parameters

¥ Basic Parameters 1EC104-1 1EC104-2 1EC104-3 IEC104-4 1EC104-5
IEC104 Parameter Settings
Link setting  |Enable(Limited) ~
Public IP address |1 ‘(1—65554

=3

L] noTE

e When IEC104 data point tables that require forwarding are different, set Link setting to
Enable(Limited). Set the data point tables to be forwarded in IEC104-1-1EC104-5 tabs.
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When IEC104 data point tables that require forwarding are the same, set Link setting to
Enable(Unlimited). Set the data point tables to be forwarded in Basic Parameters tab.

You can export an IEC104 configuration file in CSV format.

After the IEC104 configuration file exported from the SmartLogger and the device type IEC104
information files delivered with devices are correctly configured on a third-party NMS, the
third-party NMS will be able to monitor the devices connected to the SmartLogger over the IEC104
protocol.

7.10.3 Extended Parameters
7.10.3.1 Setting FTP Parameters

The FTP function is used to access a third-party NMS. The SmartLogger can report the

configu

ration information and running data of the managed plant system through the FTP. A

third-party NMS can access Huawei devices with proper configurations.

Because of permission restriction, log in as Advanced User. Choose Settings > FTP to

access t

he target page.

Figure 7-52 Setting FTP parameters

Basic parameters

FTP server ‘ ‘

User name

Password

Remote directory ‘

Report Settings

Latest Report Status

([ no

Data export  Disable ﬂ

File format  |Format 1 ﬂ

File name minYYMMDD.csv ﬂ

Time format  Y¥-MM-DD v
Export mode | Cyclic ﬂ

Export interval |30 ‘ min (5~1440)
File mode  |Accumulated data ﬂ
Status  Success
Last transmission  2000-01-01 00:00:00

TE

FTP server can be set to the domain name or IP address of the FTP server. If FTP server is set to
the domain name of the FTP server, ensure that the address of the DNS server on the Ethernet page
is set correctly.

User name and Password indicate the user name and password that need to be entered when you
log in to the FTP server.

After setting Remote directory, you can create a subdirectory in the default data upload directory
(specified by the FTP server).

If Data export is set to Enable, you can set the SmartLogger to report data regularly or at a
specified time. If you set the SmartLogger to report data regularly, you can choose whether to report
all data or only the incremental data of a day each time.

In FTP file format, Format 2 has two more information points than Format 1: E-Day (current-day
energy yield) and E-Total (total energy yield). Format 3 has more information points than the other
two format files: multimeter, PID module, user-defined device, and SmartLogger data.

The displayed formats of the file name and time can be set in File Name and Time format. Y, M, D,
H, and m represent the year, month, day, hour (24-hour system), and minute respectively.
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Table 7-11 Troubleshooting

Error Code Troubleshooting Suggestion | Error Code Troubleshooting Suggestion
0x1002 No FTP server address is 0x1003 1. Check whether the DNS
configured. Configure the server address is correct.
address correctly. 2. Check whether the domain
name of the third-party FTP
server is correct.
0x1004 No TP user name is configured. | 0x1005 No FTP user password.
Configure the user name Configure the user password
correctly. correctly.
0x3001 1. Check whether the FTP 0x3002 1. Check whether the user name
server address is correct. of the FTP server account is
2. Check whether the correct.
third-party FTP server is 2. Check whether the user
working properly. password is correct.
0x3007 Check whether data is allowed 0x3008 Check whether there is a
to be uploaded through a client SmartLogger data upload
to the third-party FTP server. directory on the third-party FTP
server.
Other error codes | Provide SmartLogger run logs - -
and contact Huawei technical
support.

7.10.3.2 Setting Email Parameters

The SmartLogger can send emails to inform users of the energy yield, alarm, and equipment
status information of the PV plant system, helping users to know the running conditions of the
PV plant system in time.

When using this function, ensure that the SmartLogger can be connected to the configured
email server and that the Ethernet parameters and email parameters for the SmartLogger are
correctly set. Ensure that no password is set between the SmartLogger and the email server.

Because of permission restriction, log in as Advanced User. Choose Settings > Email to
access the target page.
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Figure 7-53 Setting email parameters

Basic parameters

Yield

Alarms

SMTP server

Encryption mode | No encryption D
SMTP port 25 (1~65535)
User name
Password
Email language | English E
Send address
Receive address 1
Receive address 2
Receive address 3
Receive address 4 1
Receive address 5 1
Send Email | Disable [+]
Senton schedule  |22:00 (HH:MM)

Latest Report Status

Send Email | Disable [+]
Alarm level Major D
Transfer status ~ Success
Last transmission ~ 2000-01-01 00:00:00
Send test mail -

[[Ino

Table 7-12 Troubleshooting

TE

SMTP Server can be set to the domain name or IP address of the SMTP server.

If it is set to the domain name of the SMTP server, ensure that the address of the DNS server is set
correctly.

Encryption mode: Set the encryption mode supported by mailboxes. Encryption is supported by
most of the mainstream mailboxes such as Outlook, @qg.com, @126.com, @163.com, and
@sina.com.

SMTP Port specifies the port used for sending emails.

User name and Password specify the user name and password used for logging in to the SMTP
server.

Send address specifies the sender's email address. Ensure that the sender's email server is the same
as the server specified by SMTP server.

You can click Send test mail to check whether the SmartLogger can successfully send emails to
users.

Error Code Troubleshooting Suggestion Error Code Troubleshooting Suggestion

0x2002 1. Check whether the DNS server | 0x2003 1. Try again later.

address is correct.

2. Check whether the domain
name or IP address of the
SMTP server are correct.

3. Check whether the network
communication between the
SmartLogger and DNS is
normal.

2. Check whether the domain name
or IP address of the SMTP
server are correct.
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Error Code Troubleshooting Suggestion Error Code Troubleshooting Suggestion
0x200b 1. Check whether the DNS server | 0x4016 1. Try again later.
address is correct. 2. Check whether the DNS server
2. Check whether the domain address is correct.
name or IP address of the 3. Check whether the domain name
SMTP server are correct. or IP address of the SMTP
3. Check whether the network server are correct.
communication between the
SmartLogger and DNS is
normal.
0x406e Confirm the encryption mode and | 0x8217 1. Check whether the user name
port supported by the mailbox, and and password are correct.
check whether they are correctly 2. Log in to the mailbox of the
configured. email sender and start the SMTP
service.

3. Log in to the mailbox of the
email sender and start the
third-party client license code
function.

0xa003 Check whether the domain name 0xa005 Check whether the user name is
or IP address of the SMTP server correct.
are correct.

0xa006 Check whether the user password | 0xe002 No domain name or IP address is
is correct. configured for the SMTP server.

Configure the domain name and IP

correctly.

0xe003 Configure the addresses for Other error Provide SmartLogger run logs and
sending and receiving emails codes contact Huawei technical support.
correctly.
7.10.4 Port Settings

7.10.4.1 Setting DO Parameters

The SmartLogger provides three DO ports, which support external router reset and the audible

and visual alarm for grounding faults.

Connecting a 3G Router over the DO Port

Considering the restrictions on the current that can pass through the DO port of the

SmartLogger, you need to determine the number of DO ports to be used for the control based
on the maximum power supply current of the 3G router (the maximum power supply current
can be calculated based on the maximum power consumption and DC power supply voltage).

®  When the power supply current is smaller than 1 A, use one DO port.
®  When the power supply current is larger than 1 A but smaller than 1.6 A, use two DO

ports.
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®  When the power supply current is larger than 1.6 A but smaller than 2.4 A, use three DO
ports.

e When the power supply current is larger than 2.4 A, access is not allowed because the
current exceeds the upper limit.

Connect one DC power cable of the 3G router to one of the DO ports, power on or off the
wireless module by connecting or disconnecting the DO dry contact to control the reset of the
3G router.

Figure 7-54 Connecting one DO port

AC Input

| |

Adapter 3G Router
DC Power Cable

ILO1IC3007

Figure 7-55 Connecting two DO ports

AC Input
| |

Adapter 3G Router
DC Power Cable

ILO1IC3008
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Figure 7-56 Connecting three DO ports

AC Input
[ |

Adapter 3G Router
DC Power Cable

ILO1IC3009

Log in as Advanced User. Choose Settings > DO, and set the corresponding DO port to
Reset the external router.

Figure 7-57 DO configuration

DO Configuration
DO1  |Reset the external router
DO2  |No control

DO3 No control

Connecting the Horn Strobe over the DO Port

Connect one DC power cable of the horn strobe to one of the DO ports, and power on or off
the horn strobe by connecting or disconnecting the DO dry contact to achieve the audible and
visual alarm for grounding faults.

Log in as Advanced User. Choose Settings > DO, and set the corresponding DO port to
Ground fault audit and vis alm.

Figure 7-58 DO Configuration

DO Configuration
DO1 Ground fault audi and vis alm v
DO2 No control

DO3 No control

7.10.4.2 Setting USB Parameters

This topic describes how to set USB parameters for resetting an external 3G router over the
WebUI.
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Context

The SmartLogger provides a USB port, which has a power capacity of 5 V/1 A. If the DC
power cable of the 3G router has a standard USB connector and has a maximum current of
less than 1 A, it can directly connect to the USB port on the SmartLogger. Hence the
SmartLogger can power on or off the 3G router, which allows the SmartLogger to control the
reset of the 3G router when the communication link is interrupted.

NOTICE

e Only the SmartLoggers in versions later than V100R001C90SPC300 enjoy this function.

e |f the maximum working current of the 3G router is greater than 1 A, it cannot be
connected over a USB port.

Connecting a 3G Router over a USB

Connect the USB connector of the DC power cable of the 3G router to the USB port on the
SmartLogger, as shown in Figure 7-59.

Figure 7-59 Connecting the 3G router and the SmartLogger

3G Router

ILO1IC3011

USB configuration

After connecting the 3G router to the SmartLogger properly, you can set USB parameters over
the WebUI to make the external 3G router automatically reset if the SmartLogger fails to
connect to the management system, email server, or FTP server within 30 minutes.

Because of permission restriction, log in as Advanced User. Then choose Settings > USB.
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Figure 7-60 USB configuration

USB configuration

USB No control M

7.10.5 Alarm Output

After an inverter alarm is linked to a DO port, the alarm signal is delivered from the DO port
when the inverter generates the alarm.

Because of permission restriction, log in as Advanced User. Choose Settings > Alarm
Output.

L] noTE
[ ]

Before linking an inverter alarm to a DO port, ensure that the DO port is not set for other purposes.
Otherwise, the setting will fail.

e After the function is enabled, the DO port status may change and the alarm output may be abnormal
if the SmartLogger restarts or powers off.
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Figure 7-61 Alarm output

DO Configuration

DO1 alarm status | Close

DO2 alarm status | Close

EEE]

DO3 alarm status | Close
Alarm Name DOl Do2
High String Voltage
Abnormal DC Circuit
Abnormal Invert Circuit
Abnormal Grid Voltage
Abnormal Grid Frequency
Low Insulation Resistance
Abnormal Residual Current
Cabinet Overtemperature
Abnormal SPI Communication
Abnormal Grounding
System Fault
Abnormal Auxiliary Power
AFCI Self-Check Failure
DC Arc Fault
Abnormal PV String Connection

Crfhuara arcinn | lnmateh

Table 7-13 Mapping between alarm names and inverter alarms

DO3

No. Alarm Name Inverter Alarm | No. Alarm Name Inverter Alarm

1 High String e High String 2 Abnormal DC Circuit Abnormal DC Circuit
Voltage Voltage

¢ High DC Input
Voltage

3 Abnormal Invert | Abnormal Inv. 4 Abnormal Grid Voltage | Abnormal Grid Voltage
Circuit Circuit

5 Abnormal Grid Abnormal Grid 6 Low Insulation Low Insulation
Frequency Freq. Resistance Resistance

7 Abnormal Abnormal 8 Cabinet Overtemperature
Residual Current | Residual Current Overtemperature

9 Abnormal SPI Abnormal SPI 10 Abnormal Grounding Abnormal Grounding
Communication Communication

11 System Fault System Fault 12 Abnormal Auxiliary Abn. Auxiliary Power

Power

13 AFCI Self-Check | AFCI Self-Check | 14 DC Arc Fault DC Arc Fault
Failure Failure

15 Abnormal PV Abnormal PV 16 Software Version Software Ver. Unmatch
String Connection | String Connection Unmatch

17 Upgrade Failed Upgrade Failed 18 License Expired License Expired
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No. Alarm Name Inverter Alarm | No. Alarm Name Inverter Alarm
19 String Reverse e String 20 String Backfeed e String Backfeed
Connection Reversed e String 1-8 Reversed
e String 1-8
Reversed
21 Abnormal String | ® Abnormal 22 Phase Wire Phase Wire
Power String Power Short-Circuited to PE Short-Circuited to PE
e Abnormal
String 1-8
23 Grid Loss Grid Failure 24 Grid Undervoltage Grid Undervoltage
25 Grid Overvoltage | Grid Overvoltage | 26 Grid Voltage Imbalance | Grid VVoltage Imbalance
27 Grid Grid 28 Grid Underfrequency Grid Underfrequency
Overfrequency Overfrequency
29 Unstable Grid Unstable Grid 30 Output Overcurrent Output Overcurrent
Frequency Frequency
31 Output DC Output DC 32 Device Fault Device Fault
Component Component
Overhigh Overhigh
33 Faulty Power Faulty Power 34 Abnormal Battery Abnormal Battery
Collector Collector
35 Faulty Monitoring | ® Monitoring 36 Active Islanding Active Islanding
Unit Unit Faulty
* Flash Fault
37 Passive Islanding | Passive Islanding | 38 Transient AC Transient AC

Overvoltage

Overvoltage

7.10.6 Dry contact remote shutdown

You can remotely shut down dry contacts on the WebUI.

The SmartLogger provides eight DI ports, that is, DI1 (GND1) to DI4 (GND1) and DI1
(GND2) to DI4 (GND2). The OVGR can be connected to any DI port, as shown in Figure

7-62.
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Figure 7-62 Networking

e SmartLogger | D

Dry Contact Signal

—{AC Combiner Box 1}—

OVGR

—{AC Combiner Box 2|l

(O—

Cubicle

— Grid

—{AC Combiner Box n}—

Inverter n

!

Figure 7-63 shows the DI ports of the SmartLogger.

Figure 7-63 DI ports of the SmartLogger

ILO1WC0008

Table 7-14 describes the DI ports.

Table 7-14 DI port description

ILO1IC3020

Port Functions

GND1

Dry contact input common terminal 1, used for active
power derating for DI1-Dl14

DI_1

DI_2

DI_3

AW IN]| P

DI_4
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Port Functions
GND2 Dry contact input common terminal 2, used for reactive
power compensation for DI1-DI14

Before

setting the function of remote shutdown over dry contacts in the following method,

ensure that Dry contact remote control is not set in 8 Power Grid Scheduling.

On the

Settings tab page, select Dry Contact Remote Shut and set relevant parameters, as

shown in Figure 7-64. Because of permission restriction, log in as Special User.

Figure

7-64 Dry contact remote shutdown

Dry Contact Remote Shutdown

connection port None M
Effective dry contact status  Open -
OVGR Shutdown Setting Disable e

Cubicle alarm enabling  Disable -

[ no

TE

The OVGR sends dry contact signals and can be connected to any DI port of the SmartLogger. Set
related parameters based on the actual connection between the OVGR and the SmartLogger.
Otherwise, the dry contact remote shutdown function cannot be implemented.

Set Connection port based on the actual connection between the OVGR and the SmartLogger.

Effective dry contact status can be set to Close or Open. If OVGR Shutdown Setting is set to
Enable and Effective dry contact status is set to Close, the SmartLogger sends the inverter remote
shutdown command only when the DI port specified by connection port is closed.

OVGR Shutdown Setting can be set to Enable or Disable. Set OVGR Shutdown Setting as
required.

Cubicle alarm enabling can be set to Enable or Disable. If Cubicle alarm enabling is set to
Enable, if the dry contact signal is effective and the Cubicle is abnormal, an alarm indicating
abnormal Cubicle is generated.
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7.10.7 Setting DI Parameters

You can set parameters for DI ports over the WebUI.

e When avalid level is delivered into a DI port, an alarm is generated. You can set the
alarm name and severity.

e A DI port shuts down the inverter using OVGR signals.

The SmartLogger provides eight DI ports, that is, DI1 (GND1) to DI4 (GND1) and DI1
(GND2) to DI4 (GND2). For the connection method, see 4.10 Connecting the SmartLogger to
a Ripple Control Receiver.

Because of permission restriction, log in as Special User. Choose Settings > DI to access the
target page.

Figure 7-65 Setting DI parameters

DI Port Configuration

ol Activation Status Dry Contact Status Alarm Generation Alarm Severity Trigger Shutdown Trigger Startup Alarm Name
DIL(GND1) Disable M Open v Disable v Major v Disable l Disable

DI2(GND1) Disable M Open M Disable v Major v Disable M Disable

DI3(GND1) Disable v Open v Disable v Major v Disable v Disable

DI4(GND1) Disable v Open v Disable v Major v Disable ¥ Disable

DILGND2) Disable v Open v Disable N Major v Disable v Disable

DI2(GND2) Disable M Open v Disable " Major M Disable v Disable

DI3(GND2) Disable v Open v Disable v Major v Disable v Disable

DI4(GND2) Disable v Open v Disable v Major v Disable v Disable

[ |
Startup Delay
Startup delay 300

e To enable the DI port function, set Activation Status to Activated, and set Alarm
Generation, Trigger Shutdown, Trigger Startup to Enable.

®  When Dry Contact Status is set to Close, the SmartLogger sends a shutdown or alarm
command to the inverter if the external input dry contact is closed. It sends a start
command to the inverter if the external input dry contact is open.

®  When Dry Contact Status is set to Open, the SmartLogger sends a shutdown or alarm
command to the inverter if the external input dry contact is open. It sends a start
command to the inverter if the external input dry contact is closed.

e  Startup delay: specifies the time for the SmartLogger to send a start command to the
inverter.

[l noTE

When using multiple DI ports, ensure that the shutdown signal of each port and OVGR shutdown in
7.10.6 Dry contact remote shutdown have recovered. The SmartLogger then sends a start command to
the inverter.

Alarm Name is set to DI X (GND X) custom alarm by default on the SmartLogger WebUI and LCD,
which can be changed by the user. If Alarm Name has been changed by the user, the new name is
displayed on the WebUI but the default name is displayed on the LCD.
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7.10.8 Setting Export Limitation Parameters

Network Application

When the PV plant itself generates power for private use only, the loads cannot consume all
the power and countercurrent may feed into the power grid. Therefore, users need to set the
export limitation parameters over the WebUI to prevent countercurrent.

e  Scenario without a circuit breaker: The countercurrent feeding into the power grid can be
eliminated by sending a command from the SmartLogger to lower the inverter output
power.

e  Scenario with a circuit breaker: When the countercurrent feeding into the power grid
cannot be eliminated by sending a command from the SmartLogger to lower the inverter
output power, and the Maximum protection time is exceeded, the SmartLogger drives
the relay to switch off the circuit breaker by controlling the DO port. When the DI port
detects that the circuit breaker is open, the DO port and relay on the SmartLogger will be
switched off, and the SmartLogger will restore to the initial state.

Figure 7-66 Network diagram (without a circuit breaker)

SmartLogger — RS485
— Power cable

B oY

PV module Inverter Power grid
E meter
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Figure 7-67 Network diagram (with a circuit breaker)

Relay SmartLogger — RS485

— DO signal cable
” DO — Power cable

— DO power cable

DI — DI
On/Off
M n] o )
= (=)
o _— :\IE—EO W
PV module |nverter Circuit Power b wer grid
breaker meter
Load

NOTICE

In the scenario with circuit breaker, put the power supply position of the SmartLogger before
the circuit breaker to avoid the SmartLogger power-off after the DO control circuit breaker is
switched off.

Setting Parameters

Before setting the parameters, ensure that the Modbus power meter and inverter are connected
to the WebUI. Then take the following steps to complete the settings.

1. Log inas Advance User, choose Monitoring > SUN2000 > Running Param. >
Feature Parameters, and set the following parameters.

Parameter Description Recommended Value
Communication The standards of certain countries | Enable
interrupt shutdown and regions require that the

inverter must shut down after the
communication is interrupted for a

certain time.
Communication If this parameter is enabled, the Enable
resumed startup inverter automatically starts after

communication recovers. If this
parameter is disabled, the inverter
needs to be started manually after
communication recovers.

Communication Specifies the duration for 1
interruption duration | determining communication
interruption, and is used for
automatic shutdown for protection
in case of communication
interruption.
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gradually increase when the
inverter restarts after the power
grid recovers.

7 WebUI
Parameter Description Recommended Value
Soft start time Specifies the duration for the 20
power to gradually increase when
the inverter starts.
Soft start time after Specifies the time for the power to | 20

2. Log in as Special User, choose Monitoring > SUN2000 > Running Param. >
Adjustment, and set the following parameters.

gradient

Active power change

inverter active power.

Parameter Description Recommended Value
Plant active power Adjusts the rate of active power 0
gradient rise due to light changes.

Adjusts the change speed of the 125%/s

If the maximum value is
50%/s, set this parameter to
50%o/s.

3. Log inas Special User and choose Settings > Active power control. Ensure that Active
power control is set to Disable.

4. Log inas Special User and choose Settings > Export Limitation.

Figure 7-68 Setting Export Limitation Parameters

Export Limitation

Common Parameters

Extended Parameters

Circuit breaker operation

Export Limitation Enable
Control policy Strategy 1

Status Norma

Power Meter | No

Electric meter power direction | Positive
Load | Load Balance
Maximum grid feed-in power  |0.000
Power lowering adjustment period 0.5

Maximum protection time 3.0

Power raising threshold  5.000

Power limit for abnormal electric meter 100.0
Switch-off with 0% power limit Disable
Switch-off control port No
Switch-on control port No
Switch-off state feedback port | No

Switch-on state feedback port No

[ o | wcnon

oW
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Parameter

Description

Power Meter

If Export Limitation is set to Enable, set Power Meter to Smart
meter. Otherwise the function would not take effect.

Electric meter
power direction

When the inverter has no output power, set this parameter to positive
if the active power reading of the power meter is positive. Otherwise,
set this parameter to reverse.

Load

* Load Balance: backflow prevention for the total power of the
grid-tied point

® Load Imbalance: backflow prevention for each phase of the
grid-tied point

Maximum grid
feed-in power

Setting the maximum power that the inverter can feed into the power
grid.

Suggestion: Set this parameter based on the countercurrent threshold
allowed by the power grid company.

Power lowering
adjustment period

Setting the inverter output power lowering period.

Maximum
protection time

Setting the maximum duration from the time the SmartLogger
detects countercurrent to the time it controls the inverter output
power to reach 0.

Suggestion: Set this parameter based on the maximum
countercurrent duration allowed by the power grid company.

Power raising
threshold

Setting the inverter output power raising threshold.

Power limit for
abnormal electric
meter

Setting the inverter output power percentage controlled by the
SmartLogger when communication between the SmartLogger and
the power meter is abnormal.

Switch-off with 0%
power limit

Setting whether to switch off the DO port.

When this parameter is set to Enable, the settings of the Switch-off
control port, Switch-on control port, Switch-off state feedback
port, and Switch-on state feedback port are also enabled.

7.11 Maintenance

7.11.1 Upgrading Firmware

You can upgrade the firmware of the SmartLogger, inverter, SmartMBUS, or PID module

over the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Firmware Upgrade to access the target page.

1. Upload the upgrade file of the device to be upgraded. The upgrade file automatically
matches the device name and selects all devices of this type.
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2. (Optional) If you do not need to upgrade a device, clear the device.

(1] noTE

For the patch version earlier than the SUN2000 V100R001C11SPC409, SUN2000
V100R001C81SPC101, or SUN2000 VV200R001CO00, only one inverter can be upgraded. After the
upgrade file is uploaded, select only one inverter for upgrade and clear other inverters.

3. Click Upgrade.

Figure 7-69 Upgrading firmware

Firmware Upgrade

Select an upgrade file:

L No. Device Device status
OJ 1 Logger(Local) v
] 2 33KTL(COM3-1)
OJ 3 33KTL(COM3-3)
O - 33KTL(COM3-4)
O 5 33KTL(COM3-5)
<

[l noTE

The Stop Upgrade function is only effective for the devices waiting to be upgraded.

7.11.2 Product Information

Choose Maintenance > Product Information and query SmartLogger information on the
displayed page.

Curr. ver.

V100R001CC
V300R001CC
V300R001CC
V300R001CC
V300R001CC
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Figure 7-70 Product information

Product Information

SN
2102310PQW10EB000368

Device Type

SmartLogger1000

Firmware Version

V100R001CO0SPC118

7.11.3 Setting Security Parameters

Choose Maintenance > Security Settings to access the target page.

Figure 7-71 Setting security parameters

User Name Device status
Special User Online
Automatic logout time
Automatic logout time | Never v
Network Security Certificate
Select a certificate format CRT format ¥

Please select a security certificate choose file] security c..ificate.crt

Select the network security certificate key to be uploaded  |choose file| network s...te key.crt

Enable key password

[iomi |
Update Key
Copdae |
WEB TLS1.0 Setting
TLS1.0 enable Enable ¥ | (The WebUI will restart after the setting is modified. Enabling this item will pose security risks.)
Somi |
Digital Signature Verification
Digital signature verification for upgrade package | Disable v
=3

L1l noTE

e The initial password is Changeme for system users Common User, Advanced User, and Special
User.

e Use the initial password upon first power-on and change it immediately after login. To ensure
account security, change the password periodically and keep the new password in mind. Not
changing the initial password may cause password disclosure. A password left unchanged for a long
period of time may be stolen or cracked. If a password is lost, devices cannot be accessed. In these
cases, the user is liable for any loss caused to the PV plant.

e You are advised to change the password at least once every half a year to prevent unauthorized use
of your account and impact on system security.
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e After Automatic logout time is set, a user is automatically logged out if the user does not perform
any operation within the specified time period.

e You are advised to use the existing network security certificate and key.
Change the password in compliance with the following rules:

e  Containing 6 to 20 characters
e  Acombination of at least two types of digits, uppercase letters, and lowercase letters
e  Different from the old password

7.11.4 System Maintenance

Because of the permission restriction, log in as Advanced User or Special User. Choose
Maintenance > System Maint..

Figure 7-72 System maintenance

System Maintenance

Reset System

Full profile export

e T

Full profile import

7.11.5 Device Log

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Device Log to access the target page.

Figure 7-73 Device log

Device Log

Select

F4
e

Device SN Device status Prog E ion Statu

Logger(Local) 2102311RTD10GB0O00014 @

00000000
| N o R W N =

MBUS-inside
40KTL(COM3-3)
B6KTL-MO(COM6-10)
12KTL-MO(COM®6-11)
40KTL(COM6-12)
TOOKTL(COM®B-13)
B60KTL-MO(COMG-14)

Export Log Stop Export Log archiving

7.11.6 Site Test

PLC002311RTDGB0O00014
210107250110E6000015
21010743150123456789
21010743060123456780
210107296610F8000016
21010741816THC00004
671899025042

&

After a inverter is put into use, it should be inspected periodically to detect any potential risks

and problems. The SmartLogger can inspect inverters over the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Onsite Test to access the target page.
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Figure 7-74 Site test

MTERTEI spot-check

@ Single Inspection ) Batch Inspection

: 0

] F ion failure: 0

20KTL(COM1-1)
40KTLICOM1-2)
28KTL(COM1-3)
SOKTL(COM1-4)
40KTL-JP(COM1-5)

40KTL-US{COM1-6)

[ i i i I
e R =) B ¥ B - R S N

60KTL(COM1-7)

<

Start Inspection

L1l noTE

No. Device SN

INV_2000V1R1C00_0001
INV_2000V2R1C00_0002
INV_2000V1R1C81_0003
INV_2000V2R2C00_0004
INV_2000V2R2C01_0005
INV_2000V2R2C20_0006

INV_20HAV1R1C00_0007

n

Devices Status Progress

@

@

®

¢ ® ¢ ¢

Execution Status Start time

Log archiving

e The spot-check function is available only for the inverter for which Grid Code is set to Japan

standard.

e You can click the Select icon in the upper left corner of the page to select an inspection mode.

7.11.7 Managing the License

You can view the inverter license information and manage the license on the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > License Management.

®  To view the inverter license information, tap License information.

e To apply for a license, tap License application and export a license application file, as
shown in Figure 7-75.

e To load the obtained license to the inverter, tap License loading, as shown in Figure

7-76.

®  To revoke the license or export the revocation code file, tap License revocation.
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Figure 7-75 Applying for a license

( License loading  License revocation

) License information @ License application

Total Device Qty.: 1
] No. Device Device status License Status SN Rated Power(kW)
B 1 33KTL(COM3-4) Normal 2101073021ESEC000075 30 o

Export License Appli File

For the inverter with no license, you can export the application file and apply for a license on

the Electronic Software Delivery Platform (ESDP).

Figure 7-76 Loading a license

7 License information ) License application @ License loading C License revocation
Total Device Qty.: 1 File Status @ To be loaded : 0 No file: 0 @ Lloaded:1
a No. Device Device status License Status File Status Loading Progress License loadin
= 1 33KTL(COM3-4) Normal @ 2017-06-12 °
< m ',
Stop Loading License
To load a license to the inverter, perform the following steps:
1. Import the license file.
2.  Select the inverter whose File Status is To be loaded.
3. Load the license.
245
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L] NnoTE

Ensure that the extension of the license file to be imported is .dat or .zip.
7.11.8 Device Management

7.11.8.1 Connecting Devices

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Connect Device to access the target page.

Figure 7-77 Connecting devices

Total Device Qty.:8 0 o o
Connect Device
Device disconnection time 5 min(5-30
No. Device Port-Comm Addr./IP address SN Devices Status
1 Meter(COM3-1) 3-1 AM1V20064900hwappyan @
2 PID{COM3-2) 3-2 SQUTH_DEVICE_PID_002 @
3 2B8KTL(COM3-3) 3-3 INV_2000V1R1C81_0003 @
4 40KTL(COM3-4) 3-4 INV_2000V2R1C00_0004 @
5 SOKTL(COM3-5) 3-5 INV_2000V2R2C00_0005 @
6 40KTL-JP(COM3-6) 3-6 INV_2000V2R2C01_0006 @
7 EMI(COM3-7) 3-7 EM1V20064900hwappyan @
8 PLC(COM3-249) 3-249 SOUTH_DEVICE_PLC_249 @

Auto. Search Add Devices Auto Assign Address Import Config. Export Config

(L noTE
e Huawei devices can be automatically detected or manually added. The EMI, power meter, slave
SmartLogger, and third-party devices cannot be automatically detected. You need to add them
manually.

e Before manually adding an EMI connected over the COM port, set RS485 parameters correctly by
following the instructions in 7.10.2.2 Setting RS485 Parameters. When adding an EMI, set Device
Type to EMI. After adding an EMI manually, correctly set the EMI parameters. For details, see
7.8.4.2 Setting EMI Parameters.

e Before manually adding the Modbus or DL/T645 power meter, set RS485 parameters correctly by
following the instructions in 7.10.2.2 Setting RS485 Parameters. Before manually adding the
Modbus power meter, correctly set the power meter parameters. For details, see 7.10.2.3 Setting
Power Meter Parameters. When adding a power meter, set Device Type to Power Meter and
Comm.protocal to the protocol supported by the power meter.

e When manually adding a slave SmartLogger, correctly set Modbus TCP parameters. Set Link
setting to Enable, and set the client IP address to the IP address for the slave SmartLogger. For
details, see 7.10.2.5 Setting Modbus TCP Parameters. When adding a slave SmartLogger, set Device
Type to SmartLogger and set IP Address to the IP address of the slave SmartLogger.

e When connecting a third-party device, you need to import a configuration file for the device and
then manually add the device.

e An accessed device can be removed manually, and a removed device can be added again.
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e Auto Assign Address allows you to adjust device addresses based on serial numbers. If a device
cannot access due to address conflict, perform this operation to assign a new device address and then
access the device.

e After a device is connected, you can export the configurations for the device. If you need to change
the name of the exported file, retain the extension .cfg. Otherwise, the file will be unavailable.

e You can click the Start, Stop, or Reset icon to send the corresponding command to all SUN2000s
connected to the SmartLogger.

7.11.8.2 Device List

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Device list to access the target page.

Figure 7-78 Device list

Total Device Qty.:12

O No. Device port Comm Address * Logical addr. Transformer No. Winding No.

[ MBUS 249 14 [110 E |

o : ; [ T |
IEIE ‘ 1

0o ‘ 2

o s ‘ : i I |

0 s 6 s o b |

<

Modify Device Info Import Device Info Export Device Info

L1l noTE

You can modify the device name and address on the WebUI, or export a device information file in CSV
format and import the CSV file into the WebUI after modification.

7.11.8.3 Exporting Parameters

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Export Param. to access the target page.
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Figure 7-79 Exporting data

Total Device Qty.:1
S SUN2000
O No. Device SN Device status
O

1 A40KTL(COM1-1) INVSUN2000V2R1C00001

Log archiving

[l noTE

You can export configuration parameters of multiple inverters to a .csv file. Site engineers can then
check whether the inverter configurations are correct in the exported file.

7.11.8.4 Clearing Alarms

If you need to clear the active and historical alarms of certain or all devices connecting to the
SmartLogger, and re-collect alarm data, perform this operation.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Clear Alarm to access the target page.
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Figure 7-80 Clearing alarms

Total Device Qty.:2

All No. Device SN
1 Logger({Local) 2102311RTD10GB000012

2 BOKTL(PLC-1) 21010735286TGBI00003

=3

Device status
@

@

e By clearing alarms, users can clear all active and historical alarms for the selected device

and enable the SmartLogger to re-collect alarm data.

e By clearing alarms, users can clear the local SmartLogger alarms or device storage alarms.
If the version of the SUN2000-(8KTL-28KTL) is earlier than SUN2000 VV100R001C81,
users can only clear local SmartLogger alarms by performing the operation.

e |f Clear Alarm is performed for the Huawei devices such as the inverter and PID, Alarm
Reset must be performed on the NMS. Otherwise the SmartLogger cannot collect alarm

data from the devices after alarms are cleared.

e [f Clear Alarm is performed for the SmartLogger, Alarm Reset must be performed on the
NMS. Otherwise the SmartLogger cannot collect alarm data from the devices after Alarm

Reset is performed.

7.11.8.5 Data Recollection

Users can recollect previous performance data and energy yield over the WebUI. The

recollection results can be queried on the Monitoring page.

L1l noTE

e This function is not supported by the SUN2000-(8KTL-28KTL).

e When you perform data recollection and query the performance data of the inverter after the
SUN2000-33KTL/40KTL software is upgrades from SUN2000 V200R001CO0SPCXXX to
SUN2000 V200R001C90SPCXXX, the current-day energy yield generated before the upgrade

cannot be queried.

Because of permission restriction, log in as Advanced User or Special User. Choose

Maintenance > Data Re-collection to access the page.

1. Select the data recollection type and the corresponding recollection period.

2. Select the inverter whose data needs to be recollected.
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3. Click Collect Data.

Click different tabs to view the data recollection progress and status. Data is recollected
in the sequence of performance data, daily energy yield, monthly energy yield, and
annual energy yield.

Figure 7-81 Data recollection

[ Performance Data |1 ﬂDay LJE-Daily 1 ﬂDay [JE-Month 1 ﬂMomh [JE-Year|1 ¥|Year

E-Daily ' E-Month ' E-Year

Llan No. Device SN Device status Progress Execution Status

O 1 33KTL(COM3-11) 210107296710U6000988 @

Collect Data Stop Resampling

7.11.8.6 Correcting the Total Energy Yield

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Adjust total energy yield to access the target page.

Figure 7-82 Correcting the total energy yield

Total Device Qty.:1

[JAI Ne. Device Device status E-Total(kWh) Adjust total energy yield(kWh)

O 1 36KTLICOMO-2) 2256.10 (0-42949500)

=3
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Power Grid Scheduling

8.1 Power Adjustment Description

According to standard requirements, the SmartLogger can reliably adjust power for the
connected inverters in real time to ensure that the PV plant can respond to requirements of the
power grid company in a timely manner.

Two power grid scheduling modes are available: active power control and reactive power
control.

NOTICE

To ensure that the SmartLogger will deliver scheduling commands to the connected inverters,
you must enable active or reactive power control before adjusting the active or reactive power
for a PV plant. If you disable active or reactive power control, the SmartLogger will not
deliver scheduling commands to the connected inverters and the inverters will retain their
status after the previous change.

Active Power Control

If the PV plant has requirements of power limitation, the power grid scheduling personnel
should limit the active power or disable all the active power for the PV plant, that is, to enable
the active power derating mode.

Because of permission restriction, log in as Special User. Choose Settings > Active power
control to access the target page.
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Figure 8-1 Active power control

‘ Active power control
Active power control | Enable v

Active power control mode  Disable active power reduction v

[uomi

Reactive Power Control

Large-scale PV plants are required to adjust the voltage at the grid-tied point. Power grid
scheduling personnel enable the PV plant to absorb or add the reactive power at the grid-tied
point, that is, to enable the reactive power compensation, based on the real-time reactive
power transmission status in the power grid.

Because of permission restriction, log in as Special User. Choose Settings > Reactive power
control to access the target page.
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Figure 8-2 Reactive power control

Reactive Power Control

Reactive power control Enable

ElE]

Reactive power control mode Disable reactive power output

oo

8.2 Active Power Adjustment

Before setting Active power control mode, set Active power control to Enable.

8.2.1 Disabling Active Power Derating

If the inverter is required to run full load, set Active power control mode to Disable active
power reduction.
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Figure 8-3 Disabling active power derating

‘ Active power control
Active power control | Enable v

Active power control mode  Disable active power reduction v

[uomi

8.2.2 Dry Contact Remote Control

NOTICE

e |f ports of DI1-DI4 have been configured in 7.10.6 Dry contact remote shutdown, Dry
contact remote control is unavailable.

e Before setting dry contact remote control, ensure that the SmartLogger connects to a
correct ripple control receiver. For details, see 4.10 Connecting the SmartLogger to a
Ripple Control Receiver.

Set Active power control mode to Dry contact remote control.
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Figure 8-4 Dry contact remote control

Active power control
Active power control  Enable B
Active power control mode | Dry contact remote control []
No. DIL(GND1) DI2(GND1) DI3(GND1) DI4(GND1) Percentage(%)
1 ©-100
[ Oclete || Modity
=3
[ )

A maximum of 16 levels are supported for the percentages.

e ""indicates a low level. When connecting to GND1, the four DI ports of the SmartLogger are
low-level ports. If not connected, the ports are high-level ports.

e The status combination of DI1(GND1)-DI4(GND1) should differ from each other. Otherwise,
abnormal command parsing will occur.

e [f the actual input DI signal is inconsistent with that configured on the WebUI, the SmartLogger
controls the SUN2000 to work at full power and the Abnormal Active Schedule alarm is generated.

8.2.3 Percentage Fix Limitation

The SmartLogger provides simplified active power percentage configuration as well as power

control automation, that is, to automatically adjust the active power derating percentage in
different periods of the day.

If the maximum power output of the inverter needs to be controlled, set Active power control
mode to Percentage fix limitation.
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Figure 8-5 Percentage fix limitation

Active power control
Active power control | Enable []

Active power control mode | Percentage fix limitation []
No. Start time Percentage (%)
1 00:0000 100
2 [ ress o - [Contrm | concel |

=1
S

o If the inverter needs to run with specified maximum power in certain periods of a day, add setting
records based on site requirements.

e When multiple time points are set, the inverter will run with the maximum power specified for the
time point that is earlier than and the closest to the system current time point. For example, if you
add 00:00:00 and 12:00:00 on the WebUI and the system current time point is 14:30:00, the inverter
will run with the maximum power specified for 12:00:00.

8.2.4 Remote Scheduling

The NMS or independent power adjustment device sends scheduling commands over the
communications port that works with Modbus-TCP or IEC104, without the need of user
configuration or operation. The SmartLogger can automatically switch between scheduling
modes and send scheduling commands.

When Active power control mode is set to Remote scheduling, the SmartLogger receives
the scheduling commands from the upstream NMS, converts them into valid command data
identifiable to the inverters, and then sends the data to all the connected inverters. Based on
the principle of preference of remote scheduling, the SmartLogger sets Active power control
mode to Remote scheduling after receiving a scheduling command from the upstream NMS.
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Figure 8-6 Remote scheduling

‘ Active power control
Active power control | Enable
Active power control mode  |Remote scheduling

Schedule strategy Strategy 1

LI«

Adjustment coefficient ~ |1.000

=a
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Disable, Strategy 1, and Strategy 2 are available for Schedule strategy.

e Disable: The SmartLogger controls the inverter to work at full load and will not receive scheduling
commands sent by the NMS.

e Strategy 1: Open-loop scheduling policy. That is, the SmartLogger evenly allocates the power value
from the scheduling and delivers the average values to each inverter, which then operates with the
specific power. The adjustment value delivered by the SmartLogger is constant.

e Strategy 2: The customized function is provided for a site.

Adjustment coefficient: The power value will be sent to the inverter after being multiplied by the preset
coefficient.

8.2.5 Remote Output Control

NOTICE

Before setting the parameters for remote output control, synchronize the clock source of the
server. For details, see 7.10.1.1 Setting the Date and Time.
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Figure 8-7 Synchronizing the clock source

DatedTime
(UTC+08:00)Beijing ™

[l NTP synchronization test

1. Clock source: Set NTP.
2. Server: Set the server IP address or domain name.
3. NTP synchronization test: Check the time synchronization status.

Set Active power control mode to Remote output control.

Figure 8-8 Remote Output Control

Active power control

Active power control | Disable b
Active power control mode | Remote output control v
Control area | Kyushu v
Qutput control duration 10 v
PV plant ID
Remote output control server  re-ene.kyuden.cojp

PV module capacity | 0.000
Latest connection status  Login failed
Latest connection time ~ 2018-12-11 14:59:41

Present control percentage 0.0 %

[Cimport | Export |
[“Suomit | Connectserver o Tet |
(L] noTE
e Control area: Set the areas for remote output control. To enable the function in some areas, the

license needs to be imported and enabled.

e OQutput control duration: Set the time required for the inverter to change its output power from 0%
to 100% or from 100% to 0%.

e PV plant ID: Set the ID assigned by the power company to the SmartLogger.
e Remote output control server: Set the server IP address or domain name.

o If the connection between the SmartLogger and the server is abnormal, obtain the output control file
in .data format from the website of the power company and import the file.

e After the SmartLogger connects to the server, you can export the relevant file.

8.3 Reactive Power Adjustment

NOTICE

Before setting Reactive power control mode, set Reactive power control to Enable.
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8.3.1 Disabling Reactive Power Output
If the PV plant is not required to adjust the voltage at the grid-tied point or perform reactive

power compensation, the inverter can run with pure active power output. In this case, set
Reactive power control mode to Disable reactive power output.

Figure 8-9 Reactive power control

Reactive Power Control

Reactive power control Enable

=] [=]

Reactive power control mode Disable reactive power output

=3 .

8.3.2 Dry Contact Remote Control

e |f ports of DI1-DI4 have been configured in 7.10.6 Dry contact remote shutdown, Dry
contact remote control is unavailable.

e Before setting dry contact remote control, ensure that the SmartLogger connects to a
correct ripple control receiver. For details, see 4.10 Connecting the SmartLogger to a
Ripple Control Receiver.

Set Reactive power control mode to Dry contact remote control.
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Figure 8-10 Dry contact remote control

Reactive Power Control
Reactive power control | Enable -]
Reactive power control mode Dry contact remote control Zl

No. DIL(GND2) DI2(GND2) DI3(GND2) DI4(GND2) PF

1 (-1.000~-0.800]U[0.800~1.000]

=
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e A maximum of 16 levels are supported for power factors.

e ""indicates low level. When connecting to GND2, the four DI ports of the SmartLogger are
low-level ports. If not connected, the ports are high-level ports.

e The status combination of DI1(GND2)-DI4(GND2) should differ from each other. Otherwise,
abnormal command parsing will occur.

e If the actual input DI signal is inconsistent with that configured on the WebUI, the SmartLogger
does not allow the SUN2000 to generate reactive power and the Abnormal Reactive Schedule
alarm is generated.

e If Active Power Control is set to Al remote control, Dry contact remote control is unavailable
for Reactive Power Control.

8.3.3 Reactive Power Fix Control

If the PV plant is required to generate at the grid-tied point specified constant reactive power
within the power factor range, set Reactive power control mode to Reactive power fix
control.
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Figure 8-11 Reactive power fix control

Reactive Power Contral
Reactive power control | Enable [+]
Reactive power control mode | Reactive power fix control [+]
No.  Starttime Reactive power(kVar)
[} 1 00:00:00 00
2 12:00:00 ] (HH:MMSS) 100 (-1008.0~1008.0)
=3
-

e If the inverter needs to run with specified maximum power in certain periods of a day, add setting
records based on site requirements.

e The range specified for Reactive Power is relevant with the grid code and the model.

e When multiple time points are set, the inverter will run with the maximum power specified for the
time point that is earlier than and the closest to the system current time point. For example, if you
add 00:00:00 and 12:00:00 on the WebUI and the system current time point is 14:30:00, the inverter
will run with the maximum power specified for 12:00:00.

8.3.4 Power Factor Fix Control

If the PV plant is required to generate a constant power factor at the grid-tied point and the
inverter is required to adjust the real-time reactive power based on the preset power factor, set
Reactive power control mode to Power factor fix control.

Figure 8-12 Power factor fix control

Reactive Power Control

Reactive power control | Enable [=]
Reactive power control mode | Power factor fix control [=]
No. Start time Power factor
" 1 00:00:00 0.900
B 2 12:00:00 | (HHMM:SS) 0950 (-1.000~-0.800]U[0.800~1.000]
| aci | Deets |
e .
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e If the inverter is required to run with a specified power factor in certain periods of a day, add setting
records based on site requirements.

e When multiple time points are set, the inverter will run with the maximum power specified for the
time point that is earlier than and the closest to the system current time point. For example, if you
add 00:00:00 and 12:00:00 on the WebUI and the system current time point is 14:30:00, the inverter
will run with the maximum power specified for 12:00:00.

8.3.5 Q-U Characteristic Curve

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve on the SmartLogger as a substitute. The SmartLogger
delivers the values configured for the characteristic curve to the inverter, which then operates
in compliance with the configuration. The SmartLogger no longer adjusts the values.

Configure the characteristic curve under instructions from professionals to ensure that the
SUN2000 works properly.

The Q-U characteristic curve control mode is to dynamically adjust the ratio Q/S of output
reactive power to apparent power in accordance with the ratio U/Un(%) of the actual grid
voltage to the rated grid voltage.

Set Reactive power control mode to Q-U characteristic curve.

Figure 8-13 Q-U characteristic curve

Reactive Power Control

Rea rcontrol  |Enable

Q-U characteristic curve

[0

Percents of trigger frequency |20

LI

Characteristic curve points |2

5

B

85.0 90.0 950 1004 1050 110.0 1150
-0.24 X

Point U/Un(%) s
A [s80 |i80.0~115.0) [-031 |-0.600~0.600)
[1060 |ig0.0-115.0) 0310 |-0.600~0.600)

®  When configuring the curve, ensure that the U/Un(%b6) value of a point is greater than the
U/Un(%o) value of the previous point. Otherwise, the Invalid input message will be
displayed.

®  The Q-U characteristic curve supports a maximum of 10 valid points.

®  Reactive power adjustment time allows you to control the change interval of the
reactive power for a grid-tied point.
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e  Under a specific grid code, after you set Percents of trigger frequency, the
characteristic curve takes effect only when the actual output active power of the inverter
is greater than the preset value.

8.3.6 cos(Phi)-P/Pn Characteristic Curve

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve on the SmartLogger as a substitute. The SmartLogger
delivers the values configured for the characteristic curve to the inverter, which then operates
in compliance with the configuration. The SmartLogger no longer adjusts the values.

Configure the characteristic curve under instructions from professionals to ensure that the
SUN2000 works properly.

The cos(Phi)-P/Pn characteristic curve control mode is to dynamically adjust the power factor
cos(Phi) in accordance with the P/Pn (%) based on the VDE-4105\BDEW German standard.

Set Reactive power control mode to cos(Phi)-P/Pn characteristic curve.

Figure 8-14 cos(Phi)-P/Pn characteristic curve

Reactive Power Control

Reactive power control | Enable

<J[<[<]

Point P/Pn(%) cosp

A [200 [o0-1000) [og50 Ji-1000~1.000)
g0 [0.0-1000) [-085 Ji-1.000~1.000)

=

®  When you set the curve, ensure that the P/Pn(%o) value of a point is greater than the
P/Pn(%) value of the previous point. Otherwise, the Invalid input message will be
displayed.

®  The cos(Phi)-P/Pn characteristic curve can support a maximum of 10 valid points.

8.3.7 Q-U Hysteresis Curve (CEI0-16)

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve on the SmartLogger as a substitute. The SmartLogger
delivers the values configured for the characteristic curve to the inverter, which then operates
in compliance with the configuration. The SmartLogger no longer adjusts the values.
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Configure the characteristic curve under instructions from professionals to ensure that the
SUN2000 works properly.

The Q-U hysteresis curve (CEI0-16) control mode is the Italian standard CEI0-16 version of
the Q-U characteristic curve. It dynamically adjusts the output reactive power of the inverter
in accordance with the ratio of the actual voltage to the rated voltage. The final value should
be in the form of Q/S.

Set Reactive power control mode to Q-U hysteresis curve(CEI0-16).

Figure 8-15 Q-U hysteresis curve (CEI0-16)

Reactive Power Control
Enable
Q-U hysteresis curve(CEIO-16)

L <
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920 (80.0~115.0) -0.485 (-0.600~0.600)

o0 @ >

108.0 (80.0~115.0) 0485 (-0.600~0.600)
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e When configuring the curve, ensure that the U/Un(%b) value of a point is greater than the U/Un(%o)
value of the previous point. Otherwise, the Invalid input message will be displayed.

e When configuring the curve, ensure that the values of A and B for Q/S are consistent and set in
sequence, and that the values of C and D are consistent and set in sequence. Otherwise, the Invalid
input message will be displayed.

e Under a specific grid code, after you set Percents of trigger frequency, the characteristic curve
takes effect only when the actual output active power of the inverter is greater than the preset value.

8.3.8 Remote Scheduling

The NMS or independent power adjustment device sends scheduling commands over the
communications port that works with Modbus-TCP or IEC104, without the need of user
configuration or operation. The SmartLogger can automatically switch between scheduling
modes and send scheduling commands.

When Reactive power control mode is set to Remote scheduling, the SmartLogger receives
the scheduling commands from the upstream NMS, converts them into valid command data
identifiable to the inverters, and then sends the data to all the connected inverters. Based on
the principle of preference of remote scheduling, the SmartLogger sets Reactive power
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control mode to Remote scheduling after receiving a scheduling command from the
upstream NMS.

Figure 8-16 Remote scheduling

Reactive Power Control

Reactive power control Enable

(=] [&]

Reactive power control mode Remote scheduling

8.3.9 Power Factor Closed-Loop Control

Before setting the parameters for power factor closed-loop control, ensure that the power

meter is connected to the SmartLogger. For details, see 4.6 Connecting the SmartLogger to a
Power Meter.

Set Reactive power control mode to Pwr factor closed-loop control.
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Figure 8-17 Power factor closed-loop control

Reactive Power Control
Reactive power control | Enable

Reactive power control mode | Pwr factor closed-loop control

Target power factor 0,900

Adjustment interval  [20

Adjustment deadband  0.005

(oo v

®  Target power factor: indicates the target value for the adjustment power factor of the
power meter.

® Adjustment interval: indicates the interval for sending adjustment commands by the

SmartLogger.

e  Adjustment deadband: indicates the adjustment power factor precision.

(L] noTE
The specified value of Adjustment deadband takes effect only if the power factor for the power meter
exceeds 0.9.

8.3.10 Distributed Power Factor Closed-loop Control

To improve the revenue, a distributed PV plant needs to reduce or avoid the power factor
surcharge by performing the distributed reactive power compensation. To enable the function,
set the related parameters over the WebUI.

Before setting the parameters, ensure that the power meter is connected to the SmartLogger.
For details, see 4.6 Connecting the SmartLogger to a Power Meter.

Set Reactive power control mode to Distributed power factor closed-loop control.
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Figure 8-18 Distributed power factor closed-loop control

Reactive Power Control
Reactive power control Disable
Reactive power control mode Distributed power factor closed-loop control
Electric meter power direction Positive
Power Meter | No
Target power factor  0.950
Adjustment period 2.0
Adjustment deadband  0.005

Reactive compensation delay 0.0

®  Electric meter power direction: Set this parameter to positive if the active power
reading of the power meter is positive when the inverter has no power output. Otherwise,
set this parameter to reverse.

e  Power Meter: When this parameter is set to Smart meter, the distributed power factor
closed-loop control takes effect.

®  Target power factor: Indicates the target value for the adjustment power factor of the
power meter, which should be larger than the appraisal value of the PV plant power
factor.

e  Adjustment period: Indicates the interval for sending adjustment commands by the
SmartLogger.

e Adjustment deadband: Indicates the adjustment power factor precision, which takes
effect when the power factor on the gateway meter is larger than 0.9.

®  Reactive compensation delay: Indicates the delay time for starting the distributed
power compensation if the current power factor is lower than the target value.

L] noTE

When the SmartLogger receives a remote reactive power scheduling command by the PV plant,
Reactive power control mode automatically switches to Remote scheduling. To re-perform the
distributed reactive power compensation, set Reactive power control mode to Distributed power
factor closed-loop control and set Target power factor correctly.

8.3.11 PF-U Characteristic Curve

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve as a substitute. The SmartLogger delivers the values
configured for the characteristic curve to the inverter, which then operates according to the
configuration. The SmartLogger no longer adjusts the values.

NOTICE

Set the parameters of characteristic curves under instructions from professionals to ensure that
the inverters work properly.

The control mode of the PF-U characteristic curve is to dynamically adjust the PF value in
accordance with the ratio U/Un(%) of the actual grid voltage to the rated grid voltage.

Set Reactive power control mode to PF-U characteristic curve.
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Figure 8-19 PF-U characteristic curve

Reactive Power Control

A
Reactive power control  |Enable [v|
Reactive power control mode  |PF-U characteristic curve ﬂ
Characteristic curve points 10 V‘
i
0.80+
0.85+
0.90+
0.95-4&"“€£QE
1.00 r r . i S— - . »U/UN(%)
0.054 85.0 90.0 95.0 100.5%2.0 110.0 115.0
-0.90+
-0.85
-0.804
Point U/Un(%) PF
A 95.0 (80.0~115.0) 0.950 (-1.000~-0.800]U[0.800~1.000]
B 96.0 (80.0~115.0 0.960 (-1.000~-0.800]U[0.800~1.000]
C 97.0 (80.0~115.0 0.970 (-1.000~-0.800]U[0.800~1.000]
D 98.0 (80.0~115.0) 0.980 (-1.000~-0.800]U[0.800~1.000]
E 99.0 (80.0~115.0) 1.000 (-1.000-~-0.800]U[0.800~1.000]
F 1010 (80.0~115.0) 1.000 (-1.000~-0.800]U[0.800~1.000]
G 102.0 (80.0~115.0) -0.980 (-1.000-~-0.800]U[0.800~1.000]
H 103.0 (80.0~115.0) -0.970 (-1.000~-0.800]U[0.800~1.000]
I 104.0 (80.0~115.0 -0.960 (-1.000~-0.800]U[0.800~1.000]
) 105.0 (80.0~115.0 -0.950 (-1.000~-0.800]U[0.800~1.000] v

e When configuring the curve, ensure that the U/Un(%b) value of a point is greater than the
U/Un(%o) value of the previous point. Otherwise, the "Invalid input™ message will be
displayed.

®  The PF-U characteristic curve supports a maximum of 10 valid points.
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9 Maintenance

This topic describes how to perform daily maintenance and troubleshooting to ensure
long-term proper operation of the SmartLogger.

9.1 Routine Maintenance

®  Check that the SmartLogger is free from strong electromagnetic interference.
®  Check that the SmartLogger is free from heat sources.

®  Check that the heat dissipation holes are not blocked.

®  Clean up the dirt and dust for the SmartLogger periodically.

®  Check that the cables are secured periodically.

9.2 Troubleshooting

This topic describes the common faults in the SmartLogger and the troubleshooting measures.

Table 9-1 describes the common faults and the troubleshooting measures for the SmartLogger.

Table 9-1 Common fault list

No. Symptom | Possible Cause Measures
1 The 1. The DC output terminal of the power 1. Connect the DC output of the power
SmartLogge adapter does not connect to the Power adapter to the Power port of the
r cannot be port of the SmartLogger. SmartLogger.
powered on. | 2. The AC input terminal of the power 2. Connect the AC input of the power
adapter does not connect to the AC adapter to the AC power port.
power port. 3. Replace the power adapter.
3. Power adapter is faulty. 4. Contact the supplier or Huawei
4. The SmartLogger is faulty. Customer Service Dept.
2 The LCDis | 1. The LCD is faulty. Contact the supplier or Huawei Customer
off. 2. The SmartLogger is faulty. Service Dept.

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 269



SmartL.ogger1000

User Manual 9 Maintenance

No. Symptom | Possible Cause Measures

3 The LCD 1. The button is faulty. Contact the supplier or Huawei Customer
does not 2. The SmartLogger is faulty. Service Dept.
respond
when a
button is
pressed.

4 Devices 1. The COM ports are not connected to 1. Check the RS485 communications
cannot be devices, or the cables are loose, cable connection. If any cable is loose,
searched. disconnected, or reversely connected. drops off, or is reversely connected,

2. The communications parameters for rectify the connection.
the RS485 port are incorrect. 2. Correctly set the RS485
3. No EMI is manually added. communications parameters, and
4. The communications parameters for ensure that the baud rate and the
the EMI are incorrect. communications address are correctly
5. The address for the inverter is not set
within the search address segment set | 3 Add the EMI manually.
for the SmartLogger. 4. Correctly set the EMI parameters
5. Set the address of the inverter to be
within the search address segment set
for the SmartLogger.

5 Devices 1. The cable between the device and the 1. Verify that the cable between the
Status is SmartLogger is loose or disconnected. device and the SmartLogger is
Disconnecti | 2. The device is powered off. properly connected and tightened.
on on the 3. The baud rate or RS485 address of the | 2. Power on the device.

SmartLogge device is changed. 3. Verify the baud rate and RS485
r. 4. The device is replaced. address of the device.
5. The device is no longer connected. 4. If adevice is replaced, search for or
manually add the device.
5. If the device is removed, remove the
device on the SmartLogger.

6 The EMI 1. The RS485 communications cable 1. Verify that the RS485
cannot be between the EMI and the SmartLogger communications cable is properly
added. is not properly connected, or the connected and tightened.

RS485 communications cable is loose | 2. Power on the EMI.
or dlsconr?ected. 3. Verify the baud rate of the EMI.
2. The EMI is powered off. 4. Log in to the WebUI and verify the
3. The baud rate of the EMI is parameter settings of the EMI.
inconsistent with that of the
SmartLogger.
4. Parameter settings of the EMI are
incorrect.

7 The 1. The SmartLogger is not connected to 1. Connect the Ethernet network port of
SmartLogge the PC, or the cable between the the SmartLogger to the PC or router.
r cannot SmartLogger and the PC is loose or 2. Check that the Ethernet parameters are
communicat disconnected. correctly set.

e with the 2. Ethernet parameters are not properly 3. Check whether the management
managemen set. system parameters are correctly set.
tsystemon | 3 The management system parameters

the PC. are incorrectly set.
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No. Symptom | Possible Cause Measures

8 Emails 1. The SmartLogger cannot communicate | 1. Connect the Ethernet network port of
cannot be with the email server. the SmartLogger to the PC or router.
received. 2. Ethernet parameters are not properly 2. Check that the Ethernet parameters are

set.

3. Email parameters are not properly set.

correctly set.

3. Check that the Email parameters are
correctly set.

9.3 Alarms

This topic describes the common faults in the SmartLogger and the troubleshooting measures.

Table 9-2 describes the common faults and the troubleshooting measures.

Table 9-2 Alarms

Alarm | Alarm Alarm Alarm Causes Measure
ID Severity | Sub-ID
1100 Abnorm | Major 1 Under the active | 1. Check whether the cable connections to
al power Al the DI ports are correct.
P-Contro remote control | 2. Enter the active power Dry contact
I mode, the remote control configuration page and
feedback check the mapping table of the current
command data DI signal configuration. Contact the
of the AO port power grid company to check the
cannot be read completeness of the combination
due to the configurations in the mapping table and
ADAM fault, check whether the configurations
power comply with the requirements of the
disconnection, power grid company.
or abnormal
link.
1101 Abnorm | Major 1 Under the 1. Check whether the cable connections to
al reactive power the DI ports are correct.
Q-Contr Dry contact 2. Enter the reactive power Dry contact
ol remote control remote control configuration page and
mode, the four check the mapping table of the current
DI ports read DI signal configuration. Contact the
commands power grid company to check the
beyond the completeness of the combination
configuration. configurations in the mapping table and
check whether the configurations
comply with the requirements of the
power grid company.
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Alarm | Alarm Alarm Alarm Causes Measure
ID Severity | Sub-ID
1102 Abnorm Major 1 The power 1. Check whether the communications
al Meter meter cannot cable connection between the
Data properly send ADAMA4024 and the SmartLogger is
feedback signals correct, whether the RS485 address
to a third-party conflicts with the addresses of other
scheduling devices, whether the baud rate is
device due to consistent with that set for the
the ADAM corresponding SmartLogger port.
fault, power 2. Check whether the auxiliary power
disconnection, supply for the ADAM4024 is normal.
or abnormal
link.
1103 Breaker | Major 1 The general AC | Check whether the disconnection of the
Disconn circuit breaker circuit breaker is a normal operation.
ect at the grid-tied Otherwise, contact the service engineer to
point is OFF. restore the connection.
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FAQ

10.1 How Do I Set Anti-crosstalk Parameters?

When MBUS is used for communication between the SmartLogger and the inverter,
anti-crosstalk parameters must be set in the following scenarios:

e  The SmartLogger detects inverters of another subarray.

e  The SmartLogger detects more inverters than those belonging to the corresponding
subarray, while an adjacent SmartLogger detects less inverters than those belonging to
the corresponding subarray.

e  The AC power cables for different transformer stations are routed along the same trench
or cable trough.

e  The voltage on the high-voltage side of the transformer station is 10 kV.

®  There are multiple windings on the low-voltage side of the multi-split transformer station,
such as the dual-split transformer station.

®  Two or more SmartMBUSs are installed on the low-voltage side of the transformer
station.

L] noTE

After replacing or adding a device such as an inverter, a SmartLogger, or a SmartMBUS in a subarray,
you need to reset the anti-crosstalk parameters of the device.

Setting Anti-crosstalk Parameters Through an SN List

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

Collect the SNs of the inverters in the subarray corresponding to the SmartLogger.

Log in to the SmartLogger as Advanced User and choose Monitoring > MBUS >
Networking Settings.

On the SN list tab page, click Template and fill in the collected SNs based on the template.
Click Import to import the SN list to the SmartLogger.

On the Running Param. tab page, set SmartMBUS parameters Box-type transformer No.
and Winding No. as required, set Anti-crosstalk to Enable, confirm the selected items, and
click Submit.

Click Synchronize to synchronize the transformer station number and winding number to the
inverter in the subarray.

~--End
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Setting anti-crosstalk parameters based on the transformer station number and
winding number.

Step1 Log into the SmartLogger as Advanced User and choose Monitoring > MBUS >
Networking Settings.

Step 2 On the Running Param. tab page, set SmartMBUS parameters Box-type transformer No.
and Winding No. as required, set Anti-crosstalk to Enable, confirm the selected items, and

click Submit.

Step 3 Log in to the SUN2000 app as Advanced User, choose Function Menu > Settings > Comm.

Param. > MBUS, and set transformer station number and winding number for all inverters in

the subarray as required.

~—-End

FAQ
FAQ Possible Causes Suggestions
After 1. The inverters in other 1. Do not set the anti-crosstalk
anti-crosstalk subarrays are detected. parameters for the subarray until the
parametersare | 2. The SN list is incorrect. operation is performed on other

set, the number 3
of the detected
inverters do not
match that of the | 4
inverters in the
subarray.

. The three-phase input

switch on the smart
array controller is off.

. The switch between the

SmartLogger or
SmartMBUS and the
busbar of the
transformer station is
off.

The three-phase AC
power cable is a single
core cable.

subarrays.

2. Check whether the SN list and SNs
of the inverters in the subarray are
consistent.

3. Turn on or replace the three-phase
input switch on the smart array
controller.

4. Turn on or replace the switch
between the SmartLogger or
SmartMBUS and the busbar of the
transformer station.

5. Inthe US, set Network frequency
band to 1.7-4.9 (MHz). In other
regions, set this parameter to 0.5-3.7
(MHz), 2.5-5.7 (MHz), or 2-12
(MHz) as required.

Inverters cannot
be networked
through MBUS.

The SmartMBUS board is
faulty.

Contact Huawei technical support.
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10.2 Which Models of Power Meters and EMIs Are
Supported by the SmartLogger?

Table 10-1 Supported power meters

Vendor Model Export Limitation
Janitza UMG604/UMG103/UMG | Supported
104
NARUN PD510 -
Acrel PZ96L Supported
algodue UPM209 Supported
NOTE
When the power meter connects to the
SmartLogger, an external 120—-ohm resistor
needs to be connected to the RS485 bus of the
power meter. For details, see the user manual of
the power meter.
CHNT DTSU666 -
Socomec COUNTIS E43 Supported
NOTE
e Not applicable to load imbalance scenarios.
e When the power meter connects to the
SmartLogger, an external 120—ohm resistor
needs to be connected to the RS485 bus of
the power meter. For details, see the user
manual of the power meter.
ABB Ad4 -
Netbiter CEWE -
Schneider PM1200 -
SFERE PD1947 -
Lead LD-C83 -
MingHua CRDM-830 -
People RMB858E -
elster A1800ALPHA -
Mitsubishi LMS-0441E -
Toshiba S2MS -
[Ll NoTE

The SmartLogger can connect to only one power meter that uses the Modbus protocol.
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Table 10-2 Supported EMIs

Vendor

Model

EMI Information

JinZhou YangGuang

PC-4

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

HanDan

RYQ-3

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

ABB

VSN800-12

Total irradiance, ambient
temperature, and PV module
temperature

VSN800-14

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

Kipp&Zonen

SMPx series

Total irradiance and ambient
temperature

Lufft

WSx-UMB

Total irradiance, ambient
temperature, wind direction,
and wind speed

WSx-UMB (external
Sensors)

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

Hukseflux SRx

Hukseflux SRx

Total irradiance and ambient
temperature

MeteoControl

SR20-D2

Total irradiance and ambient
temperature

RainWise

PVmet-150

Total irradiance, ambient
temperature, and PV module
temperature

PVmet-200

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

Gill MetPak Pro

Gill MetPak Pro

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

Ingenieurbro Si-RS485TC

Ingenieurbro Si-RS485TC

Total irradiance, ambient
temperature, PV module
temperature, and wind speed
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Vendor

Model

EMI Information

Meier-NT ADL-SR

Meier-NT ADL-SR

Total irradiance, ambient
temperature, PV module
temperature, and wind speed

Soluzione Solare

SunMeter

Total irradiance and ambient
temperature

JinZhou LiCheng

JinZhou LiCheng

Total irradiance, ambient
temperature, PV module
temperature, wind direction,
and wind speed

Sensor ADAM

NOTE

The sensor-type EMI
(current-type or voltage-type)
communicates with the
SmartLogger through the
ADAM analog-to-digital
converter.
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1 1 Disposing of the SmartLogger

This topic describes how to dispose the SmartLogger.

If the service life of the SmartLogger expires, dispose of the SmartLogger according to the
local disposal act for waste electric appliances.
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Technical Specifications

This topic describes the SmartLogger technical specifications.

Device management

Specifications

SmartLogger1000

Number of managed devices

80

Communications mode

Three RS485 ports

The maximum communication

RS485: 1000 m; Ethernet: 100 m

distance
Display
Specifications SmartLogger1000
LCD 3.5-inch LCD
LED Three LED indicators
WEB Embedded
Common parameters
Specifications SmartLogger1000

Power supply

100 V AC to 240 V AC, 50 Hz or 60 Hz

Power consumption

Normal: 3 W; maximum: 7 W

Storage capacity Stores historical inverter performance data of the last
month
Language English, Chinese, German, Italian, Japanese, French

Dimensions (W x H x D)

225 mm x 140 mm x 50 mm

Issue 12 (2019-01-15)

Copyright © Huawei Technologies Co., Ltd. 279




SmartL.ogger1000

User Manual 12 Technical Specifications
Specifications SmartLogger1000
Net weight 500 g
Operating temperature -20C to +60C

Relative humidity

(non-condensing) 5%-95%

Protection level 1P20

Installation mode Installed on a wall, desk, or along a guide rail.
Port

Specifications SmartLogger1000

Ethernet 10/100M, Modbus-TCP

RS485 Modbus-RTU

USB Supported

Digital parameter input 4

Analog input 2

Relay output 3
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A Monitoring User List
LI noTe

Use the initial password upon first power-on and change it immediately after login. To ensure account
security, change the password periodically and keep the new password in mind. Not changing the initial
password may cause password disclosure. A password left unchanged for a long period of time may be
stolen or cracked. If a password is lost, devices cannot be accessed. In these cases, the user is liable for
any loss caused to the PV plant.

Table A-1 Monitoring User List

Login Mode User Name Initial Password
LCD Common User 000001
Advanced User 000001
Special User 000001
WEB Common User Changeme
Advanced User Changeme
Special User Changeme
SSH root Changeme
NetEco emscomm [EZFp+2%r6@IXSCv

Issue 12 (2019-01-15) Copyright © Huawei Technologies Co., Ltd. 281



SmartL.ogger1000
User Manual

B Acronyms and Abbreviations

Acronyms and Abbreviations

AC
Al
AO
APP
ATB

CCO
COM

D)
DO

EDR
EIRP
EMI
ETH

LE
LED

alternating current
analog input
analog output
application

Access Terminal Box

central coordinator

communication

digital input
digital output

enhanced data rate
equivalent isotropically radiated power
environmental monitoring instrument

Ethernet

low power

light-emitting diode
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P
PLC power line communication
R
RSTP Rapid Spanning Tree Protocol
S
SFP small form-factor pluggable
STA station
STP Spanning Tree Protocol
w
WEEE waste electrical and electronic equipment
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